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P r e f a c e
COPYRIGHT AND TRADEMARK NOTICE

Copyright 22012 Telestream, Inc. All rights reserved. No part of this publication may be reproduced, 
transmitted, transcribed, altered, or translated into any languages without written permission of 
Telestream, Inc. Information and specifications in this document are subject to change without notice and 
do not represent a commitment on the part of Telestream. 

Telestream, Vantage, Flip4Mac, FlipFactory, Episode, ScreenFlow, Wirecast, GraphicsFactory, MetaFlip, 
MotionResolve, and Split-and-Stitch are registered trademarks and Pipeline, Launch, and Videocue are 
trademarks of Telestream, Inc. All other trademarks are the property of their respective owners. 

QuickTime, Mac OS X, Final Cut Pro, and Safari are trademarks of Apple, Inc. Bonjour, the Bonjour logo, 
and the Bonjour symbol are trademarks of Apple, Inc.

All other brand, product, and company names are property of their respective owners, and are used only 
for identification purposes.

MPEG-2 License Requirements
Telestream has obtained a license from MPEG LA, to produce MPEG-2 video, to meet the following 
requirement on behalf of its FlipFactory and Pipeline licensees: The use of this product in any manner that 
complies with the MPEG-2 standard is expressly prohibited without a license under applicable patents in 
the MPEG-2 patent portfolio, which license is available from MPEG LA, L.L.C., 250 Steele Street, Suite 
300, Denver, Colorado 80206.

Obtaining Pipeline Support | Information | Assistance

Web Site. http://www.telestream.net/telestream-support/pipeline/support.htm

Terms and times of support services vary, per the terms of your current service contract with Telestream.

http://www.telestream.net/telestream-support/pipeline/support.htm


Prefaceii
Pipeline Web Site – FAQs, Forums & Updates

Web Site. http://www.telestream.net/telestream-support/pipeline/support.htm

Returning Inoperative Pipelines (RMA)

If your Pipeline is inoperative, contact Telestream at the Pipeline support E-mail address provided below, 
or contact your authorized reseller. Provide your company and contact information, the serial number of 
the inoperative unit, and request instructions for Return Material Authorization.

Company and Product Information
For information about Telestream or its products, please contact us via:

Web Site. www.telestream.net

Sales and Marketing Email. info@telestream.net

We’d Like to Hear From You!
If you have comments or suggestions about improving this document, other Telestream documents, or our 
Web site – or if you've discovered an error or omission, please email us at techwriter@telestream.net

Mail

Telestream, Inc. 
848 Gold Flat Road, Suite 1
Nevada City, CA. USA 95959

International Telestream Distributors

See the Telestream Web site at www.telestream.net for your regional authorized Telestream distributor.

FCC Emission Information
Ethernet connections to Pipeline devices must be made using a shielded Category 5 or Category 6 cable 
to ensure emissions are within applicable standards. This equipment has been tested and found to comply 
with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules.

These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, uses and can radiate 
radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference with other electronic 
equipment in which case the user will be required to correct the interference at his/her own expense. 
Changes or modifications not expressly approved by Telestream can affect emission compliance and could 
void the user's authority to operate this equipment.
May, 2012
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Canadian EMC Notice of Compliance
This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus 
set out in the Radio Interference Regulations of the Canadian Department of Communications.

Le present appareil numerique n'emet pas de bruits radioelectriques depassant les limites applicables aux 
appareils numeriques de la classe A prescrites dans le Reglement sur le brouillage radioelectrique edicte 
par le Ministere des Communications du Canada.

Important Safety Instructions
Before using Pipeline devices, read the following safety instructions to ensure it is used safely:

• Unplug the device before cleaning.

• Use only a lightly-dampened cloth to clean the unit; never pour liquids onto the device.

• Do not place the device on an unstable surface or near extreme heat.

• Do not stack Pipelines more than two units high to avoid over-heating.

• Use only the power source supplied, and recommended in this manual.

• Connect all electronic equipment to properly grounded power outlets.

• Telestream recommends using surge protection equipment (may be feature of a UPS). 

EN55022 Class A Warning

In a domestic environment this product may cause radio interference in which case the user may be 
required to take adequate measures.

Regulatory Approved Standards for Electrical Safety

This equipment complies with the minimum requirements of these standards:

IEC950 (or EN60950/BS7002/VDE0805 May 1990)
UL1950
CSA C22.2-950-M89

Radiation Emission Susceptibility Regulatory Approved Standards

This equipment complies with the minimum requirements of these standards:

FCC155, Class A
EN55022, Class A
EC DIR 89/336/EEC
EN50082-1

Caution

Pipelines contain no user serviceable parts. Never open the chassis 
enclosure. Doing so without express permission from Telestream may 
void your warranty.
82549



Prefaceiv
Limited Warranty and Disclaimers
Telestream, Inc. (the Company) warrants to the original registered end user that the product will perform as stated 
below for a period of one (1) year from the date of shipment from factory:
Hardware and Media. The Product hardware components, including equipment supplied but not manufactured by the 
Company but NOT including any third party equipment that has been substituted by the Distributor for such equipment 
(the “Hardware”), will be free from defects in materials and workmanship under normal operating conditions and use.
Software. If software is supplied as part of the product, the software will operate in substantial conformance with 
specifications set forth in its product user's guide. The Company does not warrant that the software will operate 
uninterrupted or error-free, will meet your requirements, or that software errors will be corrected.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media. The Company will either repair or replace (at its option) any defective Hardware component or 
part, or Software Media, with new or like new Hardware components or Software Media. Components may not be 
necessarily the same, but will be of equivalent operation and quality. 

Software. If software is supplied as part of the product and it fails to substantially confirm to its specifications as stated 
in the product user's guide, the Company shall, at its own expense, use its best efforts to correct (with due allowance 
made for the nature and complexity of the problem) such defect, error or nonconformity. 

Software Updates
If software is supplied as part of the product, the Company will supply the registered purchaser/licensee with 
maintenance releases of the Company’s proprietary Software Version Release in manufacture at the time of license for 
a period of one year from the date of license or until such time as the Company issues a new Version Release of the 
Software, whichever first occurs. To clarify the difference between a Software Version Release and a maintenance 
release, a maintenance release generally corrects minor operational deficiencies (previously non-implemented 
features and software errors) contained in the Software, whereas a Software Version Release adds new features and 
functionality. The Company shall have no obligation to supply you with any new Software Version Release of 
Telestream software or third party software during the warranty period, other than maintenance releases.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or Software Media, or any part 
thereof, is damaged due to abuse, misuse, alteration, neglect, or shipping, or as a result of service or modification by a 
party other than the Company, or (ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF ALL OTHER WARRANTIES, 
EXPRESS OR IMPLIED, INCLUDING, WITHOUT LIMITATION, ANY WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE. No oral or written information or advice given by the Company, its 
distributors, dealers or agents, shall increase the scope of this Limited Warranty or create any new warranties.

Geographical Limitation of Warranty. This limited warranty is valid only within the country in which the Product is 
purchased/licensed.

Limitations on Remedies. YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE LIABILITY OF TELESTREAM, INC. 
WITH RESPECT TO THE PRODUCT, SHALL BE AS STATED IN THIS LIMITED WARRANTY. Your sole and 
exclusive remedy for any and all breaches of any Limited Warranty by the Company shall be the recovery of 
reasonable damages which, in the aggregate, shall not exceed the total amount of the combined license fee and 
purchase price paid by you for the Product. 

Damages. TELESTREAM, INC. SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING ANY LOST 
PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR 
USE OR INABILITY TO USE THE PRODUCT, OR THE BREACH OF ANY EXPRESS OR IMPLIED WARRANTY, 
EVEN IF THE COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF THOSE DAMAGES, OR ANY REMEDY 
PROVIDED FAILS OF ITS ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, Inc.
848 Gold Flat Road, Suite 1
Nevada City, CA 95959

You can call Telestream, Inc. via telephone at (530) 470-1300.
May, 2012
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C H A P T E R 1

I n t r o d u c t i o n
Chapter 1, Introduction

Pipeline is an industry-first network-based video capture and playout device for moving SD & HD SDI 
video & audio in and out of Mac OS X & Windows file-based workflows. Pipeline systems provide real-time 
SD and HD SDI ingest and capture into industry-standard QuickTime, MXF OP1a, and MXF OPAtom 
directly to any storage location.

Pipeline can also be used as the front-end capture system supplying media files that can be immediately 
used directly with Telestream’s transcoding workflow automation tools. It can encode media into 
QuickTime or MXF for use in products including Apple’s Final Cut Pro, Avid Media Composer, and Adobe 
Premiere Pro. 

Pipeline captures media from tape or live sources, making it ideal for integration in broadcast, production, 
postproduction, government, and other professional media workflow applications. A Pipeline software 
development kit (SDK) is also available from Telestream, which enables integration in custom applications.

PIPELINE AUTOMATES REAL-TIME MEDIA WORKFLOWS

Designed into Pipeline is ease of use for broadcasters, post-production houses, government agencies, 
universities, and video professionals. Setting up a Pipeline is easy. Connect Ethernet and SDI, attach an 
optional VTR, and configure your network settings – you’re often up and running in under ten minutes.

Figure 1–1. Pipeline automates and adds value to real-time transcoding workflows
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TELESTREAM’S PIPELINE FAMILY OF PRODUCTS

Pipeline SC
Pipeline SC is a single-channel, single-session device. It is ideally suited for low-volume workflows where 
easy location and setup is important.

Figure 1–2. Pipeline SC – compact, and easy to set up

Pipeline SC offers these features:

• Network-accessible SDI video encoding and playout

• Real-time encoding from standard definition NTSC/PAL SDI to DV, DVCPro, IMX 30|40|50, ProRes 422 
SQ (SD), MJPEG A, and MPEG-2 50 mb/sec I-frame video

• Real-time decoding from SD DV, DVCPro, IMX, and ProRes 422 SQ to PAL/NTSC SDI video

• Extends FlipFactory, Final Cut Pro, and Episode to include workflows with tape or live sources

• VBI closed caption and timecode data extraction

• Shared network access to Pipeline saves time, effort and money

• Digitizes tapes into online libraries for an end-to-end DAM solution

• Records clips to tape for sharing with clients or colleagues.

Pipeline Quad
Pipeline Quad is a four-channel, rack-mounted device with Gigabit Ethernet and four independent Pipeline 
channels. Pipeline Quad also has a Sync Input for synchronizing output streams and for extracting VITC 
timecode.

Figure 1–3. Pipeline Quad – four-channels for high-volume applications

The Pipeline Quad’s rack-mount form is ideal for high-volume, scalable workflows where throughput and 
performance are important factors.

Pipeline Quad performs all encoding and decoding available in Pipeline SC, and adds these features: 

• Four concurrent, independent Pipeline channels on a single, rack-mount device

• Digital SDI sync input channel (sync in only) for frame-synchronized playout across all channels

• Optional, configurable confidence monitoring of client-bound video on a dedicated channel

• Gigabit Ethernet and dual, common power supplies for increased fail-safe operation.
May, 2012
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Pipeline HD Dual
Pipeline HD Dual is a two-channel, rack-mounted system with dual Gigabit Ethernet enabling two 
independent Pipeline HD channels. Pipeline HD Dual also has an SDI Reference input for synchronizing 
output streams and for extracting VITC timecode.

Figure 1–4. Pipeline HD Dual – two channels for high-volume HD applications

The Pipeline HD Dual’s rack-mount form is ideal for high-volume, scalable workflows where throughput 
and performance are important factors.

Pipeline HD Dual performs all encoding and decoding available in Pipeline SC, and adds these features:

• HD codec support for Uncompressed SD 8-bit, DVCPro50, Apple ProRes 422 HD, Avid DNxHD, and 
DVCProHD

• Two concurrent, independent Pipeline HD channels on a single, rack-mount device

• Digital SD or HD SDI sync input channel (sync in only) for frame synchronized playout across all 
channels

• Gigabit Ethernet for each channel and dual, common power supplies for increased fail-safe operation.

PIPELINE BENEFITS

A better way to capture and playout baseband media
Telestream Pipeline is a network-based video capture and playout device for moving HD and SD video and 
audio in and out of any file-based workflow. This cross-platform solution offers Mac OS X and Windows 
users more choices for fast, robust, reliable video capture.

Accessible from any workstation on your network
Pipeline provides freedom from the hassles, limitations, and expense of traditional capture-card solutions 
on a dedicated workstation. Common network protocols, RS-422 deck control, and frame-accurate
ingest/playout make Pipeline a smart choice for any video workflow.

Pipeline provides direct support for MXF workflows, creating OPAtom and OP1a media. For users who 
need to maintain closed captions and other ancillary data, Pipeline offers methods of achieving this via 
MXF, TIFO, and Avid/Apple proprietary schemes.

In addition to capture, Pipeline provides an easy Print to Tape interface for users who need to insert edit, 
assemble edit, controlled playout, or crash playout back to tape.
82549
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Edit or transcode while capture for quick turnaround
Pipeline allows you to edit or transcode your media files while they are being captured. There is no need to 
wait for the complete file to arrive. Batch ingest from an EDL file allows you to encode multiple clips from a 
single tape. Plus, real-time reliable hardware encoding removes capture

card/workstation operating system and driver incompatibilities.

Cost-effective network import/export station
Pipeline enables any machine on the network to act as a dedicated, network import/export station – 
making it very cost effective. In addition, Pipeline offers support for direct extraction and preservation of 
ancillary data and a wide variety of timecode sources. A powerful Web service API makes it easy to 
develop applications that automate control of multiple Pipeline systems. A comprehensive SDK is 
available for easy integration into any workflow.

Multi-channel scalability
Pipeline Quad and Pipeline HD Dual offer unparalleled encoding power in a compact 1RU box, plus they 
include dual power supplies for critical workflows. Pipelines can be stacked or racked for scalability to an 
unlimited number of channels.

Ingest into editing workflows
Pipeline saves significant time and costs over traditional ingest solutions by importing media directly into 
your editing workflow. A single workstation or server can handle the demands of ingesting multiple SD or 
HD streams. QuickTime movie files are ready immediately, allowing incoming events and breaking news to 
be edited while they are being captured. External encoding allows you to use your workstation for editing 
instead of waiting for clips to be rendered. Additionally, Pipeline's keyboard commands allow you to set up 
your workflow the way you want.

Ingest into transcoding workflows
Use Pipeline for high-quality baseband ingest into your transcoding workflow. Telestream's FlipFactory, 
Vantage, Agility, and Episode products allow you to simultaneously create high-res files for storage while 
creating a low-res proxy, or create any number of additional file formats in near-realtime. Transcoding 
begins immediately while ingesting media, saving you time and money. Pipeline also preserves important 
metadata throughout your transcoding workflow.
May, 2012
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C H A P T E R 2

P i p e l i n e  H a r d w a r e ,
I n s ta l l a t i o n  &  S e t u p
Chapter 2, Pipeline Hardware, Installation & Setup

Use this chapter to unpack and set up Pipeline SC, Pipeline Quad, and Pipeline HD Dual devices, connect 
video equipment, and configure the Pipeline for a LAN connection. Before proceeding, work with your 
network administrator to determine network setting requirements: IP address, netmask, and the gateway 
address. You should also understand your media workflow requirements and read Disk and Network 
Requirement by Media Format (page 41).

To set up and configure your Pipeline correctly, complete the tasks in this chapter, referring to Chapter 5, 
Using the Configure Panel on page 51 for network configuration tasks.

Topics

 Environmental Operating Requirements (page 6)

 Power Requirements (page 6)

 Unpack the Pipeline (page 6)

 Locate the Pipeline SC (page 7)

 Locate the Pipeline Quad | Pipeline HD Dual (page 7)

 Pipeline SC Hardware (page 9)

 Pipeline Quad Hardware (page 11)

 Pipeline HD Dual Hardware (page 15)

 Connecting Pipeline to Mac OS X or Windows Computers (page 19)

 Adding Pipeline to a Network (page 20)

 Powering up the Pipeline (page 21)

 Configuring & Connecting to Pipelines (page 22)

 Registering Your Pipeline with Telestream (page 22)

Note

Topics in this chapter refer to all Pipeline devices unless specifically noted.
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ENVIRONMENTAL OPERATING REQUIREMENTS

Plan adequate space for cable routing from the back of the chassis. Ensure that the Pipeline is in close 
proximity to your Ethernet and video cables, and that cable connectors are not stressed, bent, or crimped. 
Also make sure that you have adequate space for a VTR deck, if necessary.

Allow at least six inches (15 cm) of space between the Pipeline and the nearest object to ensure adequate 
airflow. Keep the temperature range within acceptable limits (table below), and keep humidity moderate in 
the vicinity. Temperature specifications are as follows:

POWER REQUIREMENTS

Input Voltage. Auto-sensing 100 to 240V AC, 50/60Hz 

UNPACK THE PIPELINE

Unpack the contents of the original shipping container; identify each component and determine that they 
are in satisfactory condition. If any shipping damage is visible, note it on your shipping documents and 
contact your shipping agent and Telestream or authorized Telestream distributor. 

Caution

Do not place more than two Pipeline SCs in a stack. If you do, you risk 
overheating a unit, potentially leading to operational failure.

Table 2–1. Operating and Storage Temperature Parameters

Modes Temperature Ranges

Operating Temperature 0°C to 40°C (32°F to 104°F)

Storage Temperature -40°C to 60°C (-40°F to 140°F)

Caution

Telestream recommends connecting computer equipment to AC power through 
an uninterruptible power supply (UPS) with surge protection. Fluctuations in 
commercial supply voltage can damage unprotected electronic equipment. 

A high quality surge suppressor may be substituted if a UPS is not available, but 
it may not provide adequate protection.

Note

Save all packaging materials and store them in a safe place. If you require service – or 
move your Pipeline – the packaging materials may be used for safe shipment.
May, 2012
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Pipeline SC Shipping Container Contents
In addition to the Pipeline itself, each package contains the following:

• Software Installation and User’s Guide CD-ROM

• Power adapter with power cord

• Quick Start Guide (in CD case)

Pipeline Quad Shipping Container Contents
In addition to the Pipeline itself, each package contains the following:

• Software Installation and User’s Guide CD-ROM

• Power cords

• Quick Start Guide (in CD case)

Pipeline HD Dual Shipping Container Contents
In addition to the Pipeline itself, each package contains the following:

• Software Installation and User’s Guide CD-ROM

• Power cords

• Quick Start Guide (in CD case)

LOCATE THE PIPELINE SC

For permanent locations, select a stable and level, smooth, hard surface. Avoid carpeted or cloth-covered 
surfaces which inhibit airflow or reduce heat dissipation, which contributes to overheating. Select an 
isolated area that provides a proper operating environment and protection from accidental damage to the 
Pipeline. Route power, Ethernet, and other cables to protect users from a tripping hazard and damage to 
the Pipeline.

LOCATE THE PIPELINE QUAD | PIPELINE HD DUAL

For permanent locations, mount the Pipeline Quad|HD Dual in a single rack-unit slot in a computer rack 
and secure it in place. Make sure the following issues are adequately addressed:

Elevated Operating Ambient Temperature. If installed in a closed or multi-unit rack assembly, the 
operating ambient temperature of the rack environment may be greater than room ambient. Therefore, 
consideration should be given to installing the equipment in an environment compatible with the maximum 
ambient temperature specified (Operating and Storage Temperature Parameters on page 6).

Reduced Air Flow. Installation of the equipment in a rack should be such that the amount of air flow 
required for safe operation of the equipment is not compromised.

Mechanical Loading. Mounting of the equipment in the rack should be such that a hazardous condition is 
not achieved due to uneven mechanical loading.

Circuit Overloading. Consideration should be given to the connecting equipment to the supply circuit and 
the effect that overloading of the circuits might have on over-current protection and supply wiring. 
Appropriate consideration of equipment nameplate ratings should be given when addressing this concern.
82549
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Reliable Earthing. Reliable earthing of rack-mounted equipment should be maintained. Particular 
attention should be given to supply connections other than direct connections to the branch circuit (e.g. 
use of power strips).
May, 2012
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PIPELINE SC HARDWARE

The Pipeline SC is 7.5 inches (19.1 cm) wide, 5.5 inches (14.0 cm) deep, and 1.5 inches (3.8 cm) high.

Pipeline SC is a compact, network-ready SDI encoder/decoder device equipped with 10/100Mb Ethernet 
using TCP/IP, UDP, RTSP, and RTP. It uses Bonjour for service discovery. Additionally, it employs Serial 
Digital Interface (BNC, SMPTE-259M 270mb/sec) with 8-channel embedded audio input and output ports, 
plus automatic detection of 525/625. It also has an RS-422 deck control port using Sony 9 Pin Protocol.

Pipeline can capture and play out NTSC/PAL having DV/DVCPRO 25Mb, IMX 30|40|50 and MPEG-2 
I-Frame 50Mb MJPEG, ProResSQ video (capture only) video, and 48 KHz, 16/24 bit, uncompressed 
audio.

Processing VBI Closed Captions and Timecode Data
Pipeline automatically processes Vertical Blanking Interval (VBI) data on ingest operations to obtain closed 
caption and timecode data. Closed captions are extracted from line 21, and timecode from lines 16 through 
20 (5 lines beginning with line 16). The last line (usually 20) with a valid timecode is the line whose data is 
used. Pipeline encodes the closed caption and timecode data into the data stream of the digital output, 
making it available for processing by client applications, such as FlipFactory, Vantage, Agility, and Episode.

Front Panel Indicators
The front panel contains LED indicators, making it easy to check its status.

Figure 2–1. Pipeline SC front panel

There are three LEDs you use to determine the state of the Pipeline:

Power. Displays green light when power is present.

SDI In. Display green light when Pipeline is configured to encode SDI In and send it out via Ethernet. How 
media is encoded is determined by the selected codec. If the LED lights orange, data is being lost. The 
reason should be corrected before continuing operation. During a firmware upgrade, this LED lights yellow 
until you reboot.

SDI Out. Displays green light when the Pipeline is configured to decode digital media from the Ethernet 
port, and send decoded media to the SDI Out port. If the LED lights orange, data is being lost. The reason 
should be corrected before continuing operation.

Power On
LED

SDI In
LED

SDI Out
LED
82549
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Rear Panel Ports and Connectors
The rear panel contains the power jack, plus video and network connector ports.

Figure 2–2. Pipeline SC rear panel

When connecting video equipment, Ethernet, and RS-422 cables, be sure that the power supply is 
disconnected from the Pipeline. Failure to do so may result in equipment malfunction or damage. 

DC Power Port. Use to connect and turn on the Pipeline. Only connect the Pipeline to power using the 
Telestream-supplied power supply.

10/100 Ethernet Port. The Ethernet port has two LEDs:
Link (left LED): If the LED is not lit, no link is available. If the LED is lit orange, link has been established.

Connection/Activity (right LED): If the port is connected at 100 Mb, the LED lights green, and blinks on 
activity. If the port is connected at 10 Mb, the LED is unlit, but blinks green during activity.

RS-422. Female DB-9 RS-422 port for VTR, using Sony 9 Pin protocol.

SDI In. BNC jack for SDI input signal.

SDI Out. BNC jack for SDI output. 

Caution

If the Connection LED is unlit, the Pipeline is operating at 10 Mb, which is 
unacceptable for real time video traffic. Resolve the problem before continuing, 
to avoid video stream data loss.

DC Power 
Connector

SDI
In

SDI
Out

10/100
Ethernet

VTR RS-422
May, 2012
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PIPELINE QUAD HARDWARE

The Pipeline Quad is 17.3 inches (43.9 cm) wide, 13.2 inches (33.5 cm) deep, and 1.5 inches (3.8 cm) 
high. Pipeline Quad is a single rack unit device, with four onboard SDI encoder/decoder devices equipped 
with an external Gigabit Ethernet port and an onboard switch routing 100Mb Ethernet to each device, using 
TCP/IP, UDP, RTSP, and RTP and Bonjour for service discovery. Serial Digital Interfaces are provided for 
each device (BNC, SMPTE-259M 270mb/sec).

There are 4 SDI in and out ports (per Quad, not per channel), each supporting up to 16 channels of 
embedded audio, with four SDI in and out ports (per Quad) with automatic detection of 525/625, and RS-
422 deck control ports, using Sony 9 Pin Protocol.

Pipeline Quads can encode and decode NTSC or PAL with DV/DVCPRO 25Mb, IMX 30, 40, 50, MPEG2 I-
Frame 50Mb MJPEG, and ProRes SQ video (encode only, in FlipFactory workflows), and 48 kHZ, 16 and 
24 bit, uncompressed audio, in up to four concurrent sessions; each individual Pipeline channel operates 
independently, each communicating via a common physical Ethernet port on the Quad’s backplane.

The Pipeline Quad and HD Dual provides common, dual power supplies for redundancy and fail-safe 
operation. Telestream highly recommends that both power supplies be connected during operations. The 
Pipeline can operate normally on a single power supply, however you will lose the redundant safety of the 
second power supply.

Using SDI Sync Input
The SDI Sync Input is used in both capture and playout modes but for two different purposes.

In capture mode, the SDI Sync Input is used as a method for supplying a common timecode reference to 
all input channels. For the timecode to be extracted, the SDI signal connected to the SDI Sync Input must 
contain a valid timecode in the vertical blanking area of the signal. This timecode is usually referred to as 
VITC (vertical interval timecode). The SDI signal must be a digital signal that is frame synchronized with 
the SDI signals used as the input video source for the timecode extraction to work properly. An analog 
signal cannot be connected to the SDI Sync input.

In playout mode, the SDI Sync Input is used as a frame synchronization source for each of the SDI 
outputs. Any timecode on the SDI Sync Input is ignored in this mode. If no signal is connected to the SDI 
Sync Input, each of the SDI outputs will free run (i.e. they will not be synchronized with each other or with 
any house reference).

Using SDI Sync Out
The SDI Sync Out port is a re-clocked loop-through port of SDI Sync In. You can use this re-clocked 
reference for additional Pipelines or other devices.

Processing Closed Caption and Timecode Data
Pipeline automatically processes Ancillary Data on ingest operations to obtain closed captions and 
timecode data. Pipeline encodes the closed caption and timecode data into the data stream of the digital 
output, making it available for further processing by client applications, such as FlipFactory, Vantage, 
Agility, and Episode.

The Pipeline automatically analyzes the signal during the Vertical Blanking Interval (VBI) on ingest 
operations to obtain closed captions and timecode data. Closed caption data is extracted from line 21, and 
timecode data from lines 16 through 20 (the 5 lines beginning with line 16). The last line (usually line 20) 
with a valid timecode is the line whose data is used.
82549
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Front Panel Indicators
The front panel contains LED indicators, making it easy to check its status.

Figure 2–3. Pipeline Quad front panel

SDI In. One per channel. Lights green when the Pipeline is configured to encode SDI In and send it out via 
the Ethernet port. Media is encoded based on the selected codec. If the LED lights orange, data is being 
lost. Correct problem before continuing. During a firmware upgrade, the LED lights yellow until the upgrade 
completes and the Pipeline is automatically rebooted.

SDI Out. One per channel. Lights green when the Pipeline is configured to decode digital media from the 
Ethernet port, and send decoded media to the SDI Out port. If the LED lights orange, data is being lost. 
The problem should be corrected before continuing operation.

The LED blinks orange at one second intervals when the internal Ethernet switch and network that 
connects the four Pipelines has failed. Usually, at least one of the Pipelines can’t communicate, indicating 
that potentially an input channel has failed, and confidence monitoring is not operational. Reboot Pipeline 
to solve the problem, or contact Telestream customer service.

Link. Lights green when Ethernet link has been established.

Sync. Lights green when an SDI signal is detected on the sync reference input channel.

PWR 1 & 2. Lights green when power is present and the power supply is operating normally. PWR1 
indicates power supply 1; PWR2 indicates power supply 2. An orange PWR LED indicates a failed power 
supply or that no power is present.

If a power supply fails, complete jobs in progress. RMA the Pipeline to Telestream for repair as soon as 
practical.

Front Panel Reset Switches
With the front panel bezel removed, five recessed reset buttons are exposed. They are not labeled.

Figure 2–4. Pipeline Quad reset switches behind front panel

Channel 1 Reset. Insert a pointed object to depress the recessed button to perform a hardware reset on 
Channel 1. The channel will be disconnected from any client currently attached.

Power 1 & 2 LEDsSDI In LED (1 per channel) Link LED
SDI Out LED (1 per channel) Sync LED

Channel 3 reset

Channel 1 reset Factory defaults

Channel 2 reset Channel 4 reset
May, 2012
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Channel 2 Reset. Insert a pointed object to depress the recessed button to perform a hardware reset on 
Channel 2. The channel will be disconnected from any client currently attached.

Channel 3 Reset. Insert a pointed object to depress the recessed button to perform a hardware reset on 
Channel 3. The channel will be disconnected from any client currently attached.

Channel 4 Reset. Insert a pointed object to depress the recessed button to perform a hardware reset on 
Channel 4. The channel will be disconnected from any client currently attached.

 Factory Default Reset. Insert a pointed object to depress the recessed button to restore the factory 
defaults of the Pipeline device. Both channels are returned to their original factory default values, including 
IP address and global options selected. During reset all LEDs glow green. When reset is complete, the 
LEDs return to their normal state.

Rear Panel Ports and Connectors
The rear panel contains power plugs, plus video and network connector ports.

Figure 2–5. Pipeline Quad rear panel

When connecting video equipment, Ethernet, and RS-422 cables, be sure that the power supply is 
disconnected from the Pipeline. Failure to do so may result in equipment malfunction or damage.

AC Power Plugs. Use to connect and turn on the Pipeline. Only connect the Pipeline Quad to power using 
the Telestream-supplied power cords. To insure fail-safe operation, be sure to use both power supplies. 
These supply common power to the Pipeline; if one power supply fails, the Pipeline continues to operate.

Sync In. The SDI Sync Input is used in both capture and playout modes but for two different purposes. In 
capture mode it is used as a method for supplying a common timecode reference to all input channels. In 
playout mode it is used as a frame synchronization source for each of the SDI output channels (Using SDI 
Sync Input on page 11). 

Sync Out. Re-clocked loop-through port of SDI Sync In. You can use this re-clocked reference for 
additional Pipelines or other devices.

RS-422. Female DB-9 RS-422 port for VTR, using Sony 9 Pin Protocol (one per channel).

Note

Resetting factory defaults does not change the firmware or app loader versions.

Note

Pipeline does not support any analog (bi-level or tri-level) reference. Do not attempt to 
use any form of analog reference with Pipeline.

AC Power 
Connectors

SDI In (one per channel)

Gigabit
Ethernet

VTR RS-422
 (one per channel)

SDI Out (one per channel)Sync In/Out
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SDI In. BNC jack for SDI input (one per channel).

SDI Out. BNC jack for SDI output (one per channel).

Gigabit Ethernet Port. The Ethernet RJ-45 jack has two LEDs: If the left, orange LED is lit and the right, 
green LED is lit, the port is operating at 1Gbs (gigabit). If only the orange LED is lit, the Ethernet port is not 
connected. Be sure to use CAT-6 cabling end-to-end from Pipeline to your Macintosh or Windows PC 
client for best results.

WARNING

SDI-OUT is intended to be used for monitoring of the looped SDI-IN input source 
and should not be used to distribute this source to additional capture channels. 
Do not connect the looped SDI-OUT signal into any other Pipeline SDI-IN port. 
This may cause unintended capture interruptions on the channel connected to 
the looped source.

Caution

If only the green LED is lit or the LED is unlit, the Pipeline is operating at 100 or 
10 Mb respectively. These data rates are unacceptable for real time video traffic 
from all four channels. Resolve the problem by connecting at 1 Gbs before 
processing jobs to avoid data loss.
May, 2012
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PIPELINE HD DUAL HARDWARE

The Pipeline HD Dual is 17.3 inches (43.9 cm) wide, 13.2 inches (33.5 cm) deep, and 1.5 inches (3.8 cm) 
high. Pipeline HD Dual is a single rack unit device with two onboard HD/SD-SDI encoder/decoder devices 
equipped with two external Gigabit Ethernet ports. It uses TCP/IP, UDP, RTSP, and RTP and Bonjour for 
service discovery. Serial Digital Interfaces are provided for each device (BNC, SMPTE-259M 270mb/sec) 
with 2 SDI in and out ports (per HD Dual), each supporting up to 16 channels of embedded audio, with 
automatic input format detection. It also provides RS-422 deck control ports using Sony 9-Pin Protocol.

Pipeline HD Dual can encode DV/DVCPRO 25/50, IMX 30|40|50, MPEG-2 50M I-frame (FlipFactory 
workflows) MJPEG, ProRes HQ/SQ/LT/Proxy, Avid DNxHD and DVCProHD video, and 48 KHz, 16/24 bit, 
uncompressed audio.

The Pipeline Quad and HD Dual provides dual power supplies for redundancy and fail-safe operation. 
Telestream highly recommends that both power supplies be connected during operations. Pipeline can 
operate normally on a single power supply, however you will lose the redundant safety of the second 
power supply.

Using SDI Sync Input
The SDI Sync Input is used in both capture and playout modes but for two different purposes. 

In capture mode, the SDI Sync Input is used as a method for supplying a common timecode reference to 
all input channels. For the timecode to be extracted, the SDI signal connected to the SDI Sync Input must 
contain a valid timecode in the vertical blanking area of the signal. This timecode is usually referred to as 
VITC (vertical interval timecode). The SDI signal must be a digital signal that is frame synchronized with 
the SDI signals used as the input video source for the timecode extraction to work properly. An analog 
signal cannot be connected to the SDI Sync input.

In playout mode, the SDI Sync Input is used as a frame synchronization source for each of the SDI 
outputs. Any timecode on the SDI Sync Input is ignored in this mode. If no signal is connected to the SDI 
Sync Input, each of the SDI outputs will free run (i.e. they will not be synchronized with each other or with 
any house reference).

Processing Closed Caption and Timecode Data
Pipeline automatically processes Ancillary Data on ingest operations to obtain closed captions and 
timecode data. Pipeline encodes the closed caption and timecode data into the data stream of the digital 
output, making it available for further processing by client applications, such as FlipFactory and Episode.

When a Standard Definition SDI signal is connected, the Pipeline automatically analyzes the signal during 
the Vertical Blanking Interval (VBI) on ingest operations to obtain closed captions and timecode data. 
Closed caption data is extracted from line 21, and timecode data from lines 16 through 20 (the 5 lines 
beginning with line 16). The last line (usually line 20) with a valid timecode is the line whose data is used.

When an HD SDI signal is connected, the Pipeline automatically processes all ancillary data packets to 
obtain closed captions and timecode data. Closed caption data is extracted from Ancillary data packets 
with a DID of 0x161 and timecode data is extracted from Ancillary data packets with a DID of 0x260.
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Front Panel Indicators
The front panel contains LED indicators, making it easy to check its status.

Figure 2–6. Pipeline HD Dual front panel

SDI In. One per channel. Lights green continuously when an HD source is connected. Flashes green when 
an SD source is connected. If the LED flashes orange, data is being lost. The problem should be corrected 
before continuing operation.

SDI Out. One per channel. Lights green continuously when HD format media is being output. Flashes 
green when SD format media is being output. If the LED lights orange, data is being lost. The problem 
should be corrected before continuing operation.

Mode. Lights green continuously when the selected codec is creating HD content. Flashes green when the 
selected codec is creating SD content.

Reference. Lights green continuously when an HD source signal is detected on the sync input reference 
channel. Flashes green when the source signal is SD.

Sync. Lights green when an HD source signal is detected on the sync input reference channel. Flashes 
green when the source signal is SD.

LAN. Flashes green to indicate LAN activity.

PWR 1 & 2. Lights green when power is present and the power supply is operating normally. PWR1 
indicates power supply 1; PWR2 indicates power supply 2. Orange indicates a failed power supply or that 
power is not present. If a power supply fails, complete jobs in progress and RMA the Pipeline to 
Telestream for repair as soon as practical.

Front Panel Reset Switches
With the front panel bezel removed, three recessed reset buttons are exposed. They are not labeled.

Figure 2–7. Pipeline HD Dual reset switches behind front panel

Channel 1 Reset. Insert a pointed object to depress the recessed button to perform a hardware reset on 
Channel 1. The channel will be disconnected from any client currently attached.

Power 1 & 2 LEDsIn LED (1 per channel)

Reference LED

Out LED (1 per channel) LAN LED
Mode LED

Channel 2 reset

Channel 1 reset Factory defaults

Unused Unused
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Channel 2 Reset. Insert a pointed object to depress the recessed button to perform a hardware reset on 
Channel 2. The channel will be disconnected from any client currently attached.

Factory Default Reset. Insert a pointed object to depress the recessed button to restore the factory 
defaults of the Pipeline device. Both channels are returned to their original factory default values, including 
IP address and global options selected. During reset all LEDs glow green. When reset is complete, the 
LEDs return to their normal state.

Rear Panel Ports and Connectors
The rear panel contains power plugs, plus video and network connector ports.

Figure 2–8. Pipeline HD Dual rear panel

When connecting video equipment, Ethernet, and RS-422 cables, be sure that the power supply is 
disconnected from the Pipeline. Failure to do so may result in equipment malfunction or damage.

AC Power Plugs. Use to connect and turn on the Pipeline. Only connect the Pipeline Quad to power using 
the Telestream-supplied power cords. To insure fail-safe operation, be sure to use both power supplies. 
These supply common power to the Pipeline; if one power supply fails, the Pipeline continues to operate.

Sync In. The SDI Sync Input is used in both capture and playout modes but for two different purposes. In 
capture mode it is used to supply a common timecode reference to all channels. In playout mode it is used 
as a frame synchronization source for each SDI output channel. (See “Using SDI Sync Input” on page 11.) 

Sync Out. Re-clocked loop-through port of SDI Sync In. Use for additional Pipelines or other devices.

RS-422. Female DB-9 RS-422 port for VTR, using Sony 9 Pin Protocol (one per channel).

SDI In. BNC jack for SD-SDI or HD-SDI input (one per channel).

Note

Resetting factory defaults does not change the firmware or app loader versions.

Note

Pipeline does not support any analog (bi-level or tri-level) reference. Do not attempt to 
use any form of analog reference with Pipeline.

AC Power Connectors

SDI In (one per channel)
Gigabit Ethernet
(one per channel)

VTR RS-422
 (one per channel) SDI Out (one per channel)

Sync In/Out
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SDI Out. BNC jack for SD-SDI or HD-SDI output (one per channel).

Gigabit Ethernet Ports. Each Ethernet RJ-45 jack has two LEDs: If the left, orange LED is lit and the 
right, green LED is lit, the port is operating at 1Gbs (gigabit). If only the orange LED is lit, the Ethernet port 
is not connected. Be sure to use CAT-6 cabling end-to-end from Pipeline to your Macintosh or Windows 
PC client for best results.

WARNING

SDI-OUT is intended to be used for monitoring of the looped SDI-IN input source 
and should not be used to distribute this source to additional capture channels. 
Do not connect the looped SDI-OUT signal into any other Pipeline SDI-IN port. 
This may cause unintended capture interruptions on the channel connected to 
the looped source.

Caution

If only the green LED is lit or the LED is unlit, the Pipeline is operating at 100MB 
or less – rates unacceptable for real time video on all four channels. Resolve the 
problem by connecting at 1 Gb/sec. before processing jobs to avoid data loss.
May, 2012
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CONNECTING PIPELINE TO MAC OS X OR WINDOWS 
COMPUTERS

Pipeline can be connected to a Mac OS X computer – a Final Cut Pro workstation or Episode Engine 
server, for example. Or, it can be connected to a Windows computer – a FlipFactory server or Pipeline 
Control workstation, for example. You can connect Pipelines directly or via LAN using a Gigabit Ethernet 
(Gig-E) switch for Pipeline Quad|HD Dual or 100MB Ethernet for Pipeline SC.

Note

For workstations or servers with multiple network adapters, you should always connect 
the Pipeline (or switch) to the second interface on the system (Windows: Local Area 
Connection 2, Mac OS X: en1).

If you are not able to connect to Pipelines using this configuration you may have 
devices on your first network using the same address scheme as your Pipelines. To 
correct this, run the following commands in a command window (verify with your 
network administrator). 

This example is for modifying your system's routing table for a Pipeline configuration 
using the default 169.254.xxx.xxx self-assigned address scheme. Modify these 
commands accordingly for your configuration:

Mac OS X:

To remove:
sudo route delete -net 169.254.0.0/16

To add it back to en1:
sudo route add -net 169.254.0.0/16 -interface en1

Windows:

When Pipeline Control discovers Pipelines on the network, it records the Network 
Interface Card (NIC) that the Pipeline responded on. The computer's routing tables are 
then examined to see if a valid route is available to the Pipeline Control application on 
which to communicate. If a valid route is not found then Update Route is displayed. 
Click Update Route to add a valid entry into the computer's routing table.

Click R to refresh status. A green bullet icon indicates that this Pipeline is available. A 
red bullet indicates that it is currently busy (connected to another client application). 
Gray indicates offline; yellow indicates an unknown state. To enable you to select a 
Pipeline to set up a document for use later, you can select a Pipeline regardless of its 
state. This dialog reports the Pipeline's current status (idle, capturing, recording, 
unknown), name, input source, firmware version, device type (SD or HD) and system 
NIC connection.

If any type of Bonjour is installed, the R icon is greyed out and the refresh functionality 
is not available.

Click 
Update 
Route

Click R
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Use the instructions in this section to make Ethernet and video connections to your Pipeline when 
connecting it to a Mac OS X or Windows computer – either directly or via a switch.

Figure 2–9. Pipeline video, VTR & network connections

1. Make sure the Pipeline is not plugged in.

2. Connect the Pipeline Ethernet port directly, or via a switch, to the computer with an Ethernet cable. (A 
crossover cable may be required for direct connections with some NICs.)

3. Connect your VTR SDI Out port to the Pipeline SDI In port with a BNC coax cable connected to your 
video source – a VTR, for example.

4. (Optional) Connect the VTR RS-422 port to the Pipeline RS-422 port.

5. (Pipeline Quad/HD – Optional) Connect video equipment to your Sync In and Sync Out video ports.

ADDING PIPELINE TO A NETWORK

One or more Pipelines can connect to a LAN. To assure acceptable performance, be sure to connect 
Pipelines to a media network or a single Gigabit switch dedicated specifically for Pipelines, edit stations, 
and media servers. If you connect to a backbone, ensure it is Gigabit, to handle the real-time traffic. Make 
certain that switches do not have a firewall, and that TCP and UDP ports 7000/7002 (video), 7004/7006 
(audio), 7008/7010 (status), 554 (RTSP), and 80 (http) are open.

Each Pipeline channel is assigned a unique, automatically assigned, link-local IP address in the range 
169.254.1.0 to 169.254.255.255, so that it can communicate directly with your computer without a 
gateway. Each of the Pipelines (channels) in a Pipeline HD Dual and Pipeline Quad is assigned an 
incremental IP address.

You can also set up the Pipeline with a static address. Make IP address modifications with Pipeline 
Administrator, a Web application built into each Pipeline (Using the Configure Panel on page 51).

WARNING

Do not enable Windows or Internet Explorer Proxy server on a Pipeline System 
host machine. This may cause various network and performance issues related 
to the Pipeline Control application.

Ethernet

RS-422
VTR Control

SDI
Video/Audio

Ethernet

RS-422
VTR Control

SDI
Video/Audio
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Use these instructions to make power, Ethernet, and video connections to one or more Pipelines when 
connecting it to a LAN where FlipFactory server or Final Cut Pro editing stations are located.

Figure 2–10. Pipeline video, VTR control & network LAN connections

1. Make sure the Pipeline is not plugged in.

2. Connect the Pipeline Ethernet port to a network switch with an Ethernet cable on the same LAN as 
your Final Cut Pro editing station or FlipFactory server.

3. Connect each Pipeline SDI IN port to an SDI source such as your VTR or SDI router with a BNC cable.

4. (Optional) Connect each Pipeline’s RS-422 port to an RS-422 control, such as your VTR.

5. (Pipeline Quad and HD Dual – Optional) Connect video equipment to your Sync In and Sync Out video 
ports.

POWERING UP THE PIPELINE

For Pipeline SC, plug the Telestream-supplied power adapter jack into the power port on the rear panel, 
and then connect the power cord to an AC source (or power converter) to power the Pipeline on.

For Pipeline HD Dual and Pipeline Quad (with redundant power supplies) plug both Telestream-supplied 
power cords into the power plugs on the rear panel, and then connect each power cord to an AC source (or 
power converter) to power the Pipeline on.

Note

Do not enable Windows or Internet Explorer Proxy server on a Pipeline System host 
machine. This may cause various network and performance issues related to the 
Pipeline Control application.

RS-422
VTR Control

SDI
Video/Audio

100MB
Ethernet

RS-422
VTR Control

SDI
Video/Audio

GigaBit Ethernet Backbone100MB
Ethernet
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CONFIGURING & CONNECTING TO PIPELINES

As with other network devices, each Pipeline has a fixed MAC address and a default IP address, which 
you can change. Before using Pipeline, you’ll need to contact your IT administrator (especially when 
connecting to a LAN) to determine which IP address and net mask to use for each Pipeline and how to set 
it up (automatic link-local, DHCP F/W v2.4 or earlier, or static), based on your facility’s network address 
policy.

Configuring Pipeline Network Settings
To view and modify the Pipeline’s network configuration, log on and display the Configure panel (click 
Configure in the toolbar at the top of Pipeline Administrator). See Using the Configure Panel on page 51.

After plugging the Pipeline into the network and powering it on, you can connect to Pipeline via Bonjour, or 
you can use the Pipeline’s default IP address.

When you connect, Pipeline Administrator displays in your browser. For details on using Pipeline 
Administrator, see Chapter 5, Using Pipeline Administrator on page 47. 

REGISTERING YOUR PIPELINE WITH TELESTREAM

When the Pipeline is operational and you can connect via Pipeline Administrator, register the Pipeline with 
Telestream – display the About panel and click the Register button. Follow the steps on the Web page to 
complete registration.

If the computer you’re using is on a LAN without Internet access, use a computer that has Internet access 
and go to dynamic.telestream.net/pipeline-register/register.asp to register your Pipeline. You should 
register your Pipeline to ensure ongoing warranty service and customer service, per the terms of service.

Note

In the unlikely event that you can’t connect, try these steps:

Make sure the Pipeline is connected to a switch on your LAN and powered on, and the 
Power LED on the front is lit.

Ping the Pipeline using the IP address. If you can’t ping it, there may be an IP address 
conflict, causing Pipeline to use a secondary address. Unplug the Pipeline and connect 
the Pipeline directly to a computer via an Ethernet cable, plug it in and ping it again.

If you’re connected directly to a computer, but can’t ping it, you may be using a standard 
Ethernet cable, but due to computer limitations, you need to use a cross-over cable.

If you can ping the Pipeline but still can’t connect, you may have a firewall blocking the 
connection.

See Appendix A, TroubleShooting, for assistance.
May, 2012
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C H A P T E R 3

I n s ta l l i n g  P i p e l i n e
S o f t w a r e
Chapter 3, Installing Pipeline Software

Use this chapter to install, update, or uninstall Pipeline software.

Topics

 Installing Pipeline Software (page 24)

 Updating Pipeline Software (page 24)

 Removing Pipeline Software (page 25)

Note

Telestream recommends that Pipeline Control be installed on a computer that is not 
hosting FlipFactory, Episode Engine, or other media processing applications: intense 
disk and CPU consumption can interfere with proper operation of both applications.

Be sure to review your platform, system and workflow requirements before installing 
Pipeline software. When you install or update Pipeline client software, you may have to 
upgrade the firmware revision in your Pipeline hardware. (see Implementing Pipeline 
Workflows on page 27)
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INSTALLING PIPELINE SOFTWARE

Pipeline for Mac OS X consists of:

• Pipeline Plugin for Final Cut Pro and Episode/Episode Pro 5.x.

• Pipeline Control

All components are installed, so that you can use the components as you want.

Pipeline Software for Mac OS X is available from www.telestream.net as a disk image file. It is also 
distributed on the Pipeline CD as an installer package file.

When you download or open the dmg file with Safari, Mac OS X automatically mounts the disk image (if 
necessary) and runs the installer. When you download a dmg file using another Web browser, mount the 
file yourself. Then, double-click it to run the installer.

UPDATING PIPELINE SOFTWARE

Follow the instructions in Installing Pipeline Software (immediately preceding) to update your software.

Software updates are periodically posted on Telestream’s Web site at www.telestream.net. Click Support > 
Support Home, then select Pipeline under the Pipeline section – software updates are in the left column.

Make sure that Final Cut Pro, Episode Desktop, Pipeline Control, and QuickTime are not running, before 
you upgrade your software.

Note

You’ll be asked for an administrator name & password during installation. If you don’t 
have an administrative account, you’ll need to obtain one in order to perform 
installation. You must restart Final Cut Pro and Episode Desktop for the Pipeline plugin 
to work correctly.

The installer will attempt to close QuickTIme, Final Cut Pro, Episode Desktop, and 
Pipeline Control before installing the software. If any of these applications cannot be 
closed (for example, because they have an open document that hasn't been saved) 
installation will fail after about a minute (unless you click Save or Discard during this 
time to close the application).

Note

You can set up the Pipeline plugin and Pipeline Control to check for updates 
periodically. Go to Preferences and click the Update tab to check for updates 
immediately, and determine how often you want to check for upgrades on a regular 
basis.

When you open schedules created in previous versions, you may need to reset the 
audio and video settings before using them.
May, 2012
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REMOVING PIPELINE SOFTWARE

To uninstall Pipeline software, remove the following files and restart your computer:

/Applications/Pipeline Control
~/Library/Application Support/Final Cut Pro System Support/Plugins/Pipeline Plugin.bundle
~/Library/Application Support/Pipeline/PlugIns/Copy File.plugin
~/Library/Application Support/Pipeline/PlugIns/EpisodeEngine.plugin
~/Library/Application Support/Pipeline/PlugIns/Final Cut Pro.plugin
~/Library/Application Support/Pipeline/PlugIns/FlipFactory.plugin
~/Library/Application Support/Pipeline/PlugIns/Instant Message.plugin
~/Library/QuickTime/TIFO.component
~/Library/QuickTime/Telestream IMX.component
~/Library/QuickTime/Telestream DvcProHD.component
~/Library/Preferences/net.telestream.PipelineControl.plist

Removing Pipeline does not remove any schedules or log and capture documents you’ve created, or any 
media you’ve saved on this computer.

Note

The ~ character in front of a path indicates that this path is in your active user's folder.
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C H A P T E R 4

I m p l e m e n t i n g  P i p e l i n e
W o r k f l o w s
Chapter 4, Implementing Pipeline Workflows

To implement Pipeline workflows, which capture or play out media on Mac OS X or Windows, you’ll need to 
install Pipeline software. Use this chapter to determine your workflow and system requirements, and to 
install, update, or uninstall Pipeline software.

Topics

 Pipeline Application Feature Comparison (page 28)

 Workflow System Requirements (page 30)

 General Pipeline System Setup Information (page 30)

 Disk Buffering Details (page 39)

 Disk and Network Requirement by Media Format (page 41)

Note

Telestream recommends that you only install Pipeline Control on a computer that is not 
hosting FlipFactory, Vantage, Agility, Episode Engine, or other media processing 
applications: intense disk and CPU consumption can interfere with proper operation of 
both applications.

When you install or update Pipeline client software, you may have to upgrade the 
firmware revision in your Pipeline hardware.

Note

If you haven’t installed the Pipeline yet, proceed to Chapter 2, Pipeline Hardware, 
Installation & Setup on page 5 before continuing.

Before you use a Pipeline to capture and play out media, the device must be 
configured using Pipeline Administrator (Chapter 5, Using Pipeline Administrator on 
page 49).
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PIPELINE APPLICATION FEATURE COMPARISON

Pipeline software includes two applications – Pipeline Control and Pipeline Plugin for Episode and Final 
Cut Pro, compared below.

Pipeline Control.  Pipeline Control is available for Mac OS X Snow Leopard, Windows 2008 
Server, and Windows 7. You can use Pipeline Control to capture or play out media from/to Pipeline SC, 
Pipeline Quad, and Pipeline HD Dual.

Pipeline Plugin for Final Cut Pro and Episode | Episode Pro. The feature set of Telestream's Pipeline 
applications vary by platform, and by program type - application or plugin. The following table identifies the 
features implemented in each Pipeline program:

Table 4–1. Feature comparison of Pipeline client applications

Pipeline Software Features Pipeline Control
(Windows)

Pipeline Control
(Mac OS X)

Pipeline 
Log & 
Capture 
Plugin

Supports Pipeline HD Dual   

Supports Pipeline SC and Pipeline Quad   

24-hour recurring record  

24-hour recurring playout 

Log & Capture with deck control   

Triggered manual and automated capture  

Print to Tape – Insert Edit   

Print to Tape – Assemble Edit   

Print to Tape – Crash Playout   

Web Service API  

Open directly from Final Cut Pro 

Open directly from Episode Desktop 

Edit while capturing  

Transcode while capturing
(FlipFactory|Episode Engine)

 

Import Pipeline G4G EDL files   

Import|Export Final Cut Interchange files   

Create QuickTime Open files directly  

Create QuickTime Closed files directly   

Create TIFO files directly  

Controlled Playout (Virtual VTR) 

Video Wall 
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Pipeline Log and Capture Plugin

You can install the Pipeline Plugin in Final Cut Pro Version 5.01 or later, and you can install it in Episode 
v5.x (this plug-in is not compatible with Episode v6).

When you install the plugin, you can use all of the Pipeline features listed in the table above. For complete 
details, Using Pipeline in Final Cut Pro & Episode on page 63.

Create Avid AAF/MXF OPAtom files directly
(Available only on 32 bit OS)

 

Create Generic MXF DNxHDOP1a files with
with DV|DVCPro|IMX video essence

 

Pipeline Software Features Pipeline Control
(Windows)

Pipeline Control
(Mac OS X)

Pipeline 
Log & 
Capture 
Plugin
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WORKFLOW SYSTEM REQUIREMENTS

Pipeline applications can be used with these versions of FlipFactory, Vantage, Episode, and Final Cut Pro:

• FlipFactory 6.0 with Service Pack 5, FlipFactory 6.1, 7.0 and 7.1.

• Episode Engine version 5.0 or greater

• Final Cut Pro Version 5.1.4 or newer

• Vantage 1.0 or later

GENERAL PIPELINE SYSTEM SETUP INFORMATION

Pipeline is a unique, network-attached encoder that can be used in a variety of capture and playout 
workflows. As a network device, architectural constraints figure prominently in configuring an efficient and 
reliable Pipeline workflow.

Pipeline System Architecture

Pipeline capture workflows consist of ingesting baseband HD/SD-SDI input, compressing it, creating a file 
with the compressed data, and delivering the completed file to a folder location. You can connect one or 
more Pipelines (Single, Quad, or HD Dual) to a Pipeline host computer (Mac OS X or Windows).

Pipelines should be connected directly via CAT6 Ethernet to a Pipeline host computer or via an enterprise 
class, fully non-blocking, professional-quality Ethernet switch. 

The key components include the Pipeline device itself, the network, the Pipeline host computer, the 
Pipeline Control application, software and the Pipeline media disk storage device. Each of these 
components is described below. 

The Pipeline Device

Each Pipeline has one to four channels each (single channel, Quad or HD Dual) with SDI I/O for capture 
and play out. The SDI connectors ingest baseband SD/HD-SDI signals, compress them into one of many 
supported formats and stream the compressed data out their respective Ethernet ports using Real Time 
Streaming Protocol (RTSP). Each channel's RTSP stream contains video, audio and application/control 
data in RTP transport packets. These streams are ingested by the Pipeline Control application running on 
a Pipeline host computer.

Pipeline Host & Pipeline Application Software

The Pipeline Control wraps each RTSP stream into the appropriate file wrapper and delivers these files to 
their respective media storage locations. The Pipeline host computer is primarily responsible for delivering 
one or more Pipeline channel's RTSP streams via Ethernet to the Pipeline application it is hosting.
May, 2012
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A Pipeline host computer can control multiple Pipeline channels concurrently. See the examples below to 
determine how best to configure a Pipeline System to meet your particular needs.

Pipeline applications, such as Pipeline Control, perform many tasks. These tasks include scheduled 
capture and play out, log/capture from tape sources, manual and automated capture from live sources, 
print to tape, and controlled playout.

Pipeline applications also provide interfaces to (or within) video edit software, FlipFactory, Vantage, Agility, 
Episode Engine, Episode desktop, and disk file systems.

There are five key factors to consider when configuring your Pipeline host system:

• CPU cores and speed

• Disk storage systems (both for the media destination and for disk buffering)

• Network connection 

• System RAM

• System Video Card

Use the system descriptions, recommended systems chart, and network and storage sections to configure 
your Pipeline host system appropriately for your workflow requirements.

Pipeline Network

For best results, Pipelines should be connected directly to a Pipeline host computer or via a single 
enterprise class, fully non-blocking professional-quality Ethernet switch via CAT6 Ethernet cabling. Multiple 
hops via routers and switches increase the risk that video frames will not be processed in a timely manner 
resulting in lost frames. It is highly recommended that the Pipeline host's network adapter be based on 
Intel Gigabit cards.

Capturing across multiple switches or routers is possible with Pipeline only when the link is a full 1 gigabit. 
Always consult with your network administrator when attempting to utilize Pipeline across multiple 
switches, networks or VLAN's.

Recommended network switches:

• Extreme Networks

• Force 10, Cisco

• Foundry (Brocade)

Use of a private Pipeline video VLAN is highly recommended

Special care must be taken to insure that a real-time process can be achieved. Other network processes, 
such as file copying, can consume unbounded bandwidth and excessive network stack cycles which can 
cause Pipeline real-time streams to be interrupted. When constructing a Pipeline system utilizing an 
existing information network, be aware of local processes using the network that could affect Pipeline 
traffic. The best practice is to separate Pipeline traffic from data traffic by using more than one network 
adapter within the Pipeline host computer. Design your system with one (or more) Ethernet ports dedicated 
to the incoming Pipeline streams and separate Ethernet port(s) for general data and media delivery traffic. 

As a rule of thumb, never exceed 50% usage of any one Ethernet port or network switch. For example 
when capturing Pro Res 422 HQ at 220Mbps use one GigE Ethernet port for every two (2) streams. 
Multiple port Ethernet is required for this purpose.
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Network examples

Figure 4–1. Eight channel Pipeline SD capture system

Figure 4–2. Four channel Pipeline HD capture system
May, 2012
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Capture-only Workflows

For capture-only workflows, when writing to internal or direct attached (non-shared) RAID arrays, you only 
need to calculate the overall write speed requirements. Configure your media storage array based on the 
write performance required for the number of streams being captured.

Figure 4–3. Configuration for capturing 4 HD streams onto Fibre-attached storage.

Concurrent Edit/Transcode Workflows

For capture with concurrent edit or transcode workflows, calculate the total read/write speed requirements 
based on the write processes of Pipeline streams and read processes for edit and transcode operations. 

To guarantee error-free operations when writing to NAS, you must use disk buffering. Use an internal or 
direct-attached non-shared RAID array that meets the read/write performance requirement (Disk Buffering 
Details on page 39). 

Pipeline's media storage location (NAS, direct-attached shared storage, or shared network folder) must 
also meet certain read/write performance requirements. When using NAS, direct-attached shared storage 
or shared network folder, be sure to verify that your system has the communications bandwidth for writing 
all Pipeline media data to the media storage location in real-time.

For SD, Telestream recommends that the host's disk storage system provide and maintain a sustained 10 
MB/sec. transfer rate per stream from the Pipeline host computer to the media disk (read/write). 

For DVCPro HD, ProRes 422/SQ/LT/Proxy and standard quality DNxHD, Telestream recommends that the 
Pipeline host's disk storage system provide and maintain a sustained 40 MB/sec. transfer rate per stream 
from the Pipeline host computer to media disk (read/write). For ProRes 422 HQ and high quality DNxHD, 
Telestream recommends at least a 50 MB/second sustained transfer rate.

Note

Disk buffering is required when the destination path is located on a NAS, shared 
network folder, or when edit/transcode while capture operations are to be performed on 
the incoming Pipeline media files.

Some format wrappers do not support this feature. Take special care when writing 
these file types to shared disks.
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Capture Workflows Utilizing NAS|Direct-Attach Storage|Network Folders

For capture writing to NAS, direct-attached shared storage or shared network folder, you should enable 
Pipeline disk buffering (Disk Buffering Details on page 39). 

Disk buffering requires a separate RAID array to guarantee error-free write operations of media streams. 

Figure 4–4. Configuration for capturing four HD streams onto NAS with Fibre-attached buffer.

When calculating disk buffer RAID array read/write performance requirements, you should use two times 
the required Pipeline streams write requirements. This is required to support a write and a read operation 
on the data buffer array for each Pipeline stream. 

The Pipeline's media storage location (NAS, direct-attached shared storage or shared network folder) 
must meet the write performance requirements. When using NAS, direct-attached shared storage or 
shared network folder, be sure to verify that your system has the communications bandwidth for writing all 
Pipeline media data to the media storage location in real-time.

Note

Disk buffering is required when the destination path is located on a NAS,  a shared 
network folder, or when edit/transcode while capture operations are to be performed on 
the incoming Pipeline media files.

Some format wrappers do not support this feature. Take special care when writing 
these file types to shared disks.

Caution

Capturing video is a disk intensive operation. It is important that you create a 
system with adequate disk performance for writing and reading real-time video 
files. In addition to the information provided below, make sure that the disks 
used for Pipeline operations are defragmented often. A fragmented drive can 
decrease performance and may cause capture and playout operations to fail.
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Pipeline Media Storage

In determining storage requirements, there are two main factors to consider – the overall sustained read/
write performance and local data disk buffering.

To ensure performance and quality, the disk storage systems used with the Pipeline host computer must 
be able to meet the demands of reading and writing one or more real-time SD and HD media streams.

For SD, Telestream recommends that the Pipeline host's disk storage system provide and maintain a 
sustained 10 MB/sec transfer rate per stream from the Pipeline host computer to the media disk (read/
write). 

For DVCPro HD, ProRes 422/SQ/LT/Proxy, and standard quality DNxHD, Telestream recommends that 
the Pipeline host's disk storage system provide and maintain a sustained 40 MB/sec transfer rate per 
stream from the Pipeline host computer to media disk (read/write) for each stream. For ProRes 422 HQ 
and high quality DNxHD, Telestream recommends at least a 50 MB/sec transfer rate for each stream. 

To evaluate your needs, first take into account the data rate for the format that you'll be using and the 
number of streams your system will be capturing concurrently. Disk and Network Requirement by Media 
Format on page 41 provides approximate data rates for a variety of formats and resolutions. Use these 
tables to calculate the overall read/write performance requirements for your main storage disk system and 
if needed for your local data buffering storage disk system.

Capture-only, writing to internal or direct-attached RAID array. For systems utilizing internal or direct 
attached (non-shared) storage for capture only operations, you only need to calculate the overall write 
speed requirements. Configure your media storage array based on the write performance requirement for 
the number of streams being captured.

Figure 4–5. Four channel Pipeline HD with direct attached Fibre RAID storage

Capture with concurrent edit or transcode. For systems that are capturing with concurrent edit or 
transcode operations, you should calculate the overall read/write speed requirements based on the write 
processes of Pipeline streams, and the read processes for the edit and transcode operations. To 
guarantee error-free operations you must use Pipeline's data buffering feature utilizing an internal or direct 
attached non-shared storage RAID array for data buffering that meets the desired read/write performance 
requirement (see Disk Buffering Details on page 39). The Pipeline's media storage location (NAS, direct 
attached shared storage or shared network folder) must also meet these minimum read/write performance 
requirements. When using NAS, direct attached shared storage or shared network folder, be sure to verify 
that your system has the communications bandwidth for writing all Pipeline media data to the media 
storage location in real-time.
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Capture writing to NAS, direct attached shared storage or shared network folder. For systems that 
are capturing media written to a NAS or shared network folder, the Pipeline data buffering feature must be 
enabled (see Disk Buffering Details on page 39). Data Buffering requires a separate data buffer RAID array 
to guarantee error-free write operations of Pipeline media streams. Calculating the disk buffer RAID array 
read/write performance requirements use 2X the required Pipeline streams write requirements. This is 
needed to support a write and a read operation on the data buffer array for each Pipeline stream. 

The Pipeline's media storage location (NAS, direct attached shared storage or shared network folder) must 
meet the minimum write performance requirements. When using NAS, direct attached shared storage or 
shared network folder, be sure to verify that your system has the communications bandwidth for writing all 
Pipeline media data to the media storage location in real-time.

Figure 4–6. Four channel Pipeline HD with direct attached data buffer RAID

Example Systems

Distributed Pipeline model. Individual workstations controlling individual channels, each workstation 
meeting the Pipeline channel specification with a network to support all traffic:
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Centralized Pipeline ingest model. A central workstation controlling multiple Pipeline channels. The 
central workstation meets the multiple Pipeline channel specification with a network and storage system to 
support the workflow:

Four channel HD with data buffering. Four channels of HD hosted by a central workstation with delivery 
to a NAS. Data Buffering is enabled through directly attached RAID storage:
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Multiple channel Transcode while capture. Multiple Pipeline channels hosted by a central workstation 
with delivery to a directly attached storage device. The storage is shared to the transcoding servers for 
concurrent processing:

Multiple channel edit while capture. Multiple Pipeline channels hosted by a central workstation with 
delivery to shared storage device. Internal 15K RAID array is used as a Disk Buffer in case the shared 
storage cannot maintain real time writes:
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DISK BUFFERING DETAILS

When Disk Buffering is checked, video and audio data are written into a FIFO disk buffer file in a local 
folder before the data is written to the media file destination.

Figure 4–7. FIFO disk buffering enhances file writing performance

Disk buffering prevents the RAM buffer from overflowing when disk writes are temporarily blocked or 
performance is reduced on the media file destination disk.

The read/write performance for a volume used for disk buffering needs to be able to support the media 
format and number of channels being captured. As a rule of thumb, the buffer disk should be RAID-0 with 
the appropriate number of drives to support the read and write requirements for the number of channels 
with the respective media format used (Disk and Network Requirement by Media Format (page 41)).

Enable Disk Buffering whenever your media file destination is not a local drive or array – such as a NAS, or 
shared network folder.

Figure 4–8. Pipeline buffering process

 

Note

Disk Buffering must be enabled when the destination path is a located on a NAS,  a 
shared network folder, or when edit/transcode while capture operations are to be 
performed on the incoming Pipeline media files.

During capture operations, when the file destination drive's performance is reduced 
due to additional read processes (when performing transcoding, file editing or other 
disk-intensive activity), data is placed into the FIFO (First In, First Out) buffer.

Note

The disk used for buffering should be used exclusively for Pipeline buffering. Using the 
disk buffer drive for other read/write processes may cause unpredictable results.

Incoming media 
stream

RAM buffer Disk buffer

Pipeline Host Computer

Media file 
destination
system
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PLATFORM AND SYSTEM REQUIREMENTS

General Pipeline Host System Requirements

• Pipeline firmware v2.6 or later

• CPU: Intel Core 2 Duo, Intel Quad Core, or greater

• Operating System:

— Mac OS X Version 10.6 (Snow Leopard). Requires QuickTime Version 7.5.5 or newer 
with ProRes decoder component.

— Windows 7 32/64 bit, Windows Server 2008 (32 bit and 64 bit editions). NET 
Framework v3.5 SP1

• Video card with minimum 256MB RAM (for Mac OS X - card must support Quartz Extreme/OpenGL 
accelerated surfaces and be attached to a compatible video display)

• GigE or faster Ethernet adapter

• Final Cut Pro Version 5.0.1 or newer is required when using Pipeline plug-in

System Requirements for FlipFactory Pipeline Workflows
FlipFactory supports workflows utilizing Pipeline SD systems.

• FlipFactory v6.0 with Update Packs 1-5 or FlipFactory v6.1

• Concurrent Pipeline ingest streams may vary depending on CPU and disk speeds

• Recommended server spec:

• Dual 2.3Ghz (or higher) Intel Quad Core CPU 

• Dedicated RAID-0 media storage

• 2GB RAM

Caution

The disk selected for buffering should be used exclusively for Pipeline video/
audio data buffering. Using the disk buffer drive for other read/write processes 
may cause unpredictable results.

Never write to a disk buffer that does not meet the minimum performance 
requirement for the number of channels and media format being captured. See 
Disk and Network Requirement by Media Format (page 41).

The disk buffering drive must never be the same as the media file destination 
drive. This will result in doubling the amount of read and writes operations to 
this drive and will severely degrade overall disk performance.

When schedule events are touching (one file stops and the other starts at the 
same moment) and there is a handle setting of more than zero, the amount of 
data being processed and written to disk doubles for the duration of the handle.

Double capturing may result in data loss in workflows on slow computers, or in 
workflows with multiple simultaneous ingests, since the application may be 
pushing the limits of CPU capacity or disk write speed.
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PIPELINE HOST COMPUTER RECOMMENDATIONS

Network and Hard Disk Performance Requirements (per stream)

Table 4–2. Disk and Network Requirement by Media Format

Recommended Hardware Systems.

Standard Definition

Single channel system

• CPU - Intel Dual Core 2.0Ghz CPU or faster

• RAM - 3GB RAM minimum

• Network's sustained bandwidth for Pipeline channel – 75Mb/s

• Media Storage sustained read and/or write speeds (separate from OS drive)

— Capture only – 10MB/s 

— Play out only – 12MB/s

— Transcode/Edit/Disk Buffering while Capture – 20MB/s

Two channel system

• CPU - Intel Dual Core 2.0Ghz CPU or faster

CODECS
Disk 
Read/Write 
Mbps

Network 
Throughput 
Mbps

Storage (per hour)
Required for 
8-Channel Audio

SD Codecs

Motion JPEG A 0.75 8 5GB

DV/DVC Pro 4.4 35 15GB

IMX30 5.3 43 16GB

IMX40 7.0 56 20GB

IMX50/DVCPro50 8.3 67 25GB

ProRes422 SQ 7.3 58 21GB

Uncompressed 8-bit 422 22 175 80GB

HD Codecs 
(range based on codec and bit rate)

DVCPro HD 16.5 135 73GB

ProRes 422 HQ 10-36 62-240 50-100GB

DNxHD 10-36 62-240 50-100GB

Note

All systems assume media storage local (internal or direct attached) to the host system 
with adequate storage to support 24 hours of content at the chosen format, and drive 
array is less than 80% full without serious fragmentation.
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• RAM - 6GB RAM minimum

• Network's sustained bandwidth for Pipeline channels – 150Mb/s

• Media Storage sustained read and/or write speeds (separate from OS drive)

— Capture only – 20MB/s 

— Play out only – 24MB/s

— Transcode/Edit/Disk Buffering while Capture – 40MB/s

Four channel system 

• CPU - Intel Quad Core (4 cores) 2.33 GHz CPU or faster

• RAM - 8GB RAM minimum

• Network's sustained bandwidth for Pipeline channels – 300Mb/s

• Operating System

— Mac OS X 10.6

— Windows XP Pro, Vista Ultimate, 7 Ultimate, Server 2003 R2 (64 bit only)
• Media Storage sustained read and/or write read and/or write speeds (separate from OS drive)

— Capture only – 40MB/s 

— Play out only – 48MB/s

— Transcode/Edit/Disk Buffering while Capture – 80MB/s

Eight channel system 

• CPU - Intel Quad Core (4 cores) 2.33 GHz CPU or faster

• RAM - 10GB RAM minimum

• Dual Port 1Gb NIC for exclusive use of Pipeline traffic

• Network's sustained bandwidth for Pipeline channels – 600Mb/s

— Use an adapter with a minimum of two (2) 1Gb ports 

— Port aggregation many be necessary
• Operating System

— Mac OS X 10.6

— Windows XP Pro, Vista Ultimate, 7 Ultimate, Server 2003 R2 (64 bit only)
• Media Storage sustained read and/or write speeds (separate from OS drive)

— Capture only – 80MB/s 

— Play out only – 100MB/s

— Transcode/Edit/Disk Buffering while Capture – 175MB/s
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High Definition – DVCPro HD (ingest only) 

Single channel system 

• CPU - Intel Dual Core 2.53Ghz CPU or faster

• RAM - 4GB RAM minimum

• Network's sustained bandwidth for Pipeline channels – 150Mb/s

• Media Storage sustained read and/or write speeds (separate from OS drive)

— Capture only – 20MB/s 

— Play out only – 30MB/s

— Transcode/Edit/Disk Buffering while Capture – 45MB/s

Two channel system 

• CPU - Intel Quad Core 2.8 GHz CPU or faster

• RAM - 8GB RAM minimum

• Dual Port 1Gb NIC for exclusive use of Pipeline traffic

• Network's sustained bandwidth for Pipeline channels – 300Mb/s

• Operating System

— Mac OS X 10.6

— Windows XP Pro, Vista Ultimate, 7 Ultimate, Server 2003 R2 (64 bit only)
• Media Storage sustained read and/or write speeds (separate from OS drive)

— Capture only – 40MB/s 

— Play out only – 60MB/s

— Transcode/Edit/Disk Buffering while Capture – 100MB/s

Three/Four channel system 

• CPU - Dual Intel Quad Core 2.8 GHz CPU or faster

• RAM - 12GB RAM minimum

• Quad Port 1Gb NIC for exclusive use of Pipeline traffic

• Network's sustained bandwidth for Pipeline channels – 600Mb/s

— Use an adapter with a minimum of two (2) 1Gb ports 

— Port aggregation many be necessary
• Operating System

— Mac OS X 10.6

— Windows XP Pro, Vista Ultimate, 7 Ultimate, Server 2003 R2 (64 bit only)
• Media Storage sustained read and/or write speeds (separate from OS drive)

Note

Edit while ingest and transcode while ingest workflows require increased disk I/O 
performance to support the additional read processes, and may require disk buffer 
cache drive system (see Pipeline User Guide disk buffering details). Viewing HD 
preview stream(s) can consume high levels of CPU which may cause dropped frames. 
It is recommended that preview be turned off during capture.
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— Capture only – 80MB/s 

— Play out only – 120MB/s

— Transcode/Edit/Disk Buffering while Capture – 200MB/s

Five channel system 

• CPU - Dual Intel Quad Core (8 cores) 3.0 GHz CPU or faster

• RAM - 16GB RAM minimum

• Quad Port 1Gb NIC for exclusive use of Pipeline traffic

• Network's sustained bandwidth for Pipeline channels – 750Mb/s

— Use an adapter with a minimum of two (2) 1Gb ports 

— Port aggregation many be necessary
• Operating System

— Mac OS X 10.6

— Windows XP Pro, Vista Ultimate, 7 Ultimate, Server 2003 R2 (64 bit only)
• Media Storage sustained read and/or write speeds (separate from OS drive)

— Capture only – 120MB/s 

— Play out only – 180MB/s

— Transcode/Edit/Disk Buffering while Capture – 300MB/s

High Definition – DNxHD 220/Pro Res 422 HQ (ingest only) 

Single channel system 

• CPU - Intel Dual Core 2.53Ghz CPU or faster

• RAM - 6GB RAM minimum

• Network's sustained bandwidth for Pipeline channels – 260Mb/s

• Media Storage sustained read and/or write speeds (separate from OS drive)

— Capture only – 40MB/s 

— Play out only – 60MB/s

— Transcode/Edit/Disk Buffering while Capture – 100MB/s

Two channel system 

• CPU - Dual Intel Quad Core (8 cores) 2.8 GHz CPU or faster

• RAM - 12GB RAM minimum

• Dual Port 1Gb NIC for exclusive use of Pipeline traffic

• Network's sustained bandwidth for Pipeline channels – 520Mb/s

Note

Edit while ingest and transcode while ingest workflows require increased disk I/O 
performance to support the additional read processes, and may require disk buffer 
cache drive system (see Pipeline User Guide disk buffering details). Viewing HD 
preview stream(s) can consume high levels of CPU which may cause dropped frames. 
It is recommended that preview be turned off during capture.
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— Use an adapter with a minimum of two (2) 1Gb ports 

— Port aggregation many be necessary
• Operating System

— Mac OS X 10.6

— Windows XP Pro, Vista Ultimate, 7 Ultimate, Server 2003 R2 (64 bit only)
• Media Storage sustained read and/or write speeds (separate from OS drive)

— Capture only – 100MB/s 

— Play out only – 140MB/s

— Transcode/Edit/Disk Buffering while Capture – 220MB/s

Three channel system 

• CPU - Dual Intel Quad Core (8 cores) 3.0 GHz CPU or faster

• RAM - 16GB RAM minimum

• Quad Port 1Gb NIC for exclusive use of Pipeline traffic

• Network's sustained bandwidth for Pipeline channels – 800Mb/s

— Use an adapter with a minimum of two (2) 1Gb ports 

— Port aggregation many be necessary
• Operating System

— Mac OS X 10.6

— Windows XP Pro, Vista Ultimate, 7 Ultimate, Server 2003 R2 (64 bit only)
• Media Storage sustained read and/or write speeds (separate from OS drive)

— Capture only – 140MB/s 

— Play out only – 200MB/s

— Transcode/Edit/Disk Buffering while Capture – 320MB/s
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C H A P T E R 5

U s i n g  P i p e l i n e
A d m i n i s t r a t o r
Chapter 5, 

Pipeline Administrator is a Web application embedded in each Pipeline, which enables you to connect to 
Pipeline devices on your network with a Web browser.

You can use Pipeline Administrator to perform administrative tasks on the Pipeline, including network 
configuration and firmware upgrades.

Topics

 Supported Web Browsers (page 48)

 Launching Pipeline Administrator (page 48)

 Using Pipeline Administrator (page 47)

 Using the About Panel (page 50)

 Using the Configure Panel (page 51)

 Using the Quad Panel (page 56)

 Using the Counters Panel (page 59)

 Using the Upgrade Panel (page 61)
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SUPPORTED WEB BROWSERS

You can configure Pipeline using your Browser of choice. However, you may need a plug-in for Bonjour if 
you want to discover Pipelines automatically.

You can run Pipeline Administrator from anywhere on your network. You can run it directly on a Pipeline 
host system or any computer with visibility to the Pipeline device.

LAUNCHING PIPELINE ADMINISTRATOR

The Pipeline Administrator can be accessed through a web browser. To connect to a Pipeline and launch 
Pipeline Administrator perform one of the following steps:

• Using a known Pipeline channel IP address: Open a web browser and enter the IP Address in the 
browsers address bar.

• In Mac OS X: Open Safari and select Bookmarks > Show All Bookmarks. In the Collections panel, click 
Bonjour. From the list of available devices double-click the Pipeline you wish to connect to, to display 
Pipeline Administrator.

• In Windows: Open Pipeline Control and select any document type (Schedule, Log and Capture, Trig-
ger, Print-to-Tape or Controlled Playout). Select the Pipeline you wish to connect to from the Pipeline 
dropdown list. Open the Diagnostics panel and click on the Administer button. This will open the 
selected Pipeline's Administrator page in your default browser.

If this is the first time connecting to this Pipeline since starting the browser, and if the Pipeline is password-
protected (configure panel > Security), the browser displays a Pipeline Authentication dialog. Enter the 

Note

Web browsers are supported only on the platform specified. You may encounter 
situations where features may not function correctly in all cases. In particular when 
running Windows 7 or Windows Server 2008 with Internet Explorer, you may encounter 
security issues that prevent Pipeline Administrator from displaying correctly or from 
saving configuration changes. In these cases consult with your IT administrator to adjust 
the browser's security setting to allow Pipeline Administrator to run properly. 
Alternatively you can install another browser such as Mozilla Firefox or Google Chrome 
as your default.
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username (always administrator) and a password (if you added one), and click OK to connect to the 
Pipeline and display Pipeline Administrator:

Figure 5–1. Connect dialog – enter your username and password to connect

USING PIPELINE ADMINISTRATOR

Pipeline Administrator has several panels you can use to perform various tasks:

 Using the About Panel – provides general information about Pipeline and registration.

 Using the Configure Panel – displays Pipeline and network settings, allows you to change network set-
tings and options.

 Using the Quad Panel – displays when connected to a Pipeline Quad, to control confidence monitoring.

 Using the Counters Panel – displays statistical information about Pipeline activity.

 Using the Upgrade Panel – enables you to upgrade the firmware and Pipeline Administrator.

You can access the Pipeline User’s Guide (the document you are currently reading) from each panel by 
clicking the User’s Guide link at the bottom of each panel.

Enter the username (administrator) and password if 
you added one, and click OK to connect.
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USING THE ABOUT PANEL

To display the About panel, click about in the menu bar at the top of the window:

Figure 5–2. The About panel displays a link to product registration.

Register the Pipeline by clicking the Register button. Follow the steps on the Web page to complete 
registration. If you’ve already registered this Pipeline, the Register button no longer displays.

If the computer you’re using is on a LAN without Internet access, use a computer that has Internet access 
and go to dynamic.telestream.net/pipeline-register/register.asp to register your Pipeline. You should 
register your Pipeline to ensure ongoing warranty service and customer support. 

The About panel – as well as the other panels – provides online access to the Pipeline User’s Guide (this 
document), by clicking the link in the lower left corner.
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Using the Configure Panel
To display the Configure panel, click configure in the menu bar at the top of the window:

Figure 5–3. Configure panel displays details & allows you to change settings

Use the Configure panel to view and make changes to Pipeline’s identity, IP settings, and options. Click the 
LAN, Security, Options, and EDL toolbar to view their respective control panels, as shown in the callouts in 
the figure above. Each control is described in the following table:
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Table 5–1. Configure Panel controls and descriptions.

Control Description

Pipeline Identity

Name Editable field. Default for Pipeline SC: Pipeline-XXXX, where XXXX is the 
serial number printed on the bottom of the Pipeline. 

Default for Pipeline Quad: PipelineQuadXXXX_N where N is the device 
number 1 through 4.
Default for Pipeline HD Dual: PipelineHDDual_XXXX_N where N is the 
device number 1 through 2.

To change the name, enter a new name, and click Save Changes. The 
name is updated in the Pipeline, and is reflected in the Bonjour panel. 
Limit: 255 characters.
If you enter a friendly name that already exists, Pipeline adds (1), (2,), as 
necessary to maintain uniqueness.
For best naming practices, you should identify the Pipeline model (SC or 
Quad), uniquely name it, and, in the case of the Quad, refer to the 
channel number. For example, PipelineQuad_Prod7_Channel2.

App (firmware version) Displays Pipeline’s firmware version number, composed of <Major 
Version>,<Minor Version><Build Number>,<Channel Number Identifier>. 
For example: 2,2,33165,00 indicates Version 2.2, Build 33165, channel 0. 
On Pipeline SC, the channel number ID is always 0. Upgrades are 
identified by major version and minor version numbers: 2.2, for example.

Loader (version) Displays Pipeline’s boot loader version number, composed of <Major 
Version>,<Minor Version><Build Number>,<Channel Number Identifier>.

CPLD Version CPLD chip version number on the Pipeline, for Telestream use.

FPGA FPGA chip version number on the Pipeline, for Telestream use.

Serial Number Four digit serial number of the device, not changeable.

LAN When changing the IP address, you should click Save Changes to 
update the Pipeline, then close Internet Explorer or Safari. Wait about 30 
seconds, then restart your Web browser and log back on. If you don’t, 
your Control application will behave incorrectly, and Pipeline 
Administrator will periodically display an error: “Can’t communicate with 
Pipeline”.

Self-Assigned Select to utilize the default link-local IP address, generated based on the 
Pipeline’s serial number; incremented on Pipeline 2, 3, and 4 on Quad.

DHCP Select to have the DHCP server assign an IP address. If DHCP fails after 
about 1 minute, the IP address reverts to the self-assigned address. The 
DHCP selection is only available with firmware revision 2.4 or earlier.

Static Select to use the IP address, subnet mask, & gateway, entered manually. 

IP Address Enter the IP address assigned by your network administrator.

Mask Enter the subnet mask assigned by your network administrator.

Gateway Enter the gateway address provided by your network administrator.

Security
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Password Editable field. No password is assigned by default. (Username is always 
administrator.) Limited to 15 characters; standard HTTP password rules 
apply. May be empty to disable authentication.

Confirm Password Editable field. Enter second time to confirm.

Control Description
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Options

Default format when no 
input connected

Select the default format from the menu. On HD Pipelines, you can 
choose an SD NTSC|PAL or various HD 720|1080 profiles. On SC/Quad 
Pipelines, choose SD NTSC|PAL. If the channel boots with no SDI input it 
will default to the value specified here. If the channel is already running 
with SDI input, selecting this setting will do nothing until the next time it 
boots without SDI input. If the channel is already running with SDI input 
and the input is removed, selecting a setting and clicking the save button 
will set the channel to the selected format. 

Note: If play out of 1080PsF at 23.98/24fps is desired you must select 
1080psf@23.98.

Default to black if SDI not 
present

Pipeline generates a test pattern when no SDI input signal is present. If 
this option is checked the test pattern is a black frame, otherwise the 
generated test pattern is color bars. The pattern is generated in NTSC or 
PAL (or HD formats on HD Dual), based on the mode the Pipeline is in. 
The last valid SDI signal sets the mode unless there is no SDI present 
when it boots. In this case it reverts to the setting specified above.

Ignore input discontinuities Unchecked by default, to insure capture quality. Check when you don’t 
want Pipeline to report missing/partial frames in input stream during 
capture. This is useful if, for example, you’re capturing from a satellite 
feed where errors occur more often and you don’t want Pipeline to report 
the error to the Final Cut Pro plugin, because it will abort the capture.

Disable loopback Prevents input SDI from being present on the output SDI during capture. 
Consider disabling when exporting or capturing to a deck and the deck 
complains about the reference signal. 
Note: Due to hardware limitations it is never fully disabled. Even a small 
amount of signal causes some decks to complain. If this happens the 
user should physically remove either the SDI input or output (depending 
on capture or playout) from either the video source or the Pipeline.

Assume F2 dominant input When checked, during encoding, Pipeline constructs a frame by using a 
field pair consisting of an F2 field followed temporally by an F1 field. This 
is in contrast to normal operation, which constructs a frame using a field 
pair consisting of an F1 field followed temporally by an F2 field.

Burn in Timecode When checked, Pipeline overlays the timecode it is using as its primary 
clock on the video image.

Remove VBI data before 
compression

When checked, Pipeline strips each frame of VBI data, replacing it with 
black before passing it to the encoder for compression.

Playout VANC using 
essence metadata

Check this option if you wish to play out the VANC data contained in the 
video essence of the file. This option overrides the play out of track based 
VANC metadata contained in QuickTime Closed Caption tracks or MXF 
SMPTE-436M packets.

Control Description
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EDL

Use IP address instead of 
Pipeline name

Check when you want communication to utilize the IP address of the 
Pipeline, instead of using the Pipeline name and resolving it via Bonjour.

Signal to abort on dropped 
frames

Check when you want FlipFactory to abort the capture process if a 
dropped frame occurs.

Buttons If another user is connected and processing media with this Pipeline, 
using these buttons will interrupt the process, and it must be re-started.

Save Changes Click to update the Pipeline with the new settings. If you change the IP 
address (by any means – returning to self-assigned, enabling DHCP, or 
assigning a static address), in about 30 seconds, Pipeline Administrator 
displays an error: “Unable to communicate with Pipeline”. Click OK, then 
reconnect to the Pipeline using the new IP address.

Default Return settings to default. After returning the settings to default, be sure 
to click Save to make the settings take effect.

Reboot This reboot performs a hardware-level reset, which disconnects Pipeline 
from any client which may attach without warning. You are warned if you 
attempt to reboot the channel while it's in use. Click to reboot the Pipeline 
if you change the password, to log on using the new password. You do 
not need to reboot when changing IP settings.

Soft Reboot This reboot resets the Pipeline and any clients WILL lose their 
connection. Pipeline Administrator displays an alert to warn you.

In cases where the Pipeline is non-responsive, click Soft Reboot to clear 
the problem.

Note

Always exit Pipeline Control before changing any parameters. If you leave it open and 
rename channels (or IP's), it will create duplicates in the UI. This can result in wrong 
channel connections.

Control Description
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Using the Quad Panel
The Quad panel only displays when Pipeline Administrator is connected to one of the Pipeline channels on 
a Pipeline Quad. When you’re connected to any other Pipeline device, this page does not display.

To display the Quad panel, click quad in the menu bar at the top of the window:

Figure 5–4. Quad panel controls confidence monitoring

Use the Quad panel to set up confidence monitoring.

Be sure to click Save Changes 
to make the change.

Choose which channel if any, to 
monitor.
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Table 5–2. Configure Panel controls and descriptions.

Confidence Monitoring

Confidence monitoring is the process of employing channel 4 on the Pipeline Quad to sniff the exact same 
video packets being captured from any of the other Pipeline channels on the Quad and processed by the 
client application during a capture operation (crash recording), for the purpose of verifying that the output is 
a true representation of the input, or that the output meets certain quality limits or other metrics.

Confidence monitoring can be enabled when you are performing a capture operation or crash recording 
from channels 1, 2, or 3 on a Pipeline Quad. When enabled, Pipeline 4 is also dedicated to the capture 
operation for the duration of the capture operation.

Figure 5–5. Confidence monitoring is performed by channel 4 via internal Ethernet bridge

As SDI is being fed into the capture channel’s SDI In port, it is encoded and sent out in TCP packets on the 
Ethernet port to the client application (Pipeline Control, Pipeline Administrator, FlipFactory, Episode, Final 
Cut Pro, and other media systems). Unlike other confidence monitoring that just re-encodes the media 
directly in the same device, the channel 4 Pipeline sniffs the very same packets on the Ethernet just as the 
client does; it then decodes the Ethernet input, and outputs the resulting SDI on its own SDI Out port.

Control Description

Confidence Monitoring

Normal Operation – no 
monitoring

Check to disable confidence monitoring. When confidence monitoring is 
disabled, channel 4 (Pipeline 4 on the Quad) operates normally, and can 
be used for capture/playout operations.

Note: This option is only enabled when you log on to channel 4. You 
cannot make this change from other channels.

Monitor channel 1 | 2 | 3 Check to enable confidence monitoring and encode and send the 
rendered stream of the selected channel on channel 4 SDI Out as well. 
Click Save Changes when you’re done to update the settings.

Ethernet Out

Pipeline Quad
Confidence monitoring of channel 1 enabled.

Internal Ethernet bridge

Pipeline Quad’s Channel 1 is performing a capture operation – 
decoding SDI from the SDI Input to Ethernet out, to Pipeline Control.

Channel 4 is confidence monitoring channel 1 – 
sniffing the outbound traffic on the internal 
Ethernet bridge and re-encoding it, outputting the 
resulting SDI on SDI Out for review.

Channel 1 SDI In
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Operators can attach monitors and vector scopes to the SDI out to view and measure the actual media in a 
full-circle operation, confident that they are testing and viewing exactly the same input as the client system 
is receiving.

When confidence monitoring is enabled and the preview media stream from the channel selected is being 
consumed by Pipeline Control, Pipeline Administrator, or in FlipFactory, the confidence monitor (channel 4 
SDI Out) displays black.

If the monitored channel’s stream is DV, DVCPro, IMX, MPEG-2, or ProRes then the confidence monitor 
displays the full frame video as it is encoded.

If the monitored channel is not streaming media on the LAN, then the confidence monitor displays a 
banner on the image. The frame background is either the last frame of the previous stream or black.

Figure 5–6. Confidence monitor displays a banner when no media stream is present

Note

To enable confidence monitoring, you must log on to channel 4 to display the enabled 
confidence monitoring option on the Quad panel. Channel 4 must be idle before you can 
enable confidence monitoring. You can confidence monitor both capture operations and 
crash recording operations.
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Using the Counters Panel
To display the Counters panel, click counters in the menu bar at the top of the window:

Figure 5–7. Counters panel displays various processing values

Use the Counters panel to view various values related to encoding and decoding to determine if operations 
are normal or if there are failures that must be corrected. These values are reset each time a new RTSP 
connection is made. This information may also be utilized when you are working with Telestream Customer 
Service to resolve an issue.

Table 5–3. Counters Panel controls and descriptions.

Value Description

Frames The number of frames processed during this RTSP session.

Process The number of frames dropped because of excessive CPU load. If this 
number is greater than zero, you’re losing frames and quality. Determine 
the cause of the error and reprocess the media.

Video Sent Number of video frames sent over RTP connection during an capture 
operation.

Audio Sent The number of audio frames sent during capture over RTP.

Status Sent The number of status frames sent during capture over RTP.
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Video Encode Time Number of microseconds it took to process the current video frame.

Video Queue The number of video frames dropped due to excessive network traffic. If 
this number is greater than zero, you’re losing frames and quality. 
Determine the cause of the error and reprocess the media

Audio Queue The number of audio frames dropped due to excessive network traffic. If 
this number is greater than zero, you’re losing frames and quality. 
Determine the cause of the error and reprocess the media

Status Queue The number of status frames dropped due to excessive network traffic.

Video Sequence Count of frames where the timecode (as observed on the RS-422 
connection) was not incrementally increasing.

Audio Align Number of times the audio processor re-synchronized due to an 
Embedded SDI audio error.

Video Align Number of times the video processor had to re-synchronize due to an 
SDI video error.

Video Frame Exceeded CBR codec error counter.

Audio Frames Requested During playout, Pipeline requests audio and video frames serially. This is 
the number of audio frames requested, and should be the same number 
as Audio Frames Received.

Audio Frames Received Number of audio frames received during playout.

Video Frames Requested Number of video frames requested during playout. Should be the same 
number as Video Frames Received

Video Frames Received Number of video frames received during playout.

TCP retransmissions Number of times TCP packets had to be retransmitted.

Value Description
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Using the Upgrade Panel
To display the Upgrade panel, click upgrade in the menu bar at the top of the window:

Figure 5–8. Upgrade panel allows you to upgrade Pipeline firmware

Pipeline is designed so its firmware and Pipeline Administrator Web application can be upgraded easily 
when new revisions of Pipeline software are made available by Telestream. 

You can periodically check the Pipeline support page at www.telestream.net/telestream-support/pipeline/
updates.htm to determine if there is newer software. (Registered users are notified of upgrades via E-mail.) 
On the site, click Support > Support Home in the main menu at the top of the page, then select Pipeline > 
Updates on the right, under Enterprise Product Support. Pipeline firmware updates are available on this 
page.

To upgrade a Pipeline, follow these steps:

1. Connect to the target Pipeline with a Web browser and determine the current firmware version via the 
Configure panel (Using the Configure Panel on page 51).

2. Log on to the Pipeline support page at www.telestream.net/telestream-support/pipeline/updates.htm.

3. Download the Pipeline firmware file (firmware-xxxxx.pln) to your computer.

After downloading the firmware file, upgrade the firmware by following these steps:

1. Log on to the target Pipeline using a Web browser.

2. Select Upgrade from the menu to display the Upgrade panel.

Note

To determine the current version of your Pipeline, log on and display the Configure 
page. The version number is the value in the App field, which displays the firmware 
version number: <Major Version>,<Minor Version><Build Number><Internal Use>. For 
example: 2,2,33165,00 indicates Version 2.2, Build 33165.
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3. Click Choose File to locate and select the firmware file (firmware.xxxxx.pln) you plan to use.

4. Click Upgrade and observe the progress bar and notes about the process.

During a firmware upgrade, the front SDI In LED (on left) lights yellow during the upgrade process. 
When the Pipeline has been upgraded, Pipeline Administrator reboots the Pipeline channel and 
displays a rebooting message on the Upgrade page. In about 15 to 30 seconds, both the In and Power 
LEDs light green. Pipeline Administrator reconnects automatically and displays the Configure panel.
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C H A P T E R 6

U s i n g  P i p e l i n e  i n  F i n a l
C u t  P r o  &  E p i s o d e
Chapter 6, Using Pipeline in Final Cut Pro & Episode

Use this chapter to learn how the Pipeline Plugin works in Final Cut Pro and enables you to import and 
export media via Pipeline. The Pipeline plugin also works in Episode 5.x | Episode Pro Desktop 5.x for 
importing media from Pipeline.

You can import media from Pipeline via the Pipeline Plugin in two ways: crash record, and log and capture. 
In crash record, you import real-time media from the Pipeline; during log and capture, you can create a clip 
list and then record the media defined by each clip in the list.

Topics

 Setting Preferences (page 64)

 Crash Recording Media From Pipeline (page 68)

 Logging and Capturing Media Clips from Pipeline (page 70)

 Loading and Saving Clip List (EDL) Files (page 77)

 Exporting Media to Pipeline From Final Cut Pro (page 79)

Note

Before using Pipeline with Final Cut Pro or Episode, the Pipeline must be installed and 
configured (Chapter 2, Pipeline Hardware, Installation & Setup on page 5). 
Configure Pipeline using Pipeline Administrator (Chapter 5, Using Pipeline 
Administrator on page 47).
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SETTING PREFERENCES

The Pipeline Plugin allows you to set up your import and export preferences, determine how often to check 
for software updates, and select preset or custom keyboard settings of your choice. Pipeline Plugin 
Preferences are displayed directly from the Pipeline Plugin Import and Export windows.

Displaying the Preferences Panel

Final Cut Pro. Open Final Cut Pro and select File > Import > Pipeline Crash Record or Pipeline Log & 
Capture or File > Export > Pipeline.

Episode. Open Episode and select File > Import > Pipeline Crash Record or Pipeline Log & Capture.

The Pipeline Plugin displays the Pipeline Settings dialog.

Figure 6–1. Use the Pipeline dialog to select the Pipeline, configure it, and connect.

Select a Pipeline, configure it, and click OK to connect.

Figure 6–2. Display Preferences from the Pipeline Plugin Import or Export window.

Click Preferences to 
display Pipeline 
Preferences.
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Click Preferences to display the Pipeline Preferences window. (The Preferences button is also displayed 
on the Pipeline export window for your convenience.)

In addition to the tabs, the window displays two important buttons:

Default. Click to return all preferences to their default settings.

OK. Click to update all preferences and close the window. You can display each tab and make changes 
before clicking OK.

Setting Import Preferences
In the Pipeline Preferences dialog, click Import to display the Import Preferences panel:

Figure 6–3. Import Preferences.

Preroll Duration. Specify the number of seconds to pre-roll video from start timecode during import 
operations.

Postroll Duration. Specify the number of seconds to post-roll video past end timecode during import 
operations.

Automatically Eject Tapes. Check to have the Pipeline plugin automatically eject the tape from the deck 
when it is finished capturing. The tape is only ejected if another tape is required. This occurs when clips are 
logged from multiple tapes.

Default. Click to return all preferences to default settings.

OK. Click to save changes and close the dialog.
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Setting Export Preferences
In the Pipeline Preferences dialog, click Export to display the Export panel:

Figure 6–4. Export Preferences.

Leader Duration. Specify the number of seconds of time to write blank media to the file before encoding.

Trailer Duration. Specify the number of seconds to write blank media to the file after encoding.

Preroll Duration. Specify the number of seconds to pre-roll video from start timecode during export 
operations.

Pipeline Frame Queue Size. Set the queue size (in number of frames). The minimum is 8 frames and the 
maximum is 22 frames. The default is 22 frames, in order to provide the most reliability. 

During playout, Pipeline keeps a queue of frames in memory to compensate for network latencies. If queue 
size is set for a large number of frames, the Pipeline can ‘ride out’ higher transient latencies in the network. 
However, a large number also introduces a longer delay between the time the frame is emitted on the 
network and the time that the frame appears on the SDI connection (roughly 1/4 second for 8 frames, up to 
about 3/4 second for 22 frames).

If you are concerned with latency between the time video is exported from the computer and the time it is 
sent out the Pipeline device, you should adjust the value lower. However, lowering this value will make the 
export connection more susceptible to errors due to insufficient CPU power or network bandwidth.

Pipeline Frame Offset. Set the offset size (number of frames). The minimum is -5 frames and the 
maximum is +5 frames. The default is 0 frames. Frames can occur early or late depending on the deck 
used. This adjustment offsets the playout based on the number of frames chosen and compensates for 
decks that are not 100% frame accurate to the timecode provided. This adjustment is made by a process 
of trial and error.

Ignore lost frames. When checked, a playout session continues even if frames have been lost. If 
unchecked, the playout session aborts when any lost frames occur.
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Setting Update Preferences
In the Pipeline Preferences dialog, click Update to display the Update panel:

Figure 6–5. Update Preferences.

Check for Updates. Select how often Pipeline Plugin should check for updates, or select never.

Check Now. Click to check for updates immediately. If Pipeline Plugin can make a connection to the 
Telestream Web site, you’ll be notified if your software is up-to-date or an update is available.

Setting Keyboard Preferences
In the Pipeline Preferences dialog, click Keyboard to display the Keyboard panel:

Figure 6–6. Keyboard Preferences.

Preset. Select among available preset keyboard shortcuts (which updates the Action table), or select 
Custom to set your own.

Action Table. Select a key on any row in the table to edit its value.
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CRASH RECORDING MEDIA FROM PIPELINE

You can use the Pipeline Plugin to crash record media in any format into Final Cut Pro or Episode Desktop 
as a QuickTime movie. You must use an HD Pipeline to record HD media. You can crash record live feeds 
or video playing out from a playback device such as a VTR into the Pipeline via SDI. 

In both Final Cut Pro and Episode, when the Pipeline Plugin installed, two new Pipeline menu items are 
added to the Import menu (example shown in Final Cut Pro):

Figure 6–7. Use File > Import > Pipeline Crash Record to import media from Pipeline in real time.

To crash record media from Pipeline, follow these steps:

1. Display Pipeline Settings Window. Select File > Import > Pipeline Crash Record to display the 
Pipeline Settings window.

Figure 6–8. Use the Pipeline Selector dialog to select a Pipeline and set the codec for this session.

Note

When capturing or crash recording from Pipeline Quad, you can perform confidence 
monitoring to qualify your video. See Confidence Monitoring (page 57).

Two new import options displays when you 
install the Pipeline Plugin:

Click Import > Pipeline Crash Record to select 
a Pipeline and capture video in real time from 
your Pipeline.

Select the Pipeline from the list of 
available Pipelines.

Next, select your video and audio preset, and
timecode clock source.

You can also change your media storage location.

Click OK to connect.
May, 2012



Crash Recording Media From Pipeline
Pipeline User’s Guide

69
2. Select Pipeline, Codec Settings, and Connect. Select the Pipeline. Then, select the codec you want 
to use and your timecode clock source. Optionally, you can change your storage location. 

3. Click OK to connect and display the Pipeline Crash Record window.

Figure 6–9. Click Record to crash record; clips display in the clip list.

4. Crash Record your Clips. Queue up your video and click the Capture (red dot) button to begin 
recording.

You can use the controls to queue the tape if VTR-controlled. When you click Capture, the Pipeline 
Plugin begins capturing the streaming media. Click the Capture button again to stop capturing. The clip 
is listed in the Clip List with a Captured icon. You can record one or more clips.

5. Import your Clips. Click Import to import the clips into the Final Cut Pro bin or the Episode job batch 
window (example in Final Cut Pro). 

Note

If your Pipeline is in NTSC mode, DVCPro is in the list, because from the NTSC video 
compression perspective, there is no difference between DV and DVCPro: both are 
720x480, 25mb/sec using 4:1:1 chroma sampling.

In PAL mode, DV compression is 720x576, 25mb/sec with 4:2:0, while DVCPro 
compression is 720x576, 25mb/sec with 4:1:1. Therefore, both DV and DVCPRO 
display in the list.

Recorded clips display 
here in the clip list.

Click Record to start 
and stop recording.

Click Import to import 
the clips into your bin.
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LOGGING AND CAPTURING MEDIA CLIPS FROM PIPELINE

You can use the Pipeline Log and Capture window to log (create) one or more clips, and then encode and 
import each clip as a QuickTime movie directly from a Pipeline that is attached via Ethernet (directly or via 
LAN). You can capture your clips in any supported format.

In both Final Cut Pro and Episode, when the Pipeline Plugin is installed, two new Pipeline menu items are 
added to the Import menu (example shown in Final Cut Pro):

Figure 6–10. Use File > Import > Pipeline to import media clips from Pipeline.

To log and capture clips and import them from Pipeline, follow these steps:

1. Display Pipeline Settings Window. Select File > Import > Pipeline Log & Capture to display the 
Pipeline Settings window.

Figure 6–11. Pipeline browser displays all Pipelines – select one and set the codec for this import.

Note

When capturing or crash recording from Pipeline Quad, you can perform confidence 
monitoring to qualify your video. See Confidence Monitoring (page 57).

Two new import options displays when you 
install the Pipeline Plugin:

Click Import > Pipeline Log & Capture to select 
a Pipeline and log clips, then capture them 
from your Pipeline.

Select the Pipeline from the list of 
available Pipelines.

Next, select your video and audio preset, and 
timecode clock source.

You can also change your media storage location.

Click OK to connect.
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2. Select Pipeline, Codec Settings, and Connect. Select the Pipeline and then select the codec you 
want to use for this import operation, and your timecode clock source. Optionally, you can change your 
storage location and handles (added video before and after capture added to the file) 

Click OK to connect and display the Pipeline Import dialog.

3. Log Your Clips. Use the mark in and mark out buttons to select start and end timecodes, or enter 
them manually, then click the Log button to add the clip to the queue. The VTR buttons can be used to 
queue the deck if necessary. Clips with overlapping timecodes cannot be captured in the same import 
session.

You can either use the mark in and mark out buttons or manually enter the timecodes.

As each clip is logged, it displays in the clip list at the right with a yellow, three-dot icon to indicate it 
hasn’t been captured yet. The codec that was selected in the Pipeline Settings window will be used.

Figure 6–12. Use the Pipeline Import window to log & capture video streaming from your Pipeline.

Note

If your Pipeline is in NTSC mode, DVCPro is in the list, because from the NTSC video 
compression perspective, there is no difference between DV and DVCPro: both are 
720x480, 25mb/sec using 4:1:1 chroma sampling.

In PAL mode, DV compression is 720x576, 25mb/sec with 4:2:0, while DVCPro 
compression is 720x576, 25mb/sec with 4:1:1. Therefore, both DV and DVCPRO 
display in the list.

Click Import to add 
clips to Final Cut 
Pro or to Episode.

Video preview 
region Clip List Panel

Click to load a clip 
list from an EDL 
file or XML file, or 
to save it as XML.

Click to capture 
selected clips.

Mark-in button

Mark-out button

VTR Controls

Shuttle Wheel

Jog Wheel
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In the following figure, the Pipeline Import dialog is depicted in Episode Desktop:

Figure 6–13. The Pipeline Plugin Import dialog in action, depicted in Episode Desktop.

When you connect, streaming media (if present) displays in the video preview region. A clip list displays on 
the right. VTR and Clip List controls, preferences and Import commands display at the bottom of the panel.

If you have a VTR and it is in Remote mode, you can control your video using the VTR controls and queue 
clips to be encoded and imported, or the video can be crash recorded. (If you’re viewing a live feed, you 
can only crash record media.)

4. Capture your Clips. When you’re done logging clips, you capture them by selecting them in the clip 
list and clicking the Capture button (the button with 3 vertical dots directly below the clip list). Select 
multiple clips by clicking and dragging or using Command-click.

As clips are captured, the yellow button on each thumbnail is replaced with a green check mark.

5. Import your Clips. Click Import to import them into the Final Cut Pro bin or the Episode Desktop job 
batch window (example shown is Episode Desktop).

The Pipeline Plugin ingests the uncaptured clips by controlling the VTR via the Pipeline to encode each 
clip and stream it to the plugin, then writes the media to a QuickTime movie (.mov) file, and saves each file 
in the destination folder. After the files have been captured and imported, they are all added to the Final 
Cut Pro bin or Episode Desktop job batch window.

When the import process completes, the Pipeline Import dialog is closed.
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Using the Video Panel
The video panel displays the encoded video stream in real time.

Figure 6–14. Pipeline Import dialog’s video panel.

At the bottom, the video panel displays start, current, duration and end timecodes and mark in/out buttons, 
and a log button for adding a clip to the clip list. The Log button is disabled unless both timecode values 
are entered. If the start value is greater than or equal to the end value, an error is displayed. 

Non-drop-frame timecode separators are all colons. Drop-frame notation applies a semi-colon between the 
second and frame values. For example: 00:29:30;16 is a drop-frame timecode.

Using the Clip List Panel
The Clip List panel displays a list of clips you’ve created.

Figure 6–15. The Clip List panel allows you to work with and import clips.

To create a clip entry, you play video, then click the Start button to mark the start timecode (at right of start 
timecode value field). Click the End button to mark the end timecode (at right of end timecode value field). 
When you have a start and end timecode value (and the start timecode is previous to the end timecode) 
you can click Log to add the clip to the list. Optionally, enter a start timecode and a duration – the end 
timecode will be calculated for you.

You can also delete, import, and preview selected clips using the Clip List buttons displayed directly below 
the Clip List panel, in the control panel below.

Video preview region displays video, bars & tone, or 
black, depending on state of Pipeline.

Click Log to add the clip to the clip list.

Start: Timecode of next clip to be added to the list. Click 
icon at right to update.

Current: Real-time timecode of stream.

Duration: Calculated length of next clip, when 
available. Click lock icon (right) to lock the duration.

End: End point of next clip to be added. Click icon at 
right to update.

Clips with a green check icon have already been 
captured, and the file is saved on disk in the 
scratch location.

Clips with a yellow icon have not been captured. 
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Status Badges

Clip thumbnails are marked with status badges to help you identify the status of each clip at a glance.

Editing Clip List Metadata

At any time when a clip list is displayed, you can view or edit metadata. To view or edit metadata, double-
click a specific clip list entry to display the Clip Information dialog:

Figure 6–16. The Clip Information dialog allows you to view and enter metadata values.

Edit the values for each metadata tag, or select recently added values from the popup menu. Click OK to 
close the window and save the metadata

Status Badge Description

Indicates that Pipeline Control attempted to capture the clip, but failed. This may 
be due to lack of storage, network or Pipeline problems, or excessive pre-roll at 
the beginning of a tape, for example. Resolve the problem and retry.

During capture state only, this indicates that this clip has not been captured yet.

Indicates that this clip is in the process of being captured.

Indicates that this clip has been successfully captured.

Enter metadata values, or select from recently-
added values in the popup menu.
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Using the Video Controls Panel
The video controls panel contains VT controls, shuttle/jog wheels, clip list buttons, and Preferences and 
Import buttons.

Figure 6–17. Use the control panel to control your VTR and import clips.

VTR Controls

Shuttle. Click and drag to roll left and right, moving the tape reverse and forward, increasing in speed the 
farther from center you go. When you release the wheel, it returns to center and stops the tape. You can 
also click on the shuttle wheel to left or right of center to shuttle in small increments and then return to 
center. The further from center you click, the more frames you’ll play, in either direction.

 Fast Reverse. Click to rewind tape.

 Halt. Click to stop tape.

 Pause. Click to pause tape – this command sends a shuttle zero command to the VTR.

 Play. Click to preview/play video at normal forward speed.

 Fast Forward. Click to roll tape forward.

Jog. Click and drag to roll tape forward or reverse frame by frame.

Keyboard Shortcuts

The Pipeline Plugin enables you to use keyboard shortcuts for video control – Play, Rewind, Log, Mark 
Out, Fast Forward, Mark In, Step Forward, Step Backward, Go To Mark In, and Go To Mark Out. Keyboard 
shortcuts can be customized to your own preferences, or you can select default Final Cut Pro or Avid 
shortcuts. To view and customize your shortcuts, see Setting Keyboard Preferences (page 67).

Clip Buttons

Delete. Click to permanently remove the selected clips from the list. Or, press Delete on the keyboard.

Capture. Click to capture selected clips. If not captured, they must be captured or discarded during Import.

Note

You can also jog media using the scroll wheel or scroll ball on a mouse so equipped.

Delete Clip

VTR Controls (for detail, see below) Click Import to add clips to the 
current project.

Shuttle Wheel Jog Wheel

Batch Capture
Preview Clip

Displays Preference window
Displays version number.
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Preview. Click to preview the selected clips. When the preview button is clicked, that part of the tape is 
queued up and played back, not the video file that was (or will be) captured.

Buttons

About. Click to display the About dialog, which displays the version that is installed.

Preferences. Click to display the Preferences dialog (see below).

Help. Click to display help on using this panel.

Cancel. Click to close the dialog without importing media.

Import. Click to save the capture clips as files and add them to the bin. Clips that haven’t been captured as 
temporary files must be captured (or discarded) during the Import process. 

If there are uncaptured clips the Pipeline Plugin displays a dialog so you can choose what to do with them:

Note

Clips that display a green check logo have already been captured and have a 
permanent (not temporary) file. If you click Cancel, these files will be deleted.
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LOADING AND SAVING CLIP LIST (EDL) FILES

Loading and saving clip list (EDL) files facilitates the transfer of clip lists between applications without 
manually re-creating them. The Pipeline Plugin enables you to load a clip list from an EDL or an XML file or 
save a clip list as an XML file in Final Cut Pro’s XML Interchange format.

For example, you can save (export) a clip list as XML from the Pipeline Plugin in Final Cut Pro, and then 
import the list into the Pipeline Plugin in Episode Desktop to ingest the clips from tape directly into Episode 
Desktop under control of the clip list.

These interchange files can be used for time-shifting your work, to avoid performing the same actions 
multiple times, or to participate in workflow tasks with others. For example, one person can define a list of 
clips, save the list as an XML file, and then pass the file on to someone else on the network who uses the 
clip list to ingest the required media.

You can create and save a clip list before capturing begins. When you click the Save XML button, the XML 
file is created, based on the clips in the list at the time. The Save XML button is deactivated while the 
plugin is capturing so you must save the XML file either before or after capturing the clips.

To load or save clip lists, use the buttons just below the clip list panel:

Figure 6–18. The Clip List buttons allow you to open clip list files and save clip lists as a file.

Loading the Clip List from an EDL File

To load the clip list from an EDL file, click Load EDL. EDL files can be created from Pipeline Administrator.

Figure 6–19. Click Load EDL to locate an EDL file and load the entries into the Clip list.

When you click Load EDL, Pipeline Plugin displays a File Open dialog which you use to browse and locate 
the EDL file you want to load. Select the file (only files with the edl suffix are available) and click Open to 
load the clips in the EDL file into your Clip list.

Click Load EDL to populate the clip list with entries from a 
Pipeline EDL file.

Click Load XML to populate the clip list with entries from an 
EDL file in Final Cut Pro XML Interchange Format.

Click Save XML to create a file with entries for this clip list, in 
Final Cut Pro XML Interchange Format.

Use the Open window to browse and open clip 
list files you’ve saved previously.
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Loading the Clip List from an XML File

To load the clip list from an XML file, click Load XML.

Click Load XML to locate a clip list XML file and load it. You can load a Clip List from an XML file that 
has been saved in Final Cut Pro, the Pipeline Plugin, Pipeline Control, or any other application that 
supports Final Cut Pro XML Interchange format.

Figure 6–20. Click Load XML to locate a clip list file and load the entries into the Clip list.

When you click Load XML, Pipeline Plugin displays a File Open dialog, which you can use to browse and 
locate the XML file you want to load. Select the file (only files with the xml extension are available), and 
click Open to load the clips in the list into your Clip list.

Save the Clip List as an XML File

To save the clips in the list as entries in XML, click Save XML, select a folder location and save the file.

Use the Open window to browse and 
open XML files you’ve saved previously.
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EXPORTING MEDIA TO PIPELINE FROM FINAL CUT PRO

The Pipeline plugin enables you to export QuickTime sequences or clips, using print to tape (via insert, 
assemble, and crash edits) directly to Pipeline for decoding and conversion to SDI in real time. (To export – 
play out – media in other wrapper/file formats, use Pipeline Control.) Export and playout is supported for 
SD/HD media, in QuickTime format.

In most cases, you’ll set your sequence setting the same as your clip format to avoid format conversion, 
because you’re performing decoding to SDI directly in the Pipeline.

During an export operation, for capturing to tape or other archival operations, the SDI out port of the 
Pipeline should be connected to an RS-422-controlled VTR. Pipeline exporting performs an insert, 
assemble, or crash edit, and the tape should not be read-only (record inhibit).

If you don’t have an RS-422 deck or your tape is read-only/record inhibit, Pipeline displays an error.

With the Pipeline Plugin installed, a new Pipeline menu item is added to the Export menu: 

Figure 6–21. Select File > Export > Pipeline to export media to your Pipeline.

To export sequences or clips to Pipeline, follow these steps:

Note

Final Cut QuickTime sequences use stereo audio tracks by default. You can export SD 
sequences or clips with essences of any supported codec in the selected Pipeline. 
Audio must be uncompressed linear PCM 16 or 24 bit (Little or Big Endian), in mono or 
stereo tracks.

When exporting media to Pipeline Quad for playout, use the SDI Sync In port to sync 
your output with a house reference signal. See Using SDI Sync Input on page 11.
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1. Select the Media to Export. Select a clip or sequence.

2. Display the Pipeline Settings Window. Select File > Export > Pipeline to display the Pipeline 
Settings dialog. 

Figure 6–22. Use the Pipeline Settings dialog to select the Pipeline for this export.

3. Select the Pipeline and Connect. Select the Pipeline you’re exporting to, and click OK to connect. 
The Pipeline Plugin displays the Pipeline Export window:

Figure 6–23. Use the Pipeline Export window to stream clips to your Pipeline.

The VTR controls on the Pipeline Export dialog emulate the controls on a VTR. Select Play to play the 
tape in the VTR. All other VTR control operation respectively.

If you want to preview the VTR output, connect the SDI out port of the VTR to the Pipeline's SDI In port. 
When you connect, the Pipeline plugin displays the video that is present on the Pipeline’s SDI In port 
coming from the deck (which is connected to the VTR’s SDI Out port), because you may want to queue 

Select the Pipeline from the list of 
available Pipelines.

Click OK to connect.

Note: The other settings are set automatically, based 
on the clip or sequence being exported.
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up your tape or roll it to a specific point before exporting the media. (Note: This step only applies when 
doing insert or assemble edits.)

4. Select Video and/or Audio Channels to Play Out. Directly on your deck, check Video edit and/or 
Audio Edit. Most decks support 2 channels of audio, other support 4 channels. The deck may allow 
you to map your video to different channels. For example, you may be able to map Audio Edit 1 and 
Audio Edit 2 to different channels, for example. Refer to your deck’s documentation for information on 
how to set up audio mapping appropriately for your workflow. (Note: This step only applies when doing 
insert or assemble edits.)

5. Queue Your Tape. Either manually enter a start timecode where you want the edit inserted or with the 
VTR in Remote mode, use the controls to queue the tape. Next, set a mark-in point for the start 
timecode where your insert edit will begin. Note that the deck may pre-roll when you begin exporting.

6. Export your media. Now, export your media from Final Cut Pro. Press Record (the round red button) 
to play out the clip or sequence in real time from Final Cut Pro, and perform a frame-accurate insert 
edit on the tape. (Note: Does not apply to assemble or crash edits.)

During the time that Final Cut Pro is playing out media, the Pipeline Export dialog displays “Exporting clip 
or sequence name” and displays the progress bar over the clips that is exporting, until export is complete.

Using the Video Panel
The video panel displays the encoded video stream in real time.

Figure 6–24. Pipeline Export dialog video panel.

At the bottom, the video panel displays start, current, duration (from the clip or sequence you’re exporting 
and end timecode), and end (start timecode + duration). 

Non-drop-frame timecode separators are all colons. Drop-frame notation displays a semi-colon between 
the seconds and frame values. For example: 00:29:30;16 is a drop-frame timecode.

Start: Timecode of beginning of current clip.

Current: current timecode of the clip.

Duration: Length of clip being exported.

End: Initially blank. When a start time is selected this value 
is updated to start timecode + duration.This is the timecode 
on the tape where Pipeline will stop exporting.
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Using the VTR Control Panel

The VTR control panel contains VTR, shuttle and jog controls, plus a Preferences button. The VTR 
controls on the Pipeline Export dialog emulate the controls on a VTR. Selecting Play will play the tape in 
the VTR. All other VTR control operation respectively. 

Figure 6–25. Use the control panel to control your VTR and export clips.

VTR Controls

Shuttle. Click and drag to roll left or right, moving the tape reverse or forward, increasing in speed the 
farther from center you move the wheel. When you release the wheel, it returns to center and stops the 
tape. You can also click on the shuttle wheel to left or right of center to shuttle in small increments and then 
automatically return to center and stop. The further from center you click, the more frames you’ll play, in 
either direction.

Fast Reverse. Click to rewind tape.

Halt. Click to stop tape.

Pause. Click to pause tape.

Play. Click to play out video at normal forward speed.

Record. Click once to start playing out the selected clip or sequence. During playout, click to stop playout.

Fast Forward. Click to roll tape forward.

Jog. Click and drag to roll tape forward or reverse frame by frame. You can also use the scroll wheel or 
scroll ball while the mouse is hovering over the Jog wheel.

Keyboard Shortcuts

The Pipeline Plugin enables you to use keyboard shortcuts for video control – Play, Rewind, Log, Mark 
Out, Fast Forward, Mark In, Step Forward, Step Backward, Go To Mark In, and Go To Mark Out. Not all 
shortcuts apply to the Export dialog. 

Keyboard shortcuts can be customized to your own preferences, or you can select default Final Cut Pro or 
Avid shortcuts. To view and customize shortcuts, see Setting Keyboard Preferences (page 67).

Buttons

About. Click to display the About dialog, which displays the Pipeline Plugin version you have installed.

Preferences. Click to display the Preferences dialog (see below).

Help. Click to display help on using this panel.

Cancel. Click to close the dialog without importing media.

VTR Controls (for detail, see below)

Click to stop exporting and 
close the Control Panel.

Shuttle Wheel Jog Wheel

Displays Preference dialog

Displays version number.
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Performing Multiple Serial Export Operations
After you’ve completed an export, you can export the same clip or sequence again, as many times as you 
need, in serial. You may want to export the clip again if you placed it at the wrong part of a tape, or you 
want the same clip or sequence export repeated several times.

After the export is complete, you can optionally enter a new value in the start timecode field manually or by 
navigating to the start timecode with the VTR controls and clicking the 'mark in' button. Press the Record 
button. Pipeline Plugin displays a progress bar dialog with Done button in the lower right corner. You can 
repeat the same process over and over again.
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C H A P T E R 7

U s i n g  P i p e l i n e  C o n t r o l
Chapter 7, Using Pipeline Control

Use this chapter to learn about Pipeline Control and how to use Pipeline Control’s general features.

Pipeline Control is a client application for controlling digital media capture and play out from Pipeline 
devices. Pipeline Control is available for both Mac OS X and Windows users. Pipeline control provides 
different document types to provide log and capture, scheduled capture and play out, triggered manual and 
automated capture, and various types of print to tape operations. 

Pipeline Control supports both SD and HD – Pipeline SC, Pipeline Quad, and Pipeline HD Dual.

Topics

 Pipeline Control Overview (page 86)

 Starting Pipeline Control (page 87)

 Creating Pipeline Control Documents (page 88)

 Pipeline Control Menus (page 89)

 Using The Pipeline Settings Panel (page 92)

 Configuring Publishers (page 100)

 Using the Pipeline Status Panel (page 108)

 Using the Video Preview Panel (page 109)

 Using the Audio Preview Panel (page 110)

 Loading and Saving Clip List Files (page 111)

 Setting Preferences (page 112)

 Using the Diagnostics Panel (page 115)

 Supported File Formats/Wrappers (page 115)
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PIPELINE CONTROL OVERVIEW

Pipeline Control enables you to select a specific Pipeline on your network and configure it for your 
workflow requirements. 

Pipeline Control provides windows to support various recording and playout tasks: scheduled capture and 
playout, log & capture, triggered manual and automated capture, and print to tape.

Pipeline Control allows you to open multiple windows at the same time and work with them simultaneously.

Figure 7–1. Typical Pipeline Control window (Schedule window shown)

Pipelines are discovered and tracked on your network by two methods: via Bonjour or manually. Bonjour is 
preferred on most networks, because it’s automatic. You can also use the manual discovery feature 
(Manually Adding Pipelines) to discover and track Pipelines across subnets or when Bonjour traffic is 
blocked.

Pipeline Control executes the tasks on each window independently of tasks in other active windows.

Before you start working in a window, make sure the active window is actually the one you want to update.
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STARTING PIPELINE CONTROL

You can start Pipeline Control by double-clicking its icon in the Applications folder.

You can also add the Pipeline Control icon to the Dock for convenient access. To add it to the dock, open 
the Applications folder and drag the Pipeline Control icon directly onto the dock. Position it among the 
other icons where you want it displayed, and release it.

You can also start Pipeline Control by double-clicking a Pipeline document you’ve saved. Or, by dropping a 
Pipeline document onto the Pipeline Control icon in the Applications folder or the dock.

By default, Pipeline documents are saved in your Documents folder. When you open Pipeline Control in 
this manner, the Pipeline document you double-clicked is displayed. The default location for saved 
documents is the storage location specified in the wrapper settings. 

Note

Pipeline Control can only be used with Pipelines whose firmware is compatible.

When you install or update Pipeline software, you may need to update your Pipeline 
firmware as well. If you select a Pipeline with older firmware that is incompatible with 
the current version of Pipeline Control, you will be warned that this may cause 
problems.

When you open schedules created in previous versions of Pipeline Control, you may 
need to reset the audio and video settings before using them.

Note

If you’re opening Pipeline Control for the first time, you should set up preferences. For 
details, see Setting Preferences (page 112).
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CREATING PIPELINE CONTROL DOCUMENTS

Pipeline Control provides specific document types to support various tasks you can perform.

Creating Documents via the Task Selector

When you start Pipeline Control, it displays a Task Selector panel that allows you to choose which task you 
want to perform (and thus, which type of document to display):

Figure 7–2. Use the Task Selector to create new documents. 

Schedule Capture or Playout. Click to create and display a new, untitled Schedule document. For 
details, see Using Schedule Documents on page 125.

Log & Capture. Click to create and display a new, untitled Log & Capture document. For details, see 
Using Log & Capture Documents on page 137.

Capture with Trigger.  Click to create and display a new, untitled Trigger document. For details, see Using 
Trigger Documents on page 145.

Print to Tape.  Click to create and display a new, untitled Print to Tape document. For details, see  on 
page 153.

Creating New Documents via the File Menu

You can also create a new, untitled window by selecting the menu item of the appropriate document type in 
the File menu: New Schedule, New Log & Capture, New Trigger, and New Print to Tape.
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PIPELINE CONTROL MENUS

Use this section as a quick reference for Pipeline Control menu items. (General menus and menu items 
are not described.)

Pipeline Control Menu

About Pipeline Control. Displays the About dialog with the Pipeline Control version number.

Preferences. Displays Capture, Play Out, Device, and Update preferences panels. For details, see 
Setting Preferences (page 112).

File Menu

Open. Displays an Open File dialog so you can browse and open previously saved documents.

New Schedule. Creates and displays a new, untitled Schedule document.

New Log & Capture. Creates and displays a new, untitled Log & Capture document.

New Trigger. Creates and displays a new, untitled Trigger document.

New Print to Tape. Creates and displays a new, untitled Print to Tape document.

Import Pipeline Edit Decision List. Displays an Open dialog, so you can select and import a Pipeline or 
GVG 4 EDL from a file. (Loading and Saving Clip List Files (page 111)).

Import Final Cut Pro XML. Displays an Open dialog, so you can select and import a Final Cut Pro XML 
Interchange file. (Loading and Saving Clip List Files (page 111)).

Export Final Cut Pro XML. Displays a File dialog, so you can save the current clip list as a Final Cut Pro 
XML Interchange file. (Loading and Saving Clip List Files (page 111)).

Close. Closes the selected (front-most) window. If the document has not been saved or has unsaved 
changes, Pipeline Control asks you if you want to save the document before closing.

Save. Saves the changes to the active window.

Save All. Saves changes to all open documents.

Save As. Displays a Save File dialog, so you can save the current window as a document with a different 
name or in a different location.

Control Menu

The menu items under the control menu control the state of the selected (active) window.

Connect. Select to connect to the selected Pipeline.

Stop. Stops preview or capture.

Capture. Begins capturing media specified in the document from the selected Pipeline.

Play Out. Begins playing out media specified in the document to the selected Pipeline.
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Device Menu and Keyboard Shortcuts

The Device menu provides commands for controlling the VTR of the connected device using the following 
keyboard commands and keyboard shortcuts. 

Play – Space. Put VTR in play mode and play the video forward at normal forward speed.

Stop – K. Stop the VTR at the current play point.

Rewind – J. Play video backward at the deck’s rewind speed.

Fast Forward – L. Play forward at deck’s fast forward speed.

Step Backward – [ (Left Brace). Step one frame backward.

Step Forward – ] (Right Brace). Step one frame forward.

Go To Start (local playback only) – Command-[ (Left Brace). Return the clip to the beginning of the 
clip/tape at highest speed.

Go To End (local playback only) – Command-] (Right Brace). Go to end of clip/tape at highest speed.

Preview Video (Mac OS X). Select to enable video during preview|capture; select again to disable it.

Preview Audio (Mac OS X). Select to turn sound on during preview|capture; select again to turn it off.

Clip Menu

Clip menu commands enable you to edit or delete clips and provide keyboard shortcuts for easy operation.

Add. Creates a new event.

Delete. Remove the selected clip (the file is not deleted from the file system.) The selected clip is indicated 
with a blue border in the Log & Capture window.

Edit. Edit the selected clip details and metadata – indicated in the Log & Capture window by caution tape 
above and below the tabs.

Review. In Schedule and Trigger windows, select to preview a clip in the video panel.

The following menu items are only available for Log and Capture documents:

Quick Mark – M. Single-click feature for logging a clip and setting a new mark in point. Click to set the 
current point on the tape as the mark out point and logs the clip. The last clip’s mark out point becomes the 
new mark in point, so that you only have to click Quick Mark again to set the out point and log the clip.

Set Mark In – I. Set the current timecode on the tape as the clip’s in point.

Set Mark Out – O. Set the current timecode on the tape as the clip’s out point.

Go To Mark In. Roll the tape to the timecode specified in the Mark In field.

Go To Mark Out. Roll the tape to the timecode specified in the Mark Out field.

Log Clip – P. Create a clip under the current tape name in the tape field, using the values in the General 
and metadata tabs.

Help

Pipeline Control Help. Displays the Pipeline User’s Guide (the guide you are reading) via the Internet, 
when your computer has Internet access.
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Gather Support Information.  Captures all pertinent diagnostic information (software revision, Mac 
system profile, system and console log files, desktop screenshot, crash log files, and your preferences) 
and compresses it into a ZIP file placed on your desktop. The zip file can then be sent to The Telestream 
Support team for evaluation.

Figure 7–3. Support Information Window. 

Enter your case number obtained from Telestream Support and click OK. A zip file will be placed on your 
desktop.
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USING THE PIPELINE SETTINGS PANEL

At the top of each window is the Pipeline Settings panel. There are several selectors in the panel. These 
selectors enable you to select a specific Pipeline, and configure the document to use it specifically for the 
tasks/workflow you intend. Some selectors do not display in certain document types. For example, in a 
Trigger document, the Handles selector doesn’t display.

Figure 7–4. Pipeline Settings panel.

These settings are saved with the document. When the document is connected to a Pipeline, the Pipeline 
is configured for the task, based on these settings.

Selecting a Pipeline
Click the Pipeline dropdown menu and select Other to display a list of all Pipelines on your network for you 
to choose from. 

Figure 7–5. Mac OS X Pipeline browser and selection window.

A green bullet icon indicates that this Pipeline is available for Preview or Capture. A red bullet indicates 
that it is currently busy (connected and in preview, playout or capture by another client). Gray indicates 
offline; orange indicates an unknown state. To enable you to select a Pipeline to set up a document for use 
later, you can select a Pipeline regardless of its state.

Note

In preview, playout, or capture mode, these settings are disabled and you can’t make 
changes. To make changes, you must first return to idle mode.

Pipeline Selector. Click 
to select a Pipeline.

Video. Click to select and 
configure the video codec.

Wrapper. Click to select 
a wrapper or file type.

Clock. Click to select a 
timecode clock source.

Publish. Click to select 
an action to perform 
when each clip is ready.

Audio. Click to select and 
configure the audio codec.

Handles. Adjust the time value of handles (not 
displayed in Trigger documents).
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Manually Adding Pipelines

You can manually add (and remove) Pipelines across subnets or when Bonjour traffic is blocked.

To add a Pipeline manually, determine its IP address. Next, click the Plus icon (at the bottom left of the 
Pipeline selector) to display the Add Pipeline dialog:

Figure 7–6. Add Pipeline dialog.

Enter the IP address and click OK to add it to the list.

To delete a manually-entered Pipeline, select it and click the Minus icon.

Selecting a Wrapper
Click the Wrapper dropdown menu to select the wrapper/file format for this clip when captured. 

For details about supported file formats and wrappers, see Supported File Formats/Wrappers (page 115).

QuickTime

QuickTime (Open) files can be edited in Final Cut Pro as they are being captured. Because of this 
characteristic, the length specified in the QuickTime file header is set at the beginning of the capture event. 
If the captured event stops before the predetermined time, the QuickTime file retains the initial length.

Although Open QuickTime files can be played while capturing, the behavior of QuickTime is different 
between Mac OS X and Windows. In QuickTime for Mac OS X, the clip can be played to the current point 
of capture. In QuickTime for Windows, the clip can only be viewed to the point that had been captured 
when the clip was opened in QuickTime. This is a limitation of QuickTime for Windows.

For example, when a Pipeline is capturing media to a network share, on Mac OS X you can open the clip 
in QuickTime and play it to the current point of capture. However, if the same clip is opened in QuickTime 
for Windows it can only be viewed to the point that had been captured at the moment the clip was opened.

Closed QuickTime files can’t be opened while they are being captured. Use closed QuickTime files if you 
will not be editing or reviewing (playing out in QuickTime player) while capturing. Use closed QuickTime 
files when crash recording an event, and a specific duration is not known in advance.

When you select QuickTime format, Pipeline Control displays this configuration dialog:

Note

Although the file retains the initial length, the file’s size is determined by the actual 
captured media.
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Table 7–1. QuickTime File Configuration

Storage Location. Click to navigate to and select a storage directory for your files.

Open|Closed. Select Open QuickTime or Closed QuickTime by selecting the appropriate radio button.

Insert Closed Caption Track.  Check to include a Closed Caption track in the QuickTime file.

Disk Buffering. Check to use disk buffering during capture (Disk Buffering Details (page 39)).

Buffer Directory. Click to navigate to and select a buffer directory.

Audio Track Format. Select Mono or Stereo tracks.

Avid AAF+MXF

Avid AAF+MXF files created by Pipeline Control can be imported into Avid editors.

When you select Avid AAF+MXF format, Pipeline Control displays this configuration dialog:

Table 7–2. Avid AAF+MXF File Configuration

AAF Location.  Click to navigate to and select a local storage directory for the Avid AAF files associated 
with each clip. Import the AAF master clip file into your Avid edit application.
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MXF Location.  Click to navigate to and select a media directory for the MXF audio and video files 
associated with this clip. In most cases this should be the Avid Mediafiles/MXF/1 folder used by the Avid 
edit system.

MXF (OP1a)

MXF (OP1a) files are an MXF Operational Pattern 1a (OP1a, SMPTE 379M-2004) file with a generic 
container mapped to DV25, DVCPro HD, IMX or DNxHD (VC-3) video essence.

When you select MXF (OP1a) format, Pipeline Control displays this configuration dialog:

Table 7–3. MXF (OP1a) File Configuration

Storage. Click to navigate to and select a storage directory for your files.

Format – Open.  . MXF OP1a produces an MXF Operational Pattern 1a (OP1a, SMPTE 379M-2004) file 
with a generic container mapped to DV, DVCPRO, DVCPRO HD, IMX or DNxHD (VC-3) video essence. 
Use Open MXF when your workflow requires the video and audio essence to be wrapped in a single file 
meeting the SMPTE 379M-2004 MXF specification. To produce an MXF D-10 file use the IMX video codec.

Format – Closed. . MXF OP1a produces an MXF Operational Pattern 1a (OP1a) file compatible with Sony 
XDCAM with essence containers mapped to DV, DVCPRO, DVCPRO HD, IMX or DNxHD (VC-3). These 
files cannot be opened while they are being captured. Use Closed when your workflow requires the video 
and audio essence to be wrapped in a single file compatible with Sony XDCAM MXF or when capturing 
MXF OP1a clips to be imported into an Avid system.

Disk Buffering. Check to use disk buffering during capture (Disk Buffering Details (page 39)).

Buffer Directory. Click to navigate to and select a buffer directory.

Generic MXF (OP-Atom)

MXF (OP-Atom) produces MXF Operational Pattern Atom (OP-Atom) files compatible with professional 
edit systems. MXF (OP-Atom) can be used with DV/DVCPro, DVCProHD, IMX or DNxHD (VC-3) video 
essences. MXF (OP-Atom) creates a unique set of files consisting of individual MXF files for video and 
audio.

When you select Generic MXF (OP-Atom) format, Pipeline Control displays this configuration dialog:
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Table 7–4. Generic MXF (OP-Atom) File Configuration

Storage. Click to navigate to and select a storage directory for your files.

TIFO

TIFO files can be transcoded with FlipFactory or Episode Engine as they are being captured. This wrapper 
type can be used with Pipeline Control’s FlipFactory or Episode Engine publish plug-in (Mac OS X only) to 
allow for real time transcode while capturing. (For details, see FlipFactory Publisher (page 100) and 
Episode Engine Publisher in the Pipeline User’s Guide for Mac OS X).

The same workflow can be achieved on Windows by using Episode Engine's Pipeline File monitor, which is 
an input monitor that transcodes TIFO files as they're written.

When you select TIFO format, Pipeline Control displays this configuration dialog:

Table 7–5. TIFO File Configuration

Storage Location. Click to navigate to and select a storage directory for your files.

Disk Buffering. Check to use disk buffering during capture (Disk Buffering Details (page 39). Click to 
navigate to and select a buffer directory.

TIFO Format Selection.  Use the default of Version 3 when creating files for use with FlipFactory 7.2 (or  
earlier) and Vantage 2.0 (or earlier). Select Version 4 if you are writing files to be processed by Episode v5 
and v6 (or later). Future versions of FlipFactory and Vantage will support TIFO 4. TIFO version 4 adds an 
anticipated duration to the file header which allows applications using TIFO to display a real-time progress 
bar while processing these files.
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Selecting and Configuring Codecs
When you don't have a Pipeline selected (None), all codecs display. When you select a specific Pipeline, 
only those codecs supported by the target Pipeline display. When choosing the frame rate, make sure 
you’re providing an appropriate (NTSC or PAL) source.

Figure 7–7. Pipeline Control notifies you when a codec is not supported by the Pipeline.

Based on your Pipeline, you can select from Uncompressed, DV, DVCPro, IMX, DVCPro HD, ProRes, 
DNxHD, MPEG2 I-Frame, or Motion JPEG codecs. Each codec has one or more profiles from which you 
can choose.

Each codec’s profile details are located in Appendix B, Pipeline Control Codec Profiles (page 165).

When you select a codec only the resolutions that apply to that codec are hinted. When a setting is hinted 
it has a green dot next to it. Unsupported settings are selectable but may not work correctly. Frame Rate 
and Quality settings are filtered based on the resolution you select. Based on the SDI signal of the 
connected Pipeline, resolutions and frame rates that display a green dot are compatible with the current 
signal.

The SD SDI stream being ingested by the Pipeline may be an NTSC or a PAL source: if you select an 
NTSC frame rate to encode PAL, or a PAL frame rate to encode NTSC, Pipeline Control displays an error 
and prevents the capture from occurring.

In capture mode, each clip is encoded in the selected codec’s format. In playout mode, each of the clips in 
the schedule must contain a track in the selected codec. The codec is also used in preview mode, and 
affects the way the preview is displayed.

When selecting a Quality setting for NTSC or PAL captures be sure to select a setting with an Anamorphic 
suffix if the SDI source of the Pipeline requires anamorphic encoding. When selected, video preview is 
displayed at the correct aspect ratio and Pipeline Control embeds a display size flag in the QuickTime file 
so that other QuickTime applications can determine the correct display aspect ratio.

Selecting and Configuring a Video Codec

Click the Video drop down menu to select the video codec you want to use. Based on your selection, the 
frame size, frame rate, and quality dropdown menus populate with available values. Select the frame size, 
rate, and quality from the dropdown menus to meet your workflow requirements. 

Note

If the source is HD and you choose an SD codec, Pipeline down-converts the video 
according to your settings. However, the video quality may not meet your production 
workflow requirements.
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Selecting and Configuring an Audio Codec

Click the Audio drop down menu to select the audio codec you want to use (for this version, only Linear 
PCM is available). Select the number of channels, bit rate, and sample size from the dropdown menus. 
Valid options for the selected codec display with a green dot (hinted).

Selecting and Configuring a Video Codec

Click the Video drop down menu to select the video codec you want to use and configure it to meet your 
workflow requirements. 

Figure 7–8. Typical video codec settings panel.

Selecting and Configuring the Audio Codec

Click the Audio drop down menu to select the audio settings and configure it for this workflow.

Figure 7–9. Typical audio codec settings panel.

When you don't have a specific Pipeline selected (None), all Quality settings can be selected. Audio 
parameters include Channels (2, 4, 8, or 16), Sample Rate (always 48K) and Quality (16-bit | 24-bit Big 
Endian | Little Endian).

Note

Settings are hinted when they are known to work with the selected Pipeline or wrapper 
and its current input signal. However, you may be creating documents for later use, 
when the signal is different, so you can select settings that may work if you change the 
Pipeline’s input signal.

Hints also indicate the settings that are known to work given the selected wrapper 
format, such as QuickTime, TIFO, or MXF-OP1a. If both the selected wrapper and the 
selected Pipeline support the setting, it is hinted.

If you’ve already selected a codec and settings – and you select a Pipeline that doesn't 
support it – Pipeline Control will notify you when you connect that it doesn’t support the 
selected codec.
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Selecting a Timecode Clock Source

Click the Clock dropdown menu to select which device provides the timecode clock source signal. You 
must be connected to a Pipeline in order to obtain a timecode clock source, except when you choose 
Computer Clock. Choose from Auto, RS422 Device, Sync Input (Pipeline Quad and Pipeline HD Dual) 
Video Input, Pipeline Clock | Internal Clock (Windows only), or Computer Clock. When connected to a 
Pipeline Quad, you can select Channel One. When you change your timecode clock source, save your file 
to save changes.

Auto. When you select Auto the Pipeline system will search for the first appropriate time source in the 
following order: RS422, Ext Sync SDI VITC, Input Signal VITC, Zero Based.

For example, if you’re connected to a Pipeline SC and RS-422 has a timecode, it will be used because it is 
highest priority (column on right). If not, SDI timecode will be used (2nd priority), etc.

RS-422 Device. Uses the timecode provided by the device attached to the RS-422 port on the target 
Pipeline; usually a VTR. If the timecode is not available, the Pipeline timecode is provided.

Sync Input. For use with Pipeline Quad and HD Dual only. Uses the timecode provided through the 
Reference Input signal in VBI or VANC. If the timecode is not available, a zero-based timecode is provided. 
Do not select Sync Input if you are connected to a single-channel Pipeline.

Video Input. Uses the timecode provided on the Pipeline’s video input signal in VBI or VANC. If the 
timecode is not available a zero-based timecode is provided.

Pipeline Clock. Uses the timecode provided by the Pipeline itself.

Computer Clock. Uses the timecode provided by the host computer on which Pipeline Control is running.

Channel 1. When connected to a Pipeline Quad you can select Channel One’s timecode. This enables 
multiple channels of a Quad to share a common timecode when an external timecode, either on the video 
input or the Reference input, is not available.

Setting up Handles

The handles setting displays only in Log & Capture and Schedule windows. Enter the SMPTE timecode 
value HH:MM:SS:FF (max. 5:59 min.) to capture before and after the scheduled capture time.

Selecting a Publisher

Click the Publish dropdown menu to select the system that you want to notify for each clip event. 
FlipFactory and Episode Engine plugins automatically send jobs when the file is ready. For details about 
setting up each type of publisher, see Configuring Publishers (page 100).

FlipFactory, Episode Engine, Final Cut Pro, and Copy publishers are used for capture workflows.

If you don’t want to directly connect to another system in your workflow to pass the saved media file and 
optional metadata, select None.

Note

When you configure clock settings in a schedule they are stored with the schedule, and 
do not change the settings in the selected Pipeline.
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CONFIGURING PUBLISHERS

Publishers are methods of notifying a specific system that an event has occurred, or that media is available 
for processing. Methods differ, based on the notification requirements of the system you’ve selected. When 
you select a publisher, you’re prompted to configure it. Publishers include two media processing systems 
from Telestream: FlipFactory and Episode Engine. You can also publish instant messages to IM users to 
notify them of events occurring in your schedule. You can select and use one publisher per schedule.

 FlipFactory Publisher (page 100)

 Episode Engine 5.x Publisher (Mac OS X only) (page 103)

 Final Cut Pro Publisher (Mac OS X only) (page 106)

 Side Car XML Plugin (page 107)

 Copy File Publisher (page 108)

FlipFactory Publisher

Set up and use the FlipFactory publisher in Pipeline Control when you want to automatically submit media 
to a factory for processing.

To speed your workflow to near real-time by starting transcoding as soon as capture starts, select TIFO as 
the file type. When capturing media in TIFO files, FlipFactory and Episode Engine are notified as soon as 
the file is created and transcoding the media occurs as soon as it is available, thus shortening the total 
processing time. 

When capturing media in QuickTime files, FlipFactory is notified when the operation is complete and the 
file is closed.

Note
Telestream recommends installing Pipeline Control on a computer that is not hosting 
FlipFactory or other media processing applications: intense disk and CPU consumption 
can interfere with proper operation of both applications.

To publish media for processing by FlipFactory, you must be running FlipFactory 
version 6.0 (with update packs 1 through 4 installed), or greater. (See FlipFactory 
support Web page at www.telestream.net for the latest updates.)

When submitting jobs with TIFO files, it is important to save the file directly on the 
FlipFactory or Episode Engine server. Refer to Workflow System Requirements (page 
30) when writing media files to a shared storage location (SAN, NAS or shared network 
folder).
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To select FlipFactory as a publisher, select Publish > FlipFactory. The following panel displays:

Figure 7–10. FlipFactory publisher panel allows you to submit media to a specific factory.

Configure the settings in the panel and click OK. Make sure you test before putting the document into 
production.

FlipFactory Server. Select the target FlipFactory from the list.

Address. Displays the currently-selected FlipFactory; allows you to enter one manually – enter its IP 
address or server name and port number in the form <IP address|ServerName>.local:<Port Number 
(default 9000)> in the Address field.

If you’re submitting jobs to a FactoryArray, enter the FactoryArray’s virtual IP Address in the Address field. 
After selecting or entering the FlipFactory server’s ID, the FlipFactory Publisher will connect to the 
FlipFactory database to obtain the accounts and associated factories and display them.

Account. Select the account on the selected FlipFactory from the popup menu. When you select an 
account, Pipeline Control queries FlipFactory for a list of factories in the account, and takes a few seconds.

Factory. Select the factory from the list of factories in the selected account. If this factory has metadata 
labels, they will be displayed so that you can provide metadata values to submit to the factory.

File Location. Drill down into the drives available on the selected FlipFactory server to select the directory. 
Or, manually enter a path to the file in UNC format – either Drive Letter format (C:\CaptureMedia, for 
example) or \\server\dir format (\\FlipServer\CaptureMedia, for example). When selecting a directory from 
the File location list, note that it is formed from the perspective of the FlipFactory server. When manually 
entering the path, it must be valid from the FlipFactory server’s view. 
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When publishing files to FlipFactory, Pipeline Control inserts the path into the FlipFactory MDML message 
to process the job:

<file name="mxf-test 2.tifo" path="ff-pipeline1/nabfiles/mxf-test 2.tifo" 
version="original"> <protocol name="Universal Naming Convention" role="destination" 
seperator="/" type="unc" user="#USER#"> Pipeline Control <connection name="Network 
File" type="pull">

To make files on Mac OS X accessible to FlipFactory, follow these guidelines:

• File Sharing must be on (System Preferences > Sharing).

• Share files and folders using SMB (Samba) must be checked (System Preferences > Sharing > File 
Sharing > Options).

• The folder where the source files are located must be added as a share (System Preferences > Sharing 
> File Sharing). In the Shared Folders list in the Sharing panel, click the + icon to add a folder. Navigate 
to the folder (for example, the default Movies folder in your user account) and add it. 

• Users must include an entry for Everyone (or a specific user, if known), with read only access to the 
shared folder.

To make files on Windows accessible to FlipFactory, follow these guidelines:

• Windows File Sharing must be enabled.

• The folder where the source files are located must be added as a share.

• Users must include an entry for Everyone (or a specific user, if known), with read only access.
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Episode Engine 5.x Publisher (Mac OS X only)

Set up and use an Episode Engine publisher in Pipeline Control when you want to automatically submit 
media to a specific setting in Episode Engine for processing when it is ready (or while capturing in the case 
of TIFO wrapper). 

Select and configure the Episode Engine publisher to submit media to the target Episode Engine.

To speed up your workflow to near real-time by starting transcoding as soon as capture starts, select TIFO 
as the file type. When capturing to TIFO files, Episode Engine is notified as soon as the file is created, and 
transcoding the media occurs as soon as it is available, thus shortening the total processing time.

If you capture media in QuickTime, Episode Engine is notified when capture is complete and the file is 
closed.

Note

Telestream recommends that Pipeline Control be installed on a computer that is not 
hosting Episode Engine or other media processing applications: intense disk and CPU 
consumption can interfere with proper operation of both applications.

To publish media for processing by Episode Engine, you must be running Episode 
Engine version 5.x.

When submitting jobs with TIFO files, it is important to save the file directly on the 
Episode Engine server. Refer to Workflow System Requirements (page 30) when 
writing media files to a shared storage location (SAN, NAS or shared network folder).

Note

As an alternative method of accessing media from Pipeline, consider Episode Engine 
input monitors: specifically, Network File Monitor and Pipeline File Monitor.
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To select Episode Engine as a publisher, select Publish > Episode Engine. Pipeline Control displays the 
following edit panel. Complete the panel and click OK. Make sure you test your configuration before putting 
the document into production.

Figure 7–11. Episode Engine publisher allows you to submit media to a specific Episode Engine.

Episode Engine Address/IP Address. Click to select the target Episode Engine from the list or enter the 
IP address of the target Episode Engine manually in the IP Address field.

User. Enter the user name (default: anonymous).

Password. Enter the password (default: anonymous).

File Location. Enter a path or URI to the file, including the host, path, and file name or use permitted 
tokens, including slashes but without spaces between them, to form a valid path to the source file being 
ingested. The path must be valid from the Episode Engine server’s view.

%HOST% Token: The %HOST% token resolves to the name of the Mac OS X computer where Pipeline 
Control is running. When the source file is on the same computer as Pipeline Control, you can use the 
%HOST% token to supply the name of the computer. When the source file is on another platform (a server, 
or an Xsan, for example), do not use the %HOST% token. Enter the host name manually.

%FILEPATH% Token. When the source file is on the same Mac OS X computer as the Episode Engine 
server, you can use the %FILEPATH% token and %FILENAME% tokens, which provide the fully-qualified 
path to the file. Be sure to add the remaining / before the %FILENAME% token. If the file is not on the 
same platform as the Episode Engine, do not use this token, because the fully-qualified path is not valid 
when it is used on another computer.

%FILENAME% Token. The %FILENAME% token resolves to the name of the file, including the extension. 
This token is required in all scenarios.
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Forming Paths to Files on the Episode Engine server. When the file is located on the same computer 
as Episode Engine. Do not use the %HOST% or the %FILEPATH% token – enter the path manually, 
followed by /%FILENAME%.

Example: /MacHD/media/%FILENAME%

Forming URIs to Files on Other Mac OS X and Windows Servers. When the source file is on a Mac 
OS X or Windows platform that is separate from the computer where the target Episode Engine is running, 
you must mount the target share on the Episode Engine computer. In Finder, select Go > Connect to 
Server, and open the target share in the Finder.

Because the share name may be different in Finder from the actual share name, open Terminal (in 
Utilities), and drag the share from the Finder window onto the Terminal window, to resolve it.

For example, your target file is on the server Venus, in a share called CaptureMedia. When mounted in 
Finder, the share icon is named CaptureMedia. Drag this icon into the Terminal window, and it displays as 
/Volumes/CaptureMedia.

Don’t use the %HOST% token or the %FILEPATH% token – it provides the fully-qualified path to the file.

Be sure to add the / before the %FILENAME% token: /%FILENAME.

Example: /Volumes/CaptureMedia/%FILENAME%

The best way to validate the correct URI is to browse to the source file’s location directly on the Episode 
Engine computer, and compare it to the entry you’ve entered in the File Location text field.

To make remote files accessible to Episode Engine, follow these guidelines:

• File Sharing must be enabled.

• The folder where the source files are located must be added as a Share.

• Users must include an entry for Everyone (or a specific user, if known), with Read Only access.

• The target share must be mounted on the target Episode Engine computer.

Setting. Select the setting that you want to process the file with, from the list.
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Final Cut Pro Publisher (Mac OS X only)

Set up and use a Final Cut Pro publisher when you want to generate a Final Cut Pro XML Interchange file 
for each clip that is created while running a document. Using Final Cut Pro XML Interchange files makes 
importing clips easier in Final Cut Pro, because you can store the video clip on a server designated for 
video storage, and just share the XML files that point to the video. You can also set up Pipeline Control to 
drop the XML files into a Final Cut Server watched folder, for automatic video ingest.

Final Cut Pro XML Interchange files are intended to be imported into Final Cut Pro or other applications 
that are compatible. Use one of the following methods to import these files:

• Double-click the Final Cut Pro XML Interchange file

• Drag the Final Cut Pro XML Interchange file to the Final Cut Pro icon on the desktop or in the Dock

• Drag the Final Cut Pro XML Interchange file into a Final Cut Pro bin

• Select File->Import->XML in Final Cut Pro.

The XML file is created when the clip event occurs. Files referenced by the XML file may already be 
complete and closed when the XML file is opened in Final Cut Pro. Or, the file may still be in the process of 
being captured. Creating the XML file immediately permits Final Cut Pro to open QuickTIme MOV files (not 
TIFO files) and begin editing them, while they are in the process of being created by Pipeline.

To select Final Cut Pro as a publisher, select Publish > Final Cut Pro. Pipeline Control displays the 
following edit panel:

Figure 7–12. Final Cut Pro publisher allows you to create an FCP XML Interchange file.

Complete the panel and click OK to save these settings and close the dialog. Make sure you test your 
settings in Final Cut Pro or Final Cut Server before putting the schedule into production.

XML Interchange File Output Location. Click to display the File System dialog, and select the server 
and folder where you want these FCP Interchange XML Interchange files stored. This location is used in 
FInal Cut Pro to import the referenced file, or in Final Cut Server’s watched folder to automatically ingest 
the referenced file.

Next, choose how to set the path to all video files in the XML file (Set Path to files in XML):

Original Location. Select Original Location when you want to reference the videos in the location 
specified in Storage where it was created. You might choose this option when you plan to capture and edit 
while encoding, for example.

Replace with a New Path. Use Replace with New Path to specify a network path to the media file when 
the Final Cut Pro system accessing them is on a system other than the one running Pipeline Control.
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Side Car XML Plugin

The Side Car XML publishing plugin will take any populated metadata label, create a XML file, and deliver 
it to a specified location. The file can be delivered upon file creation or when the file is completely captured.

Figure 7–13. Side Car XML allows publishing of metadata labels.

Use the Side Car XML plugin for workflows that require XML metadata in conjunction with a media file. 
Custom metadata labels can be created by using the Pipeline Control's Label Editor.
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Copy File Publisher

The Copy File publisher can be used to copy a captured clip to another local or network location. 
Configuration settings include the destination of the copied file, options for when a file of the same name 
already exists and whether to append the date/time to the file name.

To select Copy File as a publisher, select Publish > Copy File. The following edit panel displays.

Figure 7–14. Copy File publisher allows you to duplicate just-completed clips.

Complete the panel and click OK. Save the document to save these settings. Make sure you test your 
configuration before putting the document into production.

Copy File To. Click to display the File System dialog, and select the folder where you want to copy the file.

If File Already Exists. Select what action to take if there is already a file of the same name in this folder: 
Replace the existing file, save the new file with a unique name, or don’t copy the new file.

Append date and time to file name. The date and time is appended, in the format YYYY-MM-DD HH-
MM-SS. For example, if the file Pipeline10.MOV was created on December 5, 2008 at 13:15 when copied, 
it would be named Pipeline10 2008-12-05 13-15-00.MOV.

USING THE PIPELINE STATUS PANEL

The topmost panel on the left side of each Pipeline Control window is the Pipeline Status panel.

Figure 7–15. The status window displays current Pipeline activity.

The status bar in the window displays the current Pipeline activity: Idle, Closing connection, establishing a 
connection, previewing, capturing, preparing, playing out, and progress when recording.

Figure 7–16. The status window displays progess when recordong.

Note

When using the Avid AAF+MXF wrapper, only the AAF/XML files will be copied.

Status. Displays status messages in preview, idle, 
playout, and capture mode.

Status. Displays progress when recording.
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USING THE VIDEO PREVIEW PANEL

The video preview panel displays video whenever a clip event is in progress (converting an SDI signal to a 
digital media file) and when a clip playout event is in progress (converting a media file to SDI), along with 
the current timecode of the Pipeline video, in HH:MM:SS:FF format. Scrubber control buttons are directly 
below the timecode control.

Disable Video Preview (by closing the panel) to decrease CPU load during capture or playout. You can 
also play local clip files (events that have already been captured) in the schedule. Hover over the event 
and select Play.

Figure 7–17. When playing a local clip, you can scrub it.

When you play a local clip the timecode panel (directly below the preview panel) displays a scrubber 
instead of the status bar, and also displays the current timecode of the selected clip, in HH:MM:SS:FF 
format. When you play a local clip attached to an event a scrubber displays, so that you can use the 
preview scrubber to scrub to any point in the clip.

Figure 7–18. Use the Video Preview panel to view incoming and outgoing video streams.

When incoming video is being encoded and streamed from the Pipeline, you can preview the media. When 
Pipeline Control is in Capture or Playout mode, video that is being captured or played out may be 
displayed in the preview panel.

If you have more than one document window open, the previewed video frame rate is scaled back to 
prevent excessive CPU usage. Preview is played at full frame rate as long as the Pipeline host computer 
has one processor (or core) per 720 X 486 pixel frame being decoded.

Scrubber. When playing a local clip, you can use the scrubber.

Video. Displays video during playout 
and capture mode.

Playback Controls. Only active when playing 
a local clip from the event schedule. 
NOTE: These controls have dual use. When 
connected to a device with RS-422 these 
buttons are used to control the deviceTimecode. Displays 

timecode in 
HH:MM:SS:FF 
format.

Shuttle Wheel Jog Wheel

Connect. Click to connect to the 
selected Pipeline for previewing video.
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Using the VTR Controls

To use the VTR, first click Connect to establish a session with the selected Pipeline.

Figure 7–19. You can use preview controls to control preview or play local clips.

Mark In. Click to set the mark in point – applies only in Log and Capture and Print to Tape documents.

Jump to Start. Click to rewind the clip to the start of clip.

Fast Reverse. Click to rewind at double speed.

Stop. Click to stop the clip or VTR.

Pause. When playing, click to pause the clip or VTR.

Play. When paused, click to play video at normal forward speed.

Fast Forward. Click to roll video forward at double speed.

End of Clip. Click to go to the end of the file.

Mark Out. Click to set the mark out point – applies only in Log and Capture documents.

Jog and Shuttle Wheels

Jog. Click and drag to roll the tape or local clip forward or reverse, frame by frame.

Shuttle. Click and drag to roll left and right, moving the tape reverse and forward, increasing in speed the 
farther from center you go. When you release the wheel, it returns to center and stops the tape. You can 
also click on the shuttle wheel to left or right of center to shuttle in small increments and then return to 
center. The further from center you click, the more frames you’ll play, in either direction.

USING THE AUDIO PREVIEW PANEL

Use the Audio panel when playing video to view the decibel output of up to 16 channels of audio.The 
volume meters depict the volume of the currently playing audio.

Figure 7–20. Volume meters display decibels in real time for each audio channel.

Disable Audio Preview (by closing the panel) to decrease CPU load during capture or playout. The scale of 
the meter is -72 dBFS to 0S dBFs.

Go to End.

Play | Pause.

Fast Reverse. Fast Forward.
Go to Start.

Connect to preview video.

Shuttle Wheel Jog Wheel
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LOADING AND SAVING CLIP LIST FILES

In capture-oriented documents (all except the Print to Tape document), Pipeline Control enables you to 
load clip lists from an EDL or a Final Cut Pro XML Interchange file. You can also save a clip list you’ve 
made, in XML format. Loading and saving clip lists via files promotes interchange between applications 
and systems, without manually re-creating them. These interchange files can be used for time-shifting your 
work, to avoid performing the same actions multiple times, or to participate in workflow tasks with others.

For example, one person can define a list of clips, save the list as an XML file, and then pass the file on to 
someone else on the network who performs the actual capture.

To load a clip list, use one of the following menu items:

File > Import Pipeline EDL. Select to populate the clip list with entries from a Pipeline EDL file.

File > Import Final Cut Pro XML. Select to populate the clip list with entries from an EDL file in Final Cut 
Pro XML Interchange Format.

Pipeline Control displays an open dialog. Navigate to the location where the file you want to open is stored, 
select it, and click Open to load the clip list.

You can also save clip list entries as a file in Final Cut Pro XML Interchange Format.

File > Export Final Cut Pro XML. Select to save the clip list in Final Cut Pro XML Interchange Format.

Pipeline Control displays a Save dialog. Enter the name of the file to save, and select the location where 
you want to save the file. Click Save to save the clip list in XML Interchange Format.

XML Interchange Format can be generated from Final Cut Pro, or any other application that supports this 
format. XML Interchange Format is the file format that Pipeline import/export or capture/playout programs 
load from and save in, in order to promote interoperability with other applications. Clip list files can also be 
generated and/or edited manually.

For further details, refer to Apple’s documentation on XML Interchange Format:

http://developer.apple.com/library/mac/#documentation/AppleApplications/Reference/FinalCutPro_XML/
AboutThisDoc/AboutThisDoc.html
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SETTING PREFERENCES

Use the Preferences panels to set up Pipeline Control the way you want to use it.

Capture Preferences

Figure 7–21. Capture Preferences

Default File Naming Conventions.  Enter a phrase to use as the basename for new video files and any 
token types. Token types can be Date, Time, Mark In (inclusive First Frame TC), Mark Out (exclusive Last 
Frame TC), Counter (increments by 1), Pipeline (name), Tape (name), Codec and Frame Rate. The use of 
date and counter ensures unique names.

Schedule - Ignore Lost Frames.  When checked, a capture session continues even if frames have been 
lost. If unchecked, the capture session aborts when any lost frames occur. This setting applies to Schedule 
documents only.

Trigger - Maximum number of clips displayed in clip history.  Use slider bar to limit the number of 
events stored in trigger history (1 to 100). This list is configured FIFO (first in first out). Default is 100 
events. This setting applies to Trigger documents only.

Offset. Set the offset size (in number of frames): minimum is -5 frames, maximum is +5 frames, default is 
0 frames. Since frames can occur early or late, depending on the deck used, this adjustment offsets the 
capture based on the number of frames chosen. It also compensates for decks that are not 100% frame 
accurate (or for systems with routing latency compared to the timecode). This adjustment must be made 
by a process of trial and error.
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Playout Preferences

Figure 7–22. Playout Preferences

Queue Size. Set the queue size (number of frames). The minimum is 8 frames and the maximum is 22 
frames. The default is 22 frames, in order to provide the most reliability.

During playout, the Pipeline queues frames in memory to compensate for network latencies. If queue size 
is set for a large number, it can ‘ride out’ higher transient latencies. However, a large number also 
introduces a longer delay between the time the frame is emitted and the time that the frame appears on the 
SDI connection (about 1/4 second for 8 frames, up to about 3/4 second for 22 frames).

If you are concerned with latency between the time video is exported from the computer and the time it is 
sent out the Pipeline, you should adjust the value lower. However, lowering this value makes the 
connection more susceptible to errors due to insufficient CPU power or network bandwidth.

Offset Size. Set the offset size (number of frames). The minimum is -5 frames and the maximum is +5 
frames. The default is 0 frames.

Frames can occur early or late depending on the deck used. This adjustment offsets the playout based on 
the number of frames chosen and compensates for decks that are not 100% frame accurate to the 
timecode provided. This adjustment is made by a process of trial and error.

Ignore Lost Frames. When checked, a playout session continues even if frames have been lost. If un-
checked, the playout session aborts when any lost frames occur.

Note

Not Applicable to Crash mode playout.
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Device Preferences

Figure 7–23. Device Preferences

Preroll Duration. Specify the seconds to preroll video from start timecode during import operations.

Postroll Duration. Specify the seconds to postroll video from end timecode during import operations.

Automatically Eject Tapes. Check to have Pipeline Control eject the tape when capture is complete, if 
another tape is required.

Update Preferences

Figure 7–24. Update Preferences

The Update panel displays the current version, the last time the Telestream Web site was checked for 
availability of an update, and to determine when to check for updates from the Web site.

Check for Updates. Select Daily, Weekly, Monthly, or Never, to check for application updates.

Check Now. Click Check Now to check Telestream’s Web site for application updates right now, and let 
you know if Pipeline Control is up to date or updates are available. 
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USING THE DIAGNOSTICS PANEL

The diagnostics panel is for advanced users as an aid to providing easy access to a Pipeline device’s 
diagnostic and administration interfaces during trouble shooting and technical support. The diagnostic 
panel  provides debugging information about Pipeline hardware and Pipeline Control that may be useful to 
Telestream Customer Service (Obtaining Pipeline Support | Information | Assistance (page i)).

For more details on troubleshooting, see Appendix A,  Troubleshooting (page 161).

Figure 7–25. Diagnostics window provides advanced information.

The Pipeline Console text box displays debug information produced by the Pipeline firmware, which is 
useful in debugging by providing a glimpse at the firmware perspective of the system.

During capture operations an emptierbuffer is better; for playout, fuller is better. The RAM meter displays 
the percentage of the video or audio (which ever is more full) frame buffer that is currently full, as well as a 
high-water mark that displays the largest size the buffer has been in the last five seconds. 

During normal operations, the meter displays green. If the meter displays yellow, marginal conditions exist; 
red indicates that Pipeline Control is likely to underflow/overflow the buffer, which will cause the current 
operation to abort.

If disk buffering is enabled (available for certain wrapper formats), the Disk meter displays how much data 
(as a percentage) is remaining to be transferred to its final destination (see Disk Buffering, below). When 
this grows, it indicates that Pipeline Control is no longer able to write to the final destination at the same 
speed it is receiving the data, which is usually caused by a network or I/O issue.

SUPPORTED FILE FORMATS/WRAPPERS

Storage Models
The Pipeline's application software implements a variety of media wrapper formats. These wrapper 
formats are described below and include TIFO, QuickTime (Open and Closed), Avid AAF+MXF, MXF 
OP1a, XDCAM MXF OP1a.

Each wrapper format has different requirements of, or assumptions about the storage system used to 
capture and playback the media.

The storage requirements and application of a wrapper format are collectively defined by a storage model. 
This section describes the storage models used by the Pipeline application.
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Direct Attached Storage (DAS) Model

This storage model is employed by wrapper formats that require:

• The ability to seek to random points within the file.

• The ability to disable or control the zero-fill behavior of the file system.

• No buffering by the application to achieve optimal I/O performance.

Storage Area Network (SAN) Model

This storage model is used in high performance capture applications. Wrapper formats that implement this 
model make the following assumptions:

• The wrapper file can be sequentially constructed.

• Optimal performance is achieved by writing to the file in large (> 1 MB) sequential blocks.

• The zero-fill behavior of the file system cannot be disabled.

Network Attached Storage (NAS) Model

This storage model is used in applications where the capture destination is a network attached file system 
(NFS, Samba, etc,) and when the network bandwidth or performance of that file system is unpredictable.

In this model the media is captured to a temporary file with the assumptions defined by the SAN model. 
The temporary file is then sequentially (and concurrently) delivered to the target file system as network 
bandwidth allows. When the media is successfully delivered to the target file system the temporary file is 
removed.

This storage model require is enabled by selecting Disk Buffering within the Wrapper selection dialog.

Format Wrappers
Pipeline Control supports several industry-standard and proprietary wrappers: TIFO, QuickTime (Open 
and Closed), Avid AAF+MXF, MXF, and XDCAM MXF.

Telestream Intermediary Format (TIFO)
TIFO files can be transcoded with FlipFactory or Episode Engine as they are being captured. This wrapper 
type can be used with Pipeline Control’s FlipFactory or Episode Engine publish plug-in to enable real time 
transcode while capturing. (For details, see FlipFactory Publisher (page 100) and Episode Engine 5.x 
Publisher (Mac OS X only) (page 103)).

The same workflow can be achieved on Windows by using Episode Engine's Pipeline File monitor, which is 
an input monitor that transcodes TIFO files as they're written.

Telestream Intermediary Format (TIFO) is an intermediate media wrapper format designed by Telestream 
as a uniform, interchangeable file format to ensure interoperability among Telestream’s media processing 
solutions, including FlipFactory, Episode, and Pipeline. TIFO provides a lightweight, low-overhead wrapper 
that is essence-agnostic, with out-of-band metadata, timecode, and closed caption support.

Using TIFO improves the ability to move media files between Telestream’s media processing solutions with 
all media essence elements and metadata intact, preserving the widest range of transcoding options.
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Workflow Considerations

TIFO format should be used when you are transcoding your files with FlipFactory or Episode. TIFO files 
are unique, in that they can be transcoded as they are being captured in FlipFactory and Episode Engine, 
enabling you to create multiple output files in real-time. TIFO files can be processed by Episode Desktop 
when they have been closed. TIFO files can also contain metadata such as closed captions and timecode, 
which can be processed by FlipFactory or Episode.

Storage Model. TIFO wrapper implements the SAN and NAS storage models (Storage Models on page 
115).

Table 7–6. TIFO Format Summary

Usage Considerations

TIFO files are a Telestream proprietary format and are not playable or readable by non-Telestream 
applications. You should only use TIFO format if your workflow requires processing by Telestream 
workflow automation applications. The maximum length of a TIFO file is 9 hours.

QuickTime
QuickTime (Open) files can be edited in Final Cut Pro as they are being captured. Because of this 
characteristic, the length specified in the QuickTime file header is set at the beginning of the capture event. 
If the captured event stops before the predetermined time, the QuickTime file retains the initial length.

Although Open QuickTime files can be played while capturing, the behavior of QuickTime is different 
between Mac OS X and Windows. In Mac OS X, the QuickTime clip can be played to the current point of 
capture. In QuickTime for Windows, the clip can only be viewed to the point that had been captured when 
the clip was opened in QuickTime. This is a limitation of QuickTime for Windows.

For example, when a Pipeline is capturing media to a network share, in Mac OS X you can open the clip in 
QuickTime and play it to the current point of capture. However, if the same clip is opened in QuickTime for 
Windows it can only be viewed to the point that had been captured at the moment the clip was opened.

Closed QuickTime files can’t be opened while they are being captured. Use closed QuickTime files if you 
do not plan to edit or review (playing out in QuickTime player) while capturing. Use closed QuickTime files 
when crash recording an event, and a specific duration is not known in advance.

Video Motion JPEG-A, DV, DVCPro, IMX, MPEG2-I-Frame, DVCProHD, ProRes, 
DNxHD, Uncompressed

Audio 16 channels, 16/24 bit, 48 kHz

Timecode Video sample header

Closed captions Video sample parameter ("ATOM")

Ancillary data Video sample parameter ("ATOM")

Note

Although the file retains the initial length, the file’s size is determined by the actual 
captured media.
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If 608 closed captions are available in the source during capture, they are automatically embedded into a 
QuickTime closed caption track. When played in QuickTime Player, the closed caption data is overlaid on 
the player display by selecting  Show Closed Captioning in the View menu.

Figure 7–26. QuickTime File Configuration

QuickTime (Open)

Workflow Considerations

Use Open QuickTime files if you will be editing or reviewing (playing out in QuickTime player) while 
capturing. Be aware of the disk I/O implications of this workflow by reading Workflow System 
Requirements (page 30).

Storage Model. QuickTime Open wrapper implements the SAN and NAS storage models (Storage Models 
on page 115).

Note

When writing files to a shared folder on a computer, the security settings must allow full 
read/write for the user accessing the file for edit.
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Table 7–7. QuickTime Open Format Summary

Table 7–8. QuickTime Open Applicable Standards

Usage Considerations

The maximum length of an open QuickTime file is 9 hours. When using a Schedule document in Pipeline, 
an event can’t exceed 9 hours. Capturing an open QuickTime in a Trigger document without first specifying 
a duration results in a QuickTime file that reports a duration of 9 hours, no matter how long the actual 
recorded event is.

QuickTime (Closed)

Workflow Considerations

Closed QuickTime files can’t be opened while they are being captured. Use closed QuickTime files if you 
will not be editing or reviewing (playing out in QuickTime player) while capturing. Use closed QuickTime 
files when crash recording an event, and a specific duration is not known in advance.

Storage Model. QuickTime Closed wrapper implements the SAN and NAS storage models (Storage 
Models on page 115).

Video Motion JPEG-A, DV, DVCPro, IMX, MPEG2-I-Frame, DVCProHD, ProRes, 
DNxHD, Uncompressed

Audio 16 channels, 16/24 bit, 48 kHz, 1/2 channels per track

Timecode Timecode ('tmcd') track

Closed captions Closed caption ('clcp') track, EIA-608 caption data

Ancillary data Essence storage only

Standard Title

IEC 14496-14 MP4 File Format

QuickTime File Format Specification
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Table 7–9. QuickTime Closed Format Summary

Table 7–10. QuickTime Closed Applicable Standards

Usage Considerations

The maximum length of a closed QuickTime file is 9 hours. When using a Schedule document, no event 
can exceed 9 hours. Capturing a closed QuickTime file in a Trigger document without first specifying a 
duration (or specifying a duration longer than 9 hours) always results in a 12-hour QuickTime file.

Avid AAF+MXF

Workflow Considerations

Avid AAF+MXF produces MXF Operational Pattern Atom (OPAtom) files compatible with Avid professional 
edit systems. Avid AAF+MXF can be used with DV25, DVCPro HD, IMX or DNxHD (VC-3) video 
essences. Avid AAF+MXF creates a unique set of files consisting on an AAF master clip file and individual 
MXF files for video and audio. The AAF file and associated media files can be delivered into separate 
folders that are specified in the Avid AAF+MXF selection dialog. Avid AAF+MXF files can’t be opened 
while they are being captured. 

Use Avid AAF+MXF when your workflow requires compatibility with Avid edit systems.

Storage Model. Avid AAF+MXF  wrapper implements the DAS storage models (Storage Models on page 
115).

Video Motion JPEG-A, DV, DVCPro, IMX, MPEG2-I-Frame, DVCProHD, ProRes, 
DNxHD, Uncompressed

Audio 16 channels, 16/24 bit, 48 kHz, 1/2 channels per track

Timecode Timecode ('tmcd') track

Closed captions Closed caption ('clcp') track, EIA-608 caption data

Ancillary data Essence storage only

Standard Title

IEC 14496-14 MP4 File Format

QuickTime File Format Specification
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Table 7–11. Avid AAF+MXF Format Summary

Table 7–12. Avid AAF+MXF Applicable Standards

Usage Considerations

The Avid AAF+MXF file wrapper can’t be used in conjunction with Pipeline Control’s Disk Buffer feature. 
Take extra care when writing Avid AAF+MXF files to shared disk subsystems. See Workflow System 
Requirements (page 30).

The maximum length of an Avid AAF+MXF file is 9 hours. When using a Schedule document, no event can 
exceed 9 hours. Capturing Avid AAF+MXF files in a Trigger document without first specifying a duration 
always results in Avid AAF+MXF files that report the exact duration of the recorded event.

MXF (OP-1a)

Workflow Considerations

Opened Open MXF produces an MXF Operational Pattern 1a (OP-1a, SMPTE 379M-2004) file with a 
generic container mapped to DV, DVCPro, DVCPro HD, IMX or DNxHD (VC-3) video essence.

Use Open MXF when your workflow requires the video and audio essence to be wrapped in a single file 
meeting the SMPTE 379M-2004 generic MXF specification. To produce an MXF D-10 file use Open MXF 
in conjunction with the IMX video codec.

Closed Produces an MXF Operational Pattern 1a (OP-1a) file compatible with Sony XDCAM with essence 
containers mapped to DV, DVCPro, DVCProHD, IMX or DNxHD (VC-3). These files can't be opened while 
they are being captured. 

Video DV, DVCPro, DVCProHD, IMX, DNxHD

Audio 16 channels, 16/24 bit, 48 kHz, PCM

Timecode SMPTE 377M timecode track

Closed captions Essence storage only

Standard Title Notes

SMPTE 377M-2004 Material Exchange Format (MXF)

SMPTE 390M-2004 MXF Operational Pattern Atom

SMPTE 382M-2007 Mapping AES3 and Broadcast 
Wave Audio into the MXF Generic 
Container.

Each channel contained in a separate 
AES3 track/atom.

SMPTE 383M-2008 Mapping DV-DIF Data into the 
MXF Generic Container

Defines clip-wrapped DV-DIF 
essence.

SMPTE 386M-2004 Mapping Type D-10 Essence 
Data to the MXF Generic Con-
tainer

Clip-wrapped D-10 is not defined 
(Avid is 2KB KAG padded, Apple is 
512B KLV filled).

SMPTE 2019-4-
2008

Mapping VC-3 Coding Units into 
the MXF Generic Container

Defines clip-wrapped VC-3 essence.
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Use 'Closed' when your workflow requires the video and audio essence to be wrapped in a single file 
compatible with Sony XDCAM MXF or when capturing MXF (OP-1a) clips to be imported into an Avid 
system.

Table 7–13. MXF Format Summary

Table 7–14. MXF Applicable Standards

Usage Considerations

The MXF OP1a Closed file wrapper cannot be used in conjunction with Pipeline Control's Disk Buffer 
feature. Take extra care when writing MXF (OP-1a) Closed files to network disk subsystems.

The maximum length of an MXF (OP-1a), open or closed file, captured in Pipeline Control is 9 hours. 
Capturing an MXF (OP-1a) file in a Trigger document without first specifying the duration always results in 
a MXF file that reports the exact duration of the recorded event.

Video DV, DVCPro, 
DVCProHD

IMX DNxHD

Audio 16/24 bit, 48 kHz

16 channels 8 channels 16 channels

PCM/Dolby E PCM/DolbyE PCM/Dolby E 

Timecode SMPTE 377M Timecode track

SMPTE 385M System item SMPTE 405M System item

Standard Description Note

SMPTE 331M-2004 Elements and Metadata Definitions for SDTI-CP

SMPTE 377M-2004 Material Exchange Format (MXF)

SMPTE 378M-2004 MXF Operational Pattern 1a

SMPTE 379M-2004 MXF Generic Container

SMPTE 382M-2007 Mapping AES3 and Broadcast Wave Audio into 
MXF Generic Container

DV (AES3), DNxHD 
(BWF)

SMPTE 383M-2008 Mapping DV-DIF Data into MXF Generic Con-
tainer

DV

SMPTE 385M-2004 Mapping SDTI-CP Essence and Metadata into 
MXF Generic Container

DV, IMX

SMPTE 386M-2004 Mapping Type D-10 Essence Data to MXF 
Generic Container

IMX

SMPTE 394M-2006 System Scheme 1 for MXF Generic Container DNxHD

SMPTE 405M-2006 Elements and Individual Data Items for MXF 
Generic Container System Scheme 1

DNxHD

SMPTE 2019-4-
2008

Mapping VC-3 Coding Units into MXF Generic 
Container

DNxHD

SMPTE RDD03 eVTR MXF Interoperability Specification DV, IMX
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These files can be added to Final Cut Pro systems by using Flip4Mac MXF or MXF4Mac components, and 
to Avid Media Composer systems utilizing the Avid AMA MXF plug-in

When you select MXF (OP1a) format, Pipeline Control displays this configuration dialog:

Figure 7–27. MXF OP-1a Dialog Box

File Location. Click Browse to navigate to a storage directory for your media files.

Format – Open. MXF OP1a produces an MXF Operational Pattern 1a (OP1a, SMPTE 379M-2004) file 
with a generic container mapped to DV, DVCPRO, DVCPRO HD, IMX or DNxHD (VC-3) video essence.

Use Open MXF when your workflow requires the video and audio essence to be wrapped in a single file 
meeting the SMPTE 379M-2004 generic MXF specification. To produce an MXF D-10 file use the IMX 
video codec.

Format – Closed. MXF OP1a produces an MXF Operational Pattern 1a (OP1a) file compatible with Sony 
XDCAM with essence containers mapped to DV, DVCPRO, DVCPRO HD, IMX or DNxHD (VC-3). These 
files cannot be opened while they are being captured. 

Use Closed when your workflow requires the video and audio essence to be wrapped in a single file 
compatible with Sony XDCAM MXF or when capturing MXF OP1a clips to be imported into an Avid 
system.

MXF (OP-Atom)

Workflow Considerations

MXF (OP-Atom) produces MXF Operational Pattern Atom (OP-Atom) files compatible with professional 
edit systems. MXF (OP-Atom) can be used with DV/DVCPro, DVCProHD, IMX or DNxHD (VC-3) video 
essences. MXF (OP-Atom) creates a unique set of files consisting of individual MXF files for video and  
audio.

Output file naming:

• Video - <Filename>.MXF

• Audio - <Filename>nn.MXF, where 'nn' is a number between 00 and 15

• Data - <Filename>D.MXF

Pipeline's MXF (OP-Atom) files are not intended to be used with Avid Media Composer MXF AMA plug-in. 
Use Avid Media Tool directly or Interplay to add them to your media database.
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Table 7–15. Avid AAF+MXF Format Summary

Table 7–16. Avid AAF+MXF Applicable Standards

Usage Considerations

The MXF (OP-Atom) file wrapper can be used in conjunction with Pipeline Control's Disk Buffer feature.

The maximum length of an MXF (OP-Atom) file captured in Pipeline Control is 9 hours. When using a 
Scheduled Capture document, no event can exceed 9 hours. Capturing an MXF (OP-Atom) file in a Trigger 
document without first specifying a duration results in an file that reports the exact duration of the recorded 
event.

When you select MXF (OP-Atom) format, Pipeline Control displays this configuration dialog.

Figure 7–28. MXF OP-Atom Dialog Box

File Location. Click Browse to navigate to a storage directory for your media files.

Video DV, DVCPro, DVCProHD, IMX, DNxHD

Audio 16 channels, 16/24 bit, 48 kHz

Timecode SMPTE 377M timecode track

Closed captions Essence storage only

Standard Title Notes

SMPTE 377M-2004 Material Exchange Format (MXF)

SMPTE 390M-2004 MXF Operational Pattern Atom

SMPTE 382M-2007 Mapping AES3 and Broadcast 
Wave Audio into the MXF Generic 
Container.

Each channel contained in a separate 
AES3 track/atom.

SMPTE 383M-2008 Mapping DV-DIF Data into the 
MXF Generic Container

Defines clip-wrapped DV-DIF 
essence.

SMPTE 386M-2004 Mapping Type D-10 Essence 
Data to the MXF Generic Con-
tainer

Clip-wrapped D-10 is not defined 
(Avid is 2KB KAG padded, Apple is 
512B KLV filled).

SMPTE 2019-4-
2008

Mapping VC-3 Coding Units into 
the MXF Generic Container

Defines clip-wrapped VC-3 essence.
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C H A P T E R 8

U s i n g  S c h e d u l e
D o c u m e n ts
Chapter 8, Using Schedule Documents

Use this chapter to learn how to use Pipeline Control to create schedules for capturing media from Pipeline 
and for playing media out on Pipeline. Capturing or playing media on a schedule is achieved using the 
Schedule document.

Topics

 Using The Schedule Window (page 126)

 About Schedules (page 127)

 Creating Capture Schedules (page 128)

 Creating Playout Schedules (page 129)

 Using the Schedule Panel (page 130)

 

You can only play out schedule documents in Pipeline Control for Mac OS X, and video must be in 
QuickTime format, with essences of any supported SD codec in the selected Pipeline.
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USING THE SCHEDULE WINDOW

The Schedule document is designed to facilitate the creation of clip capture and playout schedules.

Figure 8–1. Schedule Window panels and toolbars.

Each window displays several panels, each designed to help you perform the tasks the window was 
designed for. Each panel, toolbar, and feature is described below. For details on how to use the Pipeline 
Settings panel and all panels and controls on the left, see Chapter 7, Using Pipeline Control (page 85). 

The schedule window is composed of a 24-hour schedule panel (on the right), and video/audio, state and 
diagnostics panels on the left. You can open multiple windows at a time.

Pipeline Status. 
Displays status. 

Preview panel. 
Displays video.

Timecode. 
DIsplays when 
connected.

VTR Controls. 
Use to play video.

Schedule panel. 
Displays all clips in 
a timeline.

Schedule Mode Toolbar. Controls 
how you use the schedule.

Audio Panel. 
Displays volume 
by channel.

Clip Event. Add 
these clip events to 
capture or play out 
video on schedule.

Pipeline Settings. Use to configure 
Pipeline for use in this schedule.

Schedule Details. Displays number of clips, total 
capture hours, and approx. space required.

Schedule Toolbar. Provides buttons 
for frequently used functions.

Schedule/List 
View buttons.

Current Time. 
Current timecode 
for this schedule.
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ABOUT SCHEDULES

A schedule is a list of one or more clip events to be processed in a recurring 24-hour period. Each 
schedule also has information about Pipeline selection and settings, and optional publisher specifications. 
Each schedule is displayed in a different window in Pipeline Control. Because Pipeline Control is a multi-
document application, you can open, edit, and execute (in playout or capture mode) several schedules at 
the same time. The number of media files you can capture or play out simultaneously is based on the 
power of the CPU and disk write or read speed in your computer and your network bandwidth (Disk and 
Network Requirement by Media Format on page 41).

Creating Schedules. To create a schedule, select File > New Schedule to display a new schedule 
window. To save a schedule, select File > Save or Save as, name the document and select a folder to save 
it in. When you save a schedule, it is saved as a document. You can copy Pipeline Control documents and 
move them to other folders or other computers. You can treat Pipeline Control documents just like you do 
any other document.

When you close a schedule window, if it hasn’t been saved before, you’ll be asked to name it. If you’ve 
changed it, you’ll be asked if you want to save changes 

Each schedule contains several important groups of information: a selected Pipeline and its settings, plus 
a list of one or more clip events arranged in a 24-hour timeline, along with their file names and optional 
metadata, and optional publishers. Pipeline Control uses the schedule information to execute each clip 
event at the correct time, to either capture the clip, or play out the clip.

Schedules are Symmetrical. That is, if you capture a given schedule, Pipeline Control runs the schedule 
and ingests encoded media from a specific Pipeline’s SDI port based on the clip events you’ve created in 
the schedule, and saves it as a specific type of file, based on your settings. You can also play out the same 
schedule and the reverse occurs: each file you specify with a clip event is opened at the correct time and 
the media is played out to the specified Pipeline for decoding and playout as SDI.

You can make as many schedules as you need to organize your workflows and tasks efficiently. You might 
create schedules for each Pipeline you’re using, or you might create schedules for a specific set of clips 
you need to capture or play out each day (or work shift). Or, you can create schedules based on how you 
want the media encoded, for use in an edit system, for example.

Pipeline Control automatically reconnects a schedule document if network connectivity or video signal is 
lost, and continues processing events. If an event is being recorded or played out, the file (or output of the 
file) is invalid.

Note

Active schedules must first be deactivated to close them. You may be interrupting a clip 
event, so check first.
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CREATING CAPTURE SCHEDULES

A capture schedule is a schedule with one or more clip events, which you use to capture SDI video in real 
time. The SDI video is converted to a specific media format, depending on the codec you specify in 
Pipeline Control, and saved as a digital media file in the wrapper/file format you select in Pipeline Control.

Use these steps and use a capture schedule:

1. If Pipeline Control isn’t running, start it now (Starting Pipeline Control on page 87).

2. Create a new, untitled Schedule document (Select File > New Schedule) if one isn’t open.

3. Select the Pipeline device which is supplying the video feed you want to capture (Selecting a Pipeline 
(page 92)).

4. Select the video codec and configure it to meet your video encoding requirements (Selecting and 
Configuring a Video Codec (page 98).

5. Likewise, configure the audio codec to meet your audio encoding requirements (Selecting and 
Configuring the Audio Codec (page 98).

6. Specify your timecode clock source (Selecting a Timecode Clock Source (page 99)).

7. Select your wrapper (file) format (Selecting a Wrapper (page 93)), configure it, and specify the storage 
location where you want your media clips saved.

8. Set up handles as necessary (Setting up Handles (page 99)).

9. Optionally, select and configure a publisher to perform additional actions as part of a workflow 
(Selecting a Publisher (page 99)).

10. Save your schedule and name it, then continue.

11. Add one or more clip events to the schedule (Creating Clip Events (page 131)). Each clip has a start 
time and a duration. 

12. For each clip, enter a file name if you want it to be different than the default, and optionally, select a 
metadata label and enter metadata (Editing a Clip Event’s Property Sheet (page 132)).

13. Save the schedule.

14. Click Capture to place the schedule into capture mode.

15. Pipeline Control displays the incoming video stream – verify the stream is what you expect. Pipeline 
Control waits for each clip event, and saves each clip as a file in the essence and format you specify.
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CREATING PLAYOUT SCHEDULES

A playout schedule is a schedule created with the intent of decoding the media in QuickTime files on a 
Pipeline device, and converting them to SDI for playout in real time.

SD QuickTime files containing supported video formats are capable of playout by Pipeline Control. Audio 
must be uncompressed linear PCM 16 or 24 bit (Little or Big Endian), in mono or stereo tracks. 

Audio formats can be mixed in a playout schedule. For example, you can have one clip with 24 bit Big 
Endian in dual mono, and another with 16 bit Little Endian in stereo. However, you can not mix audio 
formats in a single clip and you must have at least the number of audio channels that you want to play out 
(you can have more).

Use these steps to create and use a playout schedule:

1. If Pipeline Control isn’t running, start it now (Starting Pipeline Control on page 87). 

2. Create a new, untitled Schedule document (Select File > New Schedule) if one isn’t open. 

3. Select the Pipeline device which you want to use to playout your video clips as SDI (Selecting a 
Pipeline (page 92)).

4. Select the video codec and configure it to meet your video decoding requirements (Selecting and 
Configuring a Video Codec (page 98)).

5. Likewise, configure the audio codec to meet your audio decoding requirements (Selecting and 
Configuring the Audio Codec (page 98)).

6. Specify your timecode clock source (Selecting a Timecode Clock Source (page 99)).

7. Optionally, select and configure a publisher to perform additional actions as part of a workflow 
(Selecting a Publisher (page 99)).

8. Save your schedule and name it, then continue.

9. Add one or more QuickTime files as clips to the schedule (Creating Clip Events (page 131)).

10. Save the schedule.

11. Click the Play button to place the playout schedule into play mode. 

Now, Pipeline Control displays the outgoing video stream. Pipeline Control waits for each clip event, reads 
the media file, and delivers each clip’s media in real-time to the Pipeline, which decodes it and plays it out 
as SDI.

 

You can only create play out schedules in Pipeline Control on Mac OS X. Pipeline Control for 
Windows does not support scheduled play out.
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USING THE SCHEDULE PANEL

The schedule panel (on the right side of the window) is a vertically-oriented view of a 24-hour period. A 
time scale displays on the left, with space on the right to add clip events. The time is controlled by the 
timecode clock source you specify.

Figure 8–2. The schedule panel allows you to create clip events.

At the far left is a toolbar with buttons for frequently used functions. Above the event area is a Schedule/
List view button that enables you to display the complete schedule or just a table of events. 

You add clip events by clicking and dragging in the schedule (for capture) or by dragging and dropping a 
file onto the schedule (for playout) from the Finder. Each file you add is checked to make sure that the file 
contains supported audio and video tracks, or it is rejected.

Figure 8–3. Clip events in your schedule provide details about the clip.

When you add a new clip event, it snaps to a preset block of time based on how far you are zoomed in on 
the schedule. A capture clip event only displays the time and name of the clip in the title. Once the event 
has been captured, a file is associated with the clip event, so it displays a Play icon in the body when you 
hover over it.

When you add a local file to a schedule (by dragging it onto the schedule), it also creates a clip event. 
When you hover over the clip, it immediately displays a Play icon in the body. Click the Play icon to preview 
the clip.

Event Timer. Indicates current time in schedule.

Clip Event. Click and drag to create a new event or drop 
a file onto the schedule from the Finder. 

Capture, Idle, and playout buttons. 

Schedule/List View. Click to display the full event list in 
schedule view or just display the list of clip events. 

Schedule Toolbar. Provides buttons for frequently 
used functions. 

Event Menu. Enables you to delete an event, edit it, or 
show the enclosing folder in the Finder.

Status Badge. Indicates the state of the clip in real time.

Title. Displays the start and end time, and name of clip. 
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You can resize a clip (up to 9 hours long) by dragging either the top or bottom and resizing it. When you 
resize a clip, it snaps to preset time lengths (half hour, quarter hour, five minutes, or one minute, depending 
on the magnification of the schedule. 

To snap to preset lengths at half the displayed time scale press the control key while resizing the clip. You 
can zoom in to increase your view of the schedule with greater detail (but with smaller clip lengths). You 
can also edit the time down to the second by double-clicking on the clip event title to display its property 
sheet.

If you adjust the time of a clip event which is currently associated with a file and execute the event in 
playout mode, the file will play when the clip event is scheduled to start. It will end at the actual end of file 
or at the end of the clip event, whichever is shorter.

Schedule Panel Keyboard Shortcuts

You can work with clips in your schedule using the following keyboard shortcuts:

Delete. Deletes the selected clip event

Left Arrow. Select the previous clip event

Shift+Left Arrow. Select the first clip event

Right Arrow. Select the next clip event

Shift+Right Arrow. Select the last clip event

Up Arrow. Move the selected clip up the schedule by the current block size (half hour, quarter hour, 
minute, thirty seconds, etc.), based on your current zoom increment.

Down Arrow. Moves the selected clip event down by the current block size.

Home. Scroll to the top of schedule.

End. Scroll to the bottom of schedule.

Creating Clip Events

To add a clip event to a schedule, choose one of several actions:

• Move your cursor into the schedule panel and position it at the approximate start time. Now, click and 
drag downward for a maximum of 9 hours or until the end of the clip event (you can adjust the time 
accurately later) and release the button.

• Open a folder on your computer or LAN server and drag and drop media files (those that can be opened 
with QuickTime) onto the schedule panel, at any time position that doesn’t overlay other clips already 
on the schedule. Clip events that are attached to a file are titled with the file name.

• Drag a clip from one schedule to another, if the clip has already been captured.

• Click the Add Clip icon (the plus sign icon) at the top of the schedule toolbar or select Clip > Add.

Once a clip has been placed on the schedule, you can drag it up and down the timeline (by clicking in the 
body of the event – not the title) to change the start/stop time. Or, open the property sheet (double-click the 
title) and adjust the start and stop time. You can’t create a single clip event lasting longer than 9 hours.

You typically create new clip events directly in the event panel, when you’re creating a capture schedule. 
You typically create new events by dragging and dropping, when you’re creating a playout schedule. When 
clips are captured, they are saved in the folder specified by the storage location.
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You can move a clip by clicking in the body of the clip event and dragging it up or down. This avoids the 
necessity of moving a clip by adjusting both the start and stop times correctly. You can’t overlap clip events 
on a schedule.

To play a local clip (directly on your computer, SAN, or connected server), hover the mouse over the clip 
event and click the Play button that displays. If the file exists and is accessible, it plays in the preview area.

Deleting Clip Events

To delete a clip you’ve selected, choose one of several actions:

• Press the Delete key on the keyboard

• Click the X icon to the left of the schedule

•  Right-click and select Delete from the context menu.

Deleting a clip does not delete an associated file, if one is present.

Showing Media in Finder

When an event in the schedule is connected to a local file, you can open the folder that contains the file 
directly. Select the event. Then, control-click and select Show Storage Location in Finder. Pipeline Control 
sends a command to the Finder to display the clip in the enclosing folder. 

Editing a Clip Event’s Property Sheet

Each clip event has its own property sheet. To display a clip event’s property sheet:

• Double-click in the event’s title bar

• Select the clip and click the i icon in the toolbar to the left of the timeline

• Right-click to display the context menu and select Edit Properties. 

Viewing and Updating General Properties

To view or update the general properties of a clip event, double-click in the clip event’s title, then click the 
General tab to display this sheet.
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Figure 8–4. Clip event general properties – file name, start/end time, event color.

Start and End Time. Edit the digital clock (or the analog clock, by clicking and dragging the hour, minute 
and second hands) to adjust the start and end times of the clip event.

Link. Check Link to adjust the start or end time while maintaining the duration.

Name. Enter the name of the clip and/or naming tokens using the pull-down menu.

Color. Select a color to display in the schedule panel for this clip event.

Click OK to save your changes or click Cancel to leave them unchanged.

Viewing and Updating Metadata Labels

To view or update the label values of a clip event, double-click in the clip title on the schedule; then click 
the Embedded or Final Cut Pro tab to display the appropriate sheet. 

There may be more than one metadata label. The Embedded label is always available; others (including 
Final Cut Pro, and QuickTime) are dynamically generated as appropriate.

Values you enter in the Embedded label are embedded in the file that is created.

Figure 8–5. Clip event label values.

Clip Name. Enter or edit the clip name for this clip.

Analog Clock. Click and drag the hour, minute, and 
second hands to adjust the start and stop time.

Digital Clock. Select and edit the hour, minute, 
and second value to adjust the start and stop time.

Color. Select the color you want to represent this 
clip event in the schedule panel.

Link. Click to maintain the duration, linking the two 
clocks together. When in Link mode, adjusting one 
clock causes the other to adjust automatically, 
maintaining the duration.

Label Sets. Select the label set you 
want to use for this clip.

Labels. The labels for the selected set 
display in this table. Enter or update the 
label values in the right column.
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Values. Edit each value as appropriate for this clip.

Click OK to save these values or click Cancel to leave them unchanged.
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The Schedule Mode Toolbar

Use the schedule mode toolbar to place the schedule into a specific mode. Schedules have three modes.

Figure 8–6. Use the Schedules Mode toolbar to place the schedule into various states.

Capture Mode. Click to place the schedule into capture mode. Clip events are captured as files as they 
occur in the schedule. In this mode, locks display on clips and you can’t edit the schedule (add, edit, delete 
or play clips) or change your settings. When a clip event is executed in capture mode, the current settings 
in the Pipeline Selector and Settings panel are used, even if they are not saved. Pipeline Control does not 
automatically save settings. To save settings, select File > Save.

When you press Capture, Pipeline Control checks to make sure you have enough disk space for the clip 
events on your schedule.

Idle Mode. In idle mode, Pipeline Control is disconnected from the selected Pipeline and the schedule is 
de-activated. When the schedule is in capture, playout, or preview mode, you must click the Idle button 
before setting another mode. In idle mode, you can edit the schedule and change your settings.

Playout Mode (Mac OS X only). Click to place the schedule into playout mode. Clip events are played out 
to the Pipeline as they occur in the schedule. During the time that clips are not playing out (empty spaces 
in the schedule), Pipeline Control streams black filler video.

In playout mode, locks display on clips and you can’t edit the schedule (add, edit, delete or play clips) or 
change your Pipeline settings. When a clip event is executed in playout mode, the current settings in the 
Pipeline Selector and Settings panel are used, even if they are not saved. Pipeline Control does not 
automatically save settings. To save settings, select File > Save.

For a schedule to remain active, the Pipeline Control application must be open, and the Schedule 
document must also be open. Additionally, your Macintosh drive must not be in sleep mode. Pipeline 
Control prevents the computer from automatically putting the hard drive to sleep, but it can not prevent you 
from selecting Sleep from the Apple menu, or pressing the power button. If the Pipeline Control application 
or the Schedule document is closed, or if your hard drive is in sleep mode, clip events aren’t executed.

Idle Mode. Click to stop the 
schedule and disconnect from the 
Pipeline, and change settings.

Capture Mode. Click to start the schedule in capture 
mode. Clip events are executed by creating the file if 
necessary and saving the media in it.

Playout Mode (Mac OS X only). Click to start the 
schedule in playout mode. Clip events are executed by 
opening pre-existing files and playing out their contents.
82549



Chapter 8
Using Schedule Documents

136
Using the Schedule Toolbar

The schedule toolbar displays vertically, on the left of the schedule panel. It provides easy access to 
various schedule commands you use to create and manage clip events.

Figure 8–7. Schedule Toolbar.

Add Clip. Use to add a new clip event. Each time you add an event, it is added as early in the schedule as 
possible, where space is available. The newly-created clip is automatically selected so that you can 
immediately display its properties and add metadata, or adjust start and stop times.

Information. Click to display the property sheet for the selected clip.

Review. Review the local clip.

Delete. Click to remove the selected clip event from the schedule. When you remove a clip event, the 
actual file that it references (if present) is left intact – it is not deleted.

Zoom In/Zoom Out. Use the top magnification glass icon to zoom in on your schedule, and use the 
bottom magnification icon to zoom out. You can also use the slider to dynamically zoom your schedule.

When you zoom out all the way, on most monitors you can view the entire schedule from an hourly 
perspective. As you zoom in closer and closer, you can view half and quarter hours, 5 minutes, one 
minute. Zoom to the magnification that is best for the size of clips you’re working with.

Select and show the first clip. Click to select and zoom in on the first clip in the schedule.

Select and show the previous clip. Click to select and zoom in on the clip immediately prior to the 
currently-selected clip.

Go to Current Time. With the time source (Auto, RS422, etc.) and Pipeline selected, click to scroll the 
schedule so that the current time is as close to the center of the schedule as possible, so that it is visible. If 
you are not connected to a Pipeline device, Pipeline Control displays the schedule beginning at midnight.

Select and show the next clip. Click to select and zoom in on the next clip after the selected clip.

Select and show the last clip. Click to select and zoom in on the last clip in the schedule.

Add a new clip event

Zoom in

Display properties of the selected clip event
Review the selected local clip
Delete the selected clip event

Zoom out

Select previous event

Select first clip event

Select next event

Zoom Slider

Select last event

Go to the current time
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Chapter 9, Using Log & Capture Documents

Pipeline Control’s log and capture document enables you to create and save clip lists, and capture media 
defined by the clips in various formats via Pipeline, independently of your video editing/encoding software.

You can use the Log & Capture window in Pipeline Control to create clip lists, then capture and encode 
each clip in any supported SD or HD format and any wrapper/file format directly from a Pipeline.

Topics

 Creating Clip Lists for Log and Capture (page 138)

 Using the Log & Capture Window (page 139)

 Using Log & Capture Controls (page 140)

 Using the Clip List Panel (page 141)

Note

When capturing media from Pipeline Quad, you can perform confidence monitoring to 
qualify your video. See Confidence Monitoring (page 57).
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CREATING CLIP LISTS FOR LOG AND CAPTURE

To encode and capture media clips from a VTR, follow these steps:

1. Create a New Log & Capture Window. If a Log & Capture window isn’t open, select File > New Log & 
Capture to create a new, untitled window or open an existing Log & Capture document.

The Clip List panel, on the right, includes the General Tab for mark-in and mark-out points, several 
metadata tabs, plus the clip list at the bottom. For details, see Using the Clip List Panel (page 141).

2. Select and Configure your Pipeline. If you haven’t already selected and configured Pipeline for this 
task, do so now. After configuring Pipeline for your workflow requirements, save the file. For details, 
see (Using The Pipeline Settings Panel (page 92)).

3. Connect to the Pipeline. When you connect, streaming media (if present) displays in the video panel. 
If you’re connected to a VTR and it is in Remote mode, you can control your video using the VTR 
controls and produce clips to be encoded and imported.

4. Create a Clip List. Insert tapes in your VTR, then use the VTR controls to scrub media, create mark in 
and mark out points (General Tab), add metadata as necessary, then click the Log button to create the 
clip and add it to the list.

If you want to capture clips from multiple tapes, enter the name of the tape (or category) in the 
General > Tape field for the clip you’re creating. To capture clips from multiple tapes in one session, 
select All Tapes before clicking Capture. Before capturing clips, select the tape (or category) from the 
clip list on the left, to display the clips you want to capture. You can use the tape name to filter your list.

5. Capture the Clips. Click the Capture button below the clip list to capture the clips displayed in the clip 
list and save each one as a file. You will be prompted to insert the correct tape when necessary (if 
selected in preferences) and the previous tape will be ejected.

Note

If your Pipeline is in NTSC mode, DVCPro is selectable because from the NTSC video 
compression perspective, there is no difference between DV and DVCPro: both are 
720x480, 25mbs using 4:1:1 chroma sampling.

In PAL mode, DV compression is 720x576, 25mbs with 4:2:0. DVCPro compression is 
720x576, 25mbs with 4:1:1. Therefore, both DV and DVCPRO display in the list.
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USING THE LOG & CAPTURE WINDOW

The Log & Capture window is similar to the schedule window: at the top is the Pipeline Settings panel, and 
to the left side is the Preview panel with connection, status, and timecode. VTR controls have added Mark 
In and Out buttons on either side. For details on how to use the Pipeline Settings panel and all panels and 
controls on the left, see Chapter 7, Using Pipeline Control (page 85). 

Figure 9–1. Use the Log & Capture window to create clip lists and capture media from a VTR.

The right side of the window is specifically designed to support log and capture activities. It has tabs for 
general values, and metadata values. Below the tabs is the clip list, including tape names when logging 
clips from multiple tapes.

At the bottom center is the red Capture button.

Clip List Panel

Mark In Buttons
Mark Out Buttons

Shuttle Control

Jog Control

Click to add clip to 
clip list.

Click to begin 
capturing clips.

Thumbnail Preview 
& Controls

VTR status details
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USING LOG & CAPTURE CONTROLS

In addition to the controls described in (Using the Video Preview Panel on page 109), the Preview panel in 
Log & Capture window has additional controls to support log and capture activities.

Figure 9–2. Timecode, VTR, Jog and Shuttle in the Log & Capture window.

VTR Tape Status 

TAPE IN. Displays when a tape is in the attached VTR.

TAPE OUT. Displays when a tape is not in the attached VTR.

Deck RS-422 Control Status

NO RS422. Displays when Pipeline does not have control over the attached VTR.

RS422. Displays when Pipeline has control over the attached VTR.

Mark In/Out Buttons

Mark In. Click to update the Mark In point to the tape’s current timecode.

Mark Out. Click to update the Mark Out point to the tape’s current timecode.

VTR Remote Status

LOCAL. Displays when the VTR is in Local mode.

REMOTE. Displays when the VTR is in Remote mode.

VTR Tape Status Indicator Deck RS-422 Control Status 

Displays when tape is out
Displays when tape is in

Displays when Pipeline does not have control
Displays when Pipeline has control

Displays when VTR is in Local mode
Displays when VTR is in Remote mode

VTR Remote Status Indicator

Mark In Mark Out

Jog WheelShuttle Control
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USING THE CLIP LIST PANEL

The Clip List panel displays on the right of the Log & Capture window – it includes the General Tab for 
mark-in and mark-out points, several metadata tabs, plus the clip list, and a Capture button below the list. 
Each of the tabs holds data for the selected clip.

Figure 9–3. The Clip List panel allows you to work with and capture clips.

Status Badges

Clip thumbnails are marked with status badges to help you identify the status of each clip at a glance.

Status Badge Description

Indicates that Pipeline Control attempted to capture the clip, but failed. This may 
be due to lack of storage, network or Pipeline problems, or excessive pre-roll at 
the beginning of a tape, for example. Resolve the problem and retry.

During capture state only, this indicates that this clip has not been captured yet.

Indicates that this clip is in the process of being captured.

Indicates that this clip has been successfully captured.

Replace the current preview thumbnail with the frame 
currently displayed in the Preview panel.

Remove the current preview thumbnail.

You can create clips from multiple tapes, identified by 
tape name. Select the tape you want to capture from (or 
All Tapes) before clicking the Capture button below.

General, and metadata tabs.

Click to remove values from all tabs for the selected clip.

Click to add a new clip to the clip list, using the values in 
the tabs.

Click a clip to select it; double-click to edit its values.

Click to capture each clip from the selected tape (or 
all tapes) and save each one as a file.
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Clip List Buttons

Mark In. Click to update the Mark In point to the tape’s current timecode.

Duration. Click to disengage the lock (black). The duration is calculated as the end time minus the start 
time. While the lock button is disengaged (black), changes to the start timecode will cause the end 
timecode to remain the same, and the duration timecode to change. Any changes to the end timecode will 
similarly cause the start timecode to remain the same and the duration timecode to change. 

Click again to engage the lock (blue). Duration always stays the same. When the lock button is engaged 
(blue), changes to the start or end timecode leave the duration timecode locked – as is. If you change the 
start timecode, the end timecode will adjust to match the new start time and the locked duration. If you 
change the end timecode, the start timecode will adjust to match the new end timecode and the locked 
duration. 

For example, given a clip at 29.97 FPS, if the duration is set to 00:00:30;00 with the In point at 01:00:00;00, 
the Out point is 01:00:29;29. If the In point is changed to 01:00:10;00 the Out point will change to 
01:00:39;29. Likewise, if the out point is changed from 01:00:39;29 to 01:00:49;29 the In point will change 
to 01:00:20;00.

A blue lock does not mean that the duration fields are locked (not editable). When the lock is blue, the 
duration value can be changed manually by entering a new duration in the duration fields.

Mark Out. Click to update the Mark Out point to the tape’s current timecode.

Replace Thumbnail. Click to replace the current preview thumbnail with the frame currently displayed.

Remove Thumbnail. Click to remove the current thumbnail.

Clear All. Click to remove all data (name, timecode, and metadata, for example) from fields for the 
selected clip.

Save. In edit mode, click to permanently save the changed metadata values in the selected clip.

Log. In log mode, click to add the new clip to the clip list along with clip values and metadata. Make sure to 
use the correct tape name, if you’re using multiple tapes.

Capture. (Red button at bottom or Control > Capture) Click to capture (play and encode) each clip for the 
currently tape name (or All Tapes) and save it as a file.

Pipeline Control captures clips by controlling the VTR via the Pipeline to encode the clip and stream each 
clip’s media to Pipeline Control, which writes the media out to a file of the format/wrapper specified, and 
saves each file in the destination folder.

When the capture process completes, Pipeline Control disconnects from the Pipeline.

Creating a Clip

To create a clip, insert your tape, make sure the Pipeline is connected, and follow these steps:

1. Click the General tab to display mark-in and mark-out controls. 

2. Play/scrub the video using the VTR controls, then click the Mark In button to mark the start timecode 
(at right of Mark In code value field in the General tab of the Clip List panel). 

3. Click the Mark Out button to mark the end timecode (at right of end timecode value field). When you 
have a start and end timecode value (and the start timecode is previous to the end timecode).

4. Optionally, enter a start timecode and a duration – the end timecode will be calculated for you.

5. Optionally, enter metadata on the Embedded, Final Cut Pro, and FlipFactory tabs.

6. Click Log to create the clip and add it to the list.
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When not in edit mode, any data entry or edits you perform in any tab is for the next clip you may create. 

Deleting a Clip

To delete a clip, select it from the clip list and press the Delete key or select Clip > Delete. Deleting a clip 
does not delete the file associated with the clip, if any.

Editing a Clip’s Metadata

To edit the metadata of an existing clip, you must double-click the clip (or click a clip and select Clip > Edit).

Pipeline Control displays caution tape at the top and bottom, to indicate that you’re in edit mode:

Figure 9–4. The Clip List panel allows you to work with and capture clips.

Click on the target tab, and edit the values for each metadata tag.

Click Save to save the metadata with the clip and return to view mode.

Note

When not in edit mode, any data entry or edits you perform in any tab is for the next clip 
you may create.

General tab for basic 
data defining clip.

Metadata tabs.

Click to save new metadata
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Chapter 10, Using Trigger Documents

Pipeline Control’s Trigger document enables you to manually or automatically capture media in real time 
from a live source or VTR. You can perform the capture process in three ways: manually, automatically via 
Web services and using Timecode Break.

Topics

 Using the Trigger Document (page 146)

 Using the Video Preview Panel’s Controls (page 147)

 Using the Clip List Panel (page 148)

 Manually Recording Media (page 148)

 Setting up and Enabling Automatic Capture (page 150)

 Setting up and Capturing via Timecode Break Recording (page 150)

Note

When capturing media from Pipeline Quad, you can perform confidence monitoring to 
qualify your video. See Confidence Monitoring (page 57).
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USING THE TRIGGER DOCUMENT

The Trigger document is similar to the Schedule window. Pipeline Control can record files of any supported 
profile in any format/wrapper, up to 9 hours in length. 

Figure 10–1. The Trigger document captures video in real time.

At the top is the Pipeline Settings panel, and to the left side is the Video Preview panel with connection, 
status, and timecode. For details on how to use the Pipeline Settings panel and all panels and controls on 
the left, see Chapter 7, Using Pipeline Control (page 85).

If your VTR is in remote mode, the VTR controls allow you to scrub media, and shuttle and jog controls are 
displayed directly below.

The right side is designed to support crash recording and automation. The clip panel has settings to enable 
and configure automatic and manual recording. In addition to Web Service and Manual there is a third 
trigger that starts new clips based on timecode breaks. Below is the clip list, which displays a list of all clips 
recorded in this window.

Pipeline Control automatically reconnects a Trigger document if network connectivity or video signal is 
temporarily lost, but it will not continue processing future events. The document will continue to process 
Web service events as they are received, after reconnecting.

Web service for 
automatic recording

Activate / Deactivate 
the document for Web 
Service recording.

Captured clip list

Manual record 
button

Manual recording
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Using the Video Preview Panel’s Controls
In addition to controls described in Using the Video Preview Panel on page 109, the Video Preview panel 
in the Trigger document has additional controls. If an optional VTR is attached, you can use the VTR 
controls to view VTR status, and in Remote mode, control it.

Figure 10–2. Jog and Shuttle in the Trigger document’s Video Preview panel.

VTR Tape Status

TAPE IN. Displays when a tape is in the attached VTR.

TAPE OUT. Displays when a tape is not in the attached VTR.

Deck RS-422 Control Status

NO RS422. Displays when Pipeline does not have control over the attached VTR.

RS422. Displays when Pipeline has control over the attached VTR.

VTR Remote Status

LOCAL. Displays when VTR is in Local mode.

REMOTE. Displays when VTR is in Remote mode.

VTR Tape Status Indicator Deck RS-422 Control Status 

Displays when tape is out
Displays when tape is in

Displays when Pipeline does not have control
Displays when Pipeline has control

Displays when VTR is in Local mode
Displays when VTR is in Remote mode

VTR Remote Status Indicator

Jog WheelShuttle Control
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Using the Clip List Panel
The Clip List panel displays on the window’s right side. It displays controls to enable and configure 
automatic (Web service) and manual recording, plus media clips you’ve recorded, a Record button, and an 
Activate button.

Figure 10–3. Clip list panel.

MANUALLY RECORDING MEDIA

To manually record – encode and capture media – from Pipeline in real time, follow these steps:

1. Open a New Trigger document. If a Trigger document isn’t open, select File > New Trigger to display 
and create a new, untitled Trigger document. You can also click the Capture with Triggers icon in the 
Tasks dialog, which displays when you first start Pipeline Control.

Or, you can open a previously-saved trigger document.

2. Select and Configure your Pipeline. If you haven’t already selected and configured Pipeline for this 
task, do so now. After configuring Pipeline for your workflow requirements, save the document. For 
details, see (Using The Pipeline Settings Panel (page 92)).

3. Set up your live feed. Connect your live feed or insert tapes in your VTR.

4. Enable Manual recording. Check Manual to enable direct user-control of this document, specify the 
file name and, optionally, enter a duration. Use the VTR controls to scrub your media. NOTE: When no 

Record button

Activate/Deactivate button

Automated capture 
settings panel

Manual capture 
settings panel

clip list
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unifying token is used the record button becomes yellow and two warning signs alert the user that files 
may be overwritten.

Figure 10–4. Manual Recording settings panel.

Name and Duration. In the Name field, enter a text phrase and/or filename tokens to name the root 
file name (not including the suffix). Optionally, you can enter a duration for the amount of time Pipeline 
Control should record media to the file. Or, just click the Record button to stop recording when you 
choose.

5. Activate the Document. Click the Activate button at the bottom of the clip list to activate the 
document, enabling the Capture button.

6. Capture the Video. Click the Capture button in the manual trigger to capture the clip and display it in 
the clip list, saving it as a file. If you didn’t supply a duration, click Capture again, to stop recording and 
log the clip. If you are using a VTR without RS-422 connected via RS-422, you need to manually put 
your VTR into play mode before capturing your video.

Enable/Disable manual recording.

Specify the file name root, 
and optional duration.

Click to start/stop recording.
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SETTING UP AND ENABLING AUTOMATIC CAPTURE

To set up automatic recording, which is performed by HTTP GET requests from another application, check 
Web Service. Then, connect the feed or insert your tape, make sure the Pipeline is configured and 
connected. After you’ve set up your configuration (details below), click Activate to enable automatic 
recording.

Web Services and Port Number. Check Web services, and set the port number that the Web service 
should listen for incoming HTTP GET requests on. The port number value must be between 1025 and 
49151, and the TCP port must be open on the host system.

You can record all formats and file wrappers in this manner, depending on your Pipeline settings. All files 
have a 9 hour maximum clip length.

Figure 10–5. Automatic Capture settings panel.

When the Web service is enabled and the Pipeline document is placed into an active state, the Web 
service begins listening for requests on the specified port. You’re warned if the port is in use by another 
Trigger document or by some other service on the host computer.

Click Activate to cause the Web service to begin listening for HTTP GET requests. You can send HTTP 
GET requests to Pipeline Control to start and stop recording in the active document, (plus status requests) 
from a Web browser or custom applications that you develop.

For more details on setting up automatic recording Web service and using the Pipeline Web Service API, 
see http://www.telestream.net/download-files/pipeline/guides/Pipeline-Web-Service.pdf. 

SETTING UP AND CAPTURING VIA TIMECODE BREAK 
RECORDING

To set up timecode break recording, which is performed by timecode breaks in the feed, connect the tape 
(or live feed) and make sure the Pipeline is configured and connected. After you’ve set up your 
configuration (details below), click Activate to enable timecode break recording.

Generally these tapes have been recorded using time of day timecode. Once activated the Timecode 
Break feature will create separate files when a break in the timecode is detected. To accommodate for 
dropped frames when the tape was recorded, a Frame Threshold parameter is available. 

Note

The response codes are sent as XML and HTTP response headers. The XML is 
viewable in a Web browser.

Enable/Disable automatic recording 
via Web service.
Specify the port number.
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Name. The default file name is automatically entered based on the parameters set in Preferences. To 
change the file name, modify the basename and any token types desired. Token types can be Date, Time, 
Mark In (inclusive First Frame TC), Mark Out (exclusive Last Frame TC), Counter (increments by 1), 
Pipeline (name), Tape (name), Codec and Frame Rate. The date and counter tokens ensures unique 
names.

Max Duration. Max Duration is the maximum duration of any one individual clip. If the max duration is 
reached before a timecode break is detected any clip being captured will stop. The system will continue in 
capture mode and will start a new clip at the next timecode break. Max Duration default is 00:00:00:00 
which allows for Max Duration of 9 hours.

Threshold. Enter the minimum number of frames between timecode breaks that trigger a new clip. For 
example. If the Threshold is set to 3, a new clip will be created when a break of 3 or more frames is 
detected. If a timecode break of less than 3 frames is detected, it will be ignored and capturing will 
continue until a time break of 3 or more frames is detected. Capturing can also end if the Max Duration is 
achieved for this clip, the end of tape is detected, or the Record button is selected which stops the capture 
session.

Note

When connected to a VTR via RS-422, the Timecode Break feature prevents files from 
being created when the VTR SERVO lock is disabled. This allows an operator to jog, 
shuttle, and otherwise move to an appropriate place on the tape before files are 
created.

Enter Threshold

Enter filename and select other parameters
Enter maximum duration
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C H A P T E R 11

U s i n g  P r i n t  t o  Ta p e
D o c u m e n ts
Chapter 11, Using Print to Tape Documents

Pipeline Control’s Print To Tape document enables you to implement various types of print to tape 
operations from media files played out via Pipeline to your VTR. You can use the Print To Tape document 
to specify a set of clips and perform assemble and insert edits or crash print to tape.

Topics

 Print to Tape Overview (page 154)

 Creating Print to Tape Documents (page 156)

 Using the Clip Panel (page 158)
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PRINT TO TAPE OVERVIEW

The Print To Tape document is designed to facilitate print to tape operations via Pipeline. You can set up 
the following print to tape operations:

 Assemble edits

 Insert edits

 Crash records.

Figure 11–1. Print to Tape window panels and toolbars.

At the top of the window is the Pipeline Settings panel, and to the left is the Preview panel. For details on 
how to use these panels, see Chapter 7, Using Pipeline Control (page 85). 

When your VTR (or VTR-enabled camera) is connected via RS-422 in remote mode, VTR controls below 
the Preview panel enable you to scrub the tape.

The Print to Tape Configuration Panel (on the right) displays configuration settings and timecode settings. 
Below the timecode settings is the clip list, which displays a list of the clips you have added.

Pipeline Control automatically reconnects a Print To Tape document if network connectivity or video signal 
is lost when you are previewing the tape, but it will not reconnect if the document is activated and 
connectivity is lost.

Note: There are two ways to playout VANC data with a Pipeline system. 

1. Track based VANC Data is obtained from the data tracks of the respective file formats. For QuickTime 
this includes the time code and closed caption tracks. For MXF OP1a this includes all data stored in the 
SMPTE 436M track data.

Pipeline Status. 
Displays status. 

Preview panel. 
Displays video.

Timecode. 
DIsplays when 
connected.

VTR Controls. 

Clip list 
panel. 
Displays 
all clip 
events 
ordinally.

Clip Events. Add these clips to 
play out video in print to tape 
operations.

Pipeline Settings Panel. Use to configure 
Pipeline for use in this document.

Print To Tape Details. Displays the number 
of clips and total capture hours.

Clip List Toolbar. Provides buttons 
for frequently used functions.

Print To Tape 
Configuration 
Panel.

Activate 
button.

Print Time Tape. 
Visual depiction of 
layout on tape.
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2. Video Essence based VANC Data plays out VANC data embedded into DVCProHD, ProRes, and 
DNxHD video essence frames. This method requires you to enable VANC essence playout option from 
the Pipeline Administration page. This option overrides Pipeline’s track based playout. (See Using the 
Configure Panel on page 51.)

(For more detal see:  http://www.telestream.net/pdfs/app-notes/app_Pipeline_VBI-VANC_Support.pdf).
82549
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CREATING PRINT TO TAPE DOCUMENTS

A Print to Tape document contains one or more clip file events in QuickTime (mov) format, which you use 
to play out SDI video from Pipeline in real time. The video format is automatically detected, and decoded 
by the appropriate codec in the Pipeline, and played out under control of Pipeline Control.

Here are the steps you’ll take to create and use a Print to Tape document:

1. Open a New Print To Tape Window. If a Print To Tape document isn’t open, select File > New Print To 
Tape Document to create and display a new, untitled document. Or, open a saved document.

2. Select your Pipeline. If you haven’t already selected the Pipeline for this workflow, do so now. All 
other settings are automatically configured when you add the first clip to the list. All other clips you add 
must conform to the same video settings. Clips that don't conform to the first clip are rejected. For 
details, see Using The Pipeline Settings Panel (page 92).

3. Select insert, assemble, or crash Print Mode. Select the type of operation you want to perform from 
the Print Mode dropdown menu and configure your Preview, Video, and Audio settings.

Figure 11–2. Print To Tape configuration panel.

Preview. Check to test your clips, timecodes, and settings by playing out the clip list to the VTR or other 
destination, without sending a record command to the VTR – without performing the actual print to tape 
operation (available in Insert edit mode and Assemble edit mode).

Video. Check to play out video (available in Insert edit mode only).

For analog and digital audio playout, to route selected channels based on the deck configuration. These 
are enabled in Insert edit mode only:

Analog Audio. Check the audio flags to play out.

Digital Audio. Check the audio flags to play out.

Figure 11–3. Print To Tape Timecode panel.

Mark In. Enter the timecode of the first frame on the tape where media will begin to be laid down (insert 
and assemble edits only).

Leader. Enter the length of black leader to play out before the first clip.

Padding. Enter the length of black video between clips as they are played out.

Trailer. Enter the length of black trailer to play out at the end of the last clip.

Select the type of print to tape operation.

Check to perform an insert or assemble 
edit without recording to tape

Check video and audio to play out, as appropriate.

Set your tape’s 
mark in timecode. Specify the length of black leader 

to print before the first clip.

Specify the length of 
black trailer to print 
after the last clip.Specify the padding to print 

between each clip.
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4. Add your Clips. Using the Clip panel, add your clip files to the list, trimming each file as appropriate. 
You can only add QuickTime files that conform to the requirements of the Print to Tape document. All 
clips must have the same essence. For details, see (Using the Clip Panel (page 158)).

5. Play Out the Video as Print To Tape. Click the Activate button at the bottom of the window to start 
playing out all of the clips in order, according to your settings.

Note

When the first file is added the audio and video parameters will change to match those 
of the added file. All subsequent files must match these settings.
82549



Chapter 11
Using Print to Tape Documents

158
USING THE CLIP PANEL

The clip panel (on the bottom, right side of the window) allows you to specify a set of clip files to play out in 
a print to tape operation, view a virtual tape track, and adjust the trim on each clip.

Figure 11–4. The clip panel allows you to create a collection of clip files to print to tape.

At the top of the print time tape is the Mark In; at the bottom is the Mark Out. By convention, the terms Mark 
In and Mark Out are inclusive-exclusive. Thus, Mark Out is the timecode of the first frame NOT recorded. 
Clip start and clip end times are inclusive-inclusive.

Adding, Organizing, and Deleting Clips

To add a clip, drag a QuickTime movie file (containing media essences supported by Pipeline) onto the clip 
panel. You can only drag one clip file at a time using this method. 

Or, click + (Plus icon) in the toolbar to display a File System dialog. Navigate and select files to add to the 
clip list.

To delete a clip, select it in the clip list and click the - (Minus) icon in the toolbar.

To rearrange clips, click and drag them to the position you want them laid down on the tape. 

Clip Panel Toolbar

At the far right is a toolbar with buttons for frequently used functions. 

Figure 11–5. The Clip Panel toolbar displays icons for frequently used commands.

Note

Drag and drop is supported under Mac OS X 10.6 (Snow Leopard).

Clips. 

Drag in QuickTime mov files 
or click + to add them to the 
list. Click and drag to 
rearrange. 

Print Time Tape.

Visual track for 
each leader, clip, 
and padding, by 
timecode. 

Add Clip. Click to navigate and select clips to add to the list. 

Play Preview. Plays currently selected clip in preview panel. 

Show In Finder. Opens the folder where the clip is stored, and selects it. 

Delete Clip. Click to delete the selected clip from the list. 
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Print Time Tape

To the left of the clip list is the Print Time Tape. The Print Time Tape is a virtual representation of the order 
and time the leaders and clips will be applied to the tape.

Figure 11–6. The Print Time Tape.

The print time tape helps you visualize how the clips will be printed, and includes leader, trailer and 
padding so that you can visualize and confirm the result of the print to tape operation before you actually 
perform it.

Clip Events

Each clip file you add to the clip list is identified by a clip event.

Figure 11–7. Clip events in your schedule provide details about the clip.

Each clip event has several controls:

Preview Thumbnails. Assigned when you created the mark-in and mark out points.

File Path. Displays the full path and file name of the clip for this clip event.

Duration. Specifies the duration of playout for that clip, as calculated by the clip in and clip out points.

Clip In & Clip Out. Set by using the scrubber controls to adjust clip in and clip out points. Or, enter the 
values manually.

Trimmer. Use the scrubber controls at the left and right to set your clip in and clip out points.

Clip 
Events. 

Clip Pointers. 
Identifies the 
clip associated 
with a given 
block on the 
tape. 

Tape. Displays 
clips, leaders, 
and padding 
ordinally.

Thumbnail. 
Displays thumbnail 
at mark in point.

Clip Trimmer. Scrub to set 
clip in and out points.

File. Clip file path and filename.

Clip In. Start 
timecode.

Thumbnail. 
Displays thumbnail 
at mark out point.

Clip Out. End 
timecode.
82549



Chapter 11
Using Print to Tape Documents

160
May, 2012



161
A P P E N D I X A

Tr o u b l e s h o o t i n g
Appendix A, Troubleshooting

This appendix provides instructions for gathering information to assist in troubleshooting. For a complete 
and current list of potential issues and recommendations, go to http://www.telestream.net/download-files/
pipeline/guides/Pipeline_FAQ.pdf

This information may be useful to Telestream Customer Service when you’re obtaining support (Obtaining 
Pipeline Support | Information | Assistance (page i)).

GATHERING INFORMATION FOR TROUBLESHOOTING

These topics enable you to gather various details that aid in troubleshooting, depending on your workflow 
and environment. 

 Workflow Information (immediately following)

 Pipeline Device Firmware Information (page 163)

 Pipeline Administrator Counters Panel Details (page 163)

 Obtaining Debug Logs from Pipeline Control (page 163)

Workflow Information
First, briefly document the workflow and obtain system information about your source and/or destination 
system: FlipFactory (immediately following), Episode Engine (Page 162), Pipeline Control for Mac OS X 
(Page 162), Pipeline Control for Windows (Page 162), or Final Cut Pro (Page 163).

FlipFactory

Obtain FlipFactory information using FlipFactory's automatic support email or obtain it manually.

To obtain the information automatically, send email to Telestream by using the Email Tech Support button 
on the FlipFactory System Settings window (see the FlipFactory User’s Guide, Chapter 5, Using 
FlipFactory, in the Sending Email to Tech Support section). 

To obtain this information manually:

• Get FlipFactory version and all update packs which are installed

• Get a copy of the FlipFactory license file

• Get account and factory details – obtain an XML output of the account when possible

• Obtain the FlipFactory server and/or Pipeline client system information:

http://www.telestream.net/download-files/pipeline/guides/Pipeline_FAQ.pdf
http://www.telestream.net/download-files/pipeline/guides/Pipeline_FAQ.pdf
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1. Click Start > Help and Support.
2. On the Help and Support panel, click Support from the top menu.
3. Click Advanced System Information.
4. Click View detailed system information.
5. On the System Information dialog, select File > Save to save an nfo file containing your system 

information to the desktop of the computer.

Episode Engine

Obtain the Episode Engine version and export your compression template to a file.

Obtain the Mac OS X system profile:

1. Launch the System Profiler, which is located at: /Applications/Utilities/System Profiler.

2. Select Save As... from the File menu.

3. Select Rich Text Format (RTF) from the Format popup menu.

4. Save the file to the desktop.

Pipeline Control for Mac OS X

Obtain the Pipeline Control for Mac OS X version and the Pipeline device firmware version (Pipeline 
Device Firmware Information (page 163)).

Obtain the Mac OS X system profile:

1. Launch the System Profiler, which is located at: /Applications/Utilities/System Profiler.

2. Select Save As... from the File menu.

3. Select Rich Text Format (RTF) from the Format popup menu.

4. Save the file to the desktop.

Save the Pipeline document(s) containing all of your settings, and send the system profile document and 
all Pipeline documents to Telestream support with other debug information.

If you are using a FlipFactory or Episode Engine publisher, obtain all of the system information associated 
with these systems (FlipFactory (page 161) and Episode Engine (page 162)).

Pipeline Control for Windows

Obtain the Pipeline Control for Windows version and the Pipeline device firmware version (Pipeline Device 
Firmware Information (page 163)).

Obtain the Windows system information profile:

1. Run the System Information tool: Start > All Programs > Accessories > System Tools > System 
Information.

2. Select Export from the File menu.

3. Save the System Information file to the desktop.

Save the Pipeline document(s) containing your settings and send the system profile document and 
Pipeline documents to Telestream support with other debug information.

If you are using a FlipFactory publisher, obtain all of the system information associated with these systems 
(FlipFactory (page 161)).
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Final Cut Pro

Obtain the Final Cut Pro version and Pipeline plug-in revision.

Obtain the Mac OS X system profile:

1. Launch the System Profiler, which is located at: /Applications/Utilities/System Profiler

2. Select Save As... from the File menu.

3. Select Rich Text Format (RTF) from the Format popup menu.

4. Save the file to the desktop.

Pipeline Device Firmware Information
Obtain the Pipeline’s firmware revision number. Locate the Main and App Loader revision numbers on the 
Configure panel of Pipeline Administrator (Using the Configure Panel (page 51)).

Obtain Network Details

Pipeline IP address – default, static or DHCP (F/W v2.4 or earlier).

Document whether the connection is direct or through a switch.

If the connection is through a switch, is the route through more than one?

Are there any managed switches between the Pipeline and the target system?

What is the speed of each leg of the connection: 100Mb or 1000Mb (Gigabit).

Document whether the LAN is used for general data traffic and video traffic or only video traffic.

Pipeline Administrator Counters Panel Details
If a video or audio issue is being reported, repeat the encode or playout process while running Pipeline 
Administrator and viewing the counters on the Counters panel (see Using the Counters Panel (page 59) for 
a description of these parameters). To display the Counters panel, click counters in Pipeline 
Administrator’s menu.

Obtaining Debug Logs from Pipeline Control
Debugging Pipeline components (hardware, client applications, etc.) can rarely be done independently. 
Since they all work as a system, they must be debugged as a system. The information obtained through 
these techniques can point to a problem anywhere in the system, and even to problems in multiple points 
in the system.
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Mac OS X

Debug logs for Pipeline Control are generated only when you enable them, by editing property list files:

• Net.telestream.system.plist

• Net.telestream.PipelineControl.plist

• Net.telestream.tifo.plist

• Net.telestream.dvcprohd.plist

• Net.telestream.imx.plist

Each of these files controls, among other things, the output of debug information for different subsystems. 
The system plist handles enabling and disabling debug logging for the Pipeline Engine, the lowest layer of 
the Pipeline software suite. The second plist, PipelineControl, handles application level logging – the 
Pipeline Control application itself. The media format plists (tifo, devprohd, and imx, for example), handle 
debug logging for various QuickTime decompressor components. 

To enable debug logging, first exit Pipeline Control. If you want to obtain debug logging for QuickTime 
decompressors, then you’ll need to also exit QuickTime-enabled applications including QuickTime Player 
or Final Cut Pro. 

Now, add a DebugLevel key to the plist as a number (for example, NSNumber), and a value 5. Save the 
changes to the plist and start PipelineControl again. Optionally, you can add a DebugLog key as a string 
(for example, NSString) to the plist, with a complete absolute path to a target text file. This causes debug 
logging to be output to the target text file instead of to the default location, which is viewable by the 
Console application.

To view the logs, you can open the Console application (located in Applications/Utilities) and select the log 
from the panel on the left. This panel may need to be opened first – click the Show Log List icon in the 
upper left. After selecting the desired log file in the list, select File > Save As to save a copy to send to 
Customer Service.

Windows

Pipeline Control for Windows saves details in trace (...trace.log) files, located at:

XP: C:\Program Files\Telestream\Pipeline Control.

Vista & Win7: C:\Users\<username>\AppData\Local\Telestream\Pipeline Control.

When requested, E-mail the latest log file, along with other details, to Customer Service.
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P i p e l i n e  C o n t r o l
C o d e c  P r o f i l e s
Appendix B, Pipeline Control Codec Profiles

This appendix describes each Pipeline codec’s preset profiles. SD profiles are available in Pipeline SC and 
Pipeline Quad. Both SD and HD codec profiles are available in Pipeline HD Dual.

Some wrapper/file formats do not support all possible audio / video options. For example, MXF wrappers 
(Avid, XDCam, and Op1a) do not support 16 channels of audio.

Video Profiles

 DNxHD Profiles (page 166)

 DV and DVCPro Profiles (page 166)

 DVCPro HD Profiles (page 166)

 IMX Profiles (page 167)

 ProRes Profiles (page 167)

 Motion JPEG Profiles (page 167)

 SD Uncompressed Profiles (page 168)

Audio Profiles

 Linear PCM Profiles (page 168)
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DNxHD Profiles
Table B–1. DNxHD Profiles

*1080i Field Order: Upper Field First

DV and DVCPro Profiles
Table B–2. DV and DVCPro Profiles

*NTSC Field Order: Lower Field First

**PAL Field Order: Upper Field First

*** Available with Pipeline HD Dual Channel Only

DVCPro HD Profiles
Table B–3. DVCPro HD Profiles

*1080i Field Order: Upper Field First

Vertical Horizontal Aspect Ratios Frame 
Rates Quality

720p 1280 16:9 23.976, 25, 
29.97, 50, 
59.94

8bit SQ, 8bit 
HQ, 10bit HQ

1080i* 1440 16:9 25, 29.97 8bit SQ

1080i* 1920 16:9 25, 29.97 8bit SQ, 8bit 
HQ, 10bit HQ

1080p 1920 16:9 23.976, 24, 
25

8bit LQ

1080p 1920 16:9 23.976, 24, 
25, 29.97

8bit SQ, 8bit 
HQ, 10bit HQ

Vertical Horizontal Aspect Ratios Frame 
Rates

Quality 
(Mbps)

480i*, 486i* 720 4:3, 16:9 29.97 25, 50***

576i** 720 4:3, 16:9 25 25, 50***

Vertical Horizontal Aspect Ratios Frame 
Rates

Quality 
(Mbps)

720p 960 16:9 23.976, 25, 
29.97, 50, 
59.94

100

1080p 1280 16:9 23.976 100

1080i*, 1080p 1280 16:9 29.97 100

1080i*, 1080p 1440 16:9 25 100
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IMX Profiles
Table B–4. IMX Profiles

*NTSC Field Order: Lower Field First

**PAL Field Order: Upper Field First

ProRes Profiles
ProRes SQ is supported in SD profiles; SQ and HQ are supported in HD profiles.

Table B–5. ProRes Profiles

*NTSC Field Order: Lower Field First

**PAL Field Order: Upper Field First

***1080i Field Order: Upper Field First

Motion JPEG Profiles
Motion JPEG A is supported in SD profiles; Standard and HQ are supported in HD profiles.

Table B–6. Motion JPEG Profiles

Vertical Horizontal Aspect Ratios Frame 
Rates

Quality 
(Mbps)

486i* 720 4:3, 16:9 29.97 30, 40, 50

576i** 720 4:3, 16:9 25 30, 40, 50

Vertical Horizontal Aspect Ratios Frame 
Rates

Quality 
(Mbps)

486i* 720 4:3, 16:9 29.97 SQ, HQ

576i** 720 4:3, 16:9 25 SQ, HQ

720p 960, 1280 16:9 23.976, 25, 
29.97, 50, 
59.94

SQ, HQ, LT, 
Proxy

1080p 1440, 1920 16:9 23.976 SQ, HQ, LT, 
Proxy

1080i***, 1080p 1440, 1920 16:9 25, 29.97 SQ, HQ, LT, 
Proxy

Vertical Horizontal Aspect Ratios Frame 
Rates

Quality 
(Mbps)

240p 320 4:3 25, 29.97 Q80

240p 427 16:9 25, 29.97 Q80
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SD Uncompressed Profiles
Table B–7. SD Uncompressed Profiles

*NTSC Field Order: Lower Field First

**PAL Field Order: Upper Field First

Linear PCM Profiles
Table B–8. Linear PCM Profiles

Vertical Horizontal Aspect Ratios Frame 
Rates

Quality 
(Mbps)

480i*, 486i* 720 4:3, 16:9 29.97 8

576i** 720 4:3, 16:9 25 8

Parameter Value

Channels 2 | 4 | 8 | 16

Sample Rate 48 KHz

Quality 16 | 24 bit, Big Endian | Little Endian
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A P P E N D I X C

P i p e l i n e  M u l t i f e e d
C o n t r o l  A p p l i c a t i o n
Appendix C, Pipeline Multifeed Control Application

SETTING UP THE MULTIPLE PIPELINE CONTROL UTILITY

Before using the utility, you must first open and activate one or more Pipeline Control Trigger documents 
on their respective Pipeline host systems and enable the Web service trigger (Chapter 10, Using Trigger 
Documents on page 145).

Next, add one or more Trigger document details by clicking the Plus button. Each entry requires the 
Pipeline host system IP Address (or fully-qualified DNS system name), a corresponding port number and 
an optional filename.

When each Trigger document reports that it is in idle mode you are ready to start capturing. (For details, 
see the user guide accompanying the download below).

PIPELINE MULTIFEED CONTROL APPLICATION

The Pipeline Multifeed Control application is a simple Java application used to start and stop multiple 
Pipeline Trigger documents simultaneously. This application can be used from any computer on your 
network to remotely control one or more Pipeline capture sessions. It is located on the Pipeline CD in the 
Utilities folder. You can also download it from the Pipeline download page at www.telestream.net.

Figure C–1. Pipeline Multifeed

http://www.telestream.net
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The Pipeline Multifeed Control application displays a list of Pipeline Control Trigger documents, with the 
TCP/IP address of the Pipeline host system running the respective Trigger document, and its port number. 
It also displays the file name of the captured file and the status of the connection to the respective Trigger 
document.
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Index
Numerics

525/625, automatic detection of 2-9, 2-11
554 port (RTSP) must be open 2-20
608 closed captions 7-118
80, http port, must be open 2-20
8080

default Web service port 10-148

A

About panel, generally 5-50
assemble edits, performing 11-153
auto timecode clock source 7-99
Avid, MXF file support 4-29

B

back plane, HD Dual, ports and connectors 2-17
back plane, SC, ports and connectors 2-10
Big Endian 6-79, 7-98, 8-129, B-168
black frame 5-54
BNC, SMPTE-259M 270MBPS 2-11, 2-15
Bonjour panel 4-33–4-34

C

Canadian EMC Notice of Compliance i-iii
Cat-5 cable, must be used with Pipeline i-ii
Channel 1 (Quad), timecode clock source 7-99
clip events 11-159
clip list files, loading and saving 7-111
clip list panel, using generally 9-141, 10-148
clip list, creating for log and capture 9-138
Clip panel, using 11-158
clip, creating 9-142
clip, deleting 9-143
clip, metadata 9-143
closed caption 1-2, 2-9, 7-116

closed caption data extraction 2-9
closed caption, embedded in QuickTime 

track 7-118
closed caption, processing 2-15
comparison of features 4-28
computer clock, timecode source 7-99
confidence monitoring 1-2, 2-12, 5-56–5-58, 6-68, 

6-70, 9-137, 10-145
confidence monitoring, disabling 5-57
confidence monitoring, enabling 5-57
Configure panel, generally 5-51
Connect dialog, authenticating with 5-49
Copy File, configuring publisher for 7-108
copyright notice i-i
Counters panel 5-59
CPLD chip version 5-52
crash print to tape, performing 11-153

D

DAM 1-2
DHCP address 2-22, 5-52, 5-55, A-163
dimensions, of Pipeline Quad 2-11, 2-15
dimensions, of Pipeline SC 2-9
DNxHD, Avid DNxHD 1-3
documents, creating 7-88
DV 2-11, 5-58
DVCPro 2-11, 5-58
DVCProHD 1-3

E

edit decision list 5-61
EDL 5-61
EDL, GVG 4 7-89
EDL, loading and saving 7-111
electrical safety, standards complied with i-iii
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emission information i-ii
emission standards complied with i-iii
EN55022 Class A Warning i-iii
environmental operating requirements 2-6
Episode 2-9, 5-57, 7-116

Pipeline Plugin for 6-63
QuickTime, required for export 6-79

Episode | Episode Pro, Pipeline Plugin for 4-28
Episode configuring publisher for 7-103
Episode Desktop

Pipeline Plugin for 6-63
QuickTime, required for export 6-79

Episode Engine, restarting after installing Pipeline 
software 3-24

Episode, installing Pipeline plugin for 3-24
Episode, version requirements for use with 

Pipeline 4-30
Ethernet 2-6, 2-9–2-10, 2-12
Ethernet port (SC) 2-10
Ethernet port, LED indicators for 2-14, 2-18
Ethernet, gigabit 1-2, 2-11, 2-15
Ethernet, gigabit in Quad 1-2
Ethernet, gigabit port (HD Dual) 2-18
Ethernet, gigabit port (Quad) 2-14

F

FCC Emission Information i-ii
features, comparison of Pipeline applications 4-28
file format, selecting 7-93
Final Cut Pro 1-2, 2-19, 2-21, 3-24, 5-57, 6-63, 

6-79, A-161, A-163
Pipeline Plugin for 6-63
QuickTime, required for export 6-79

Final Cut Pro bin 6-72
Final Cut Pro configuring publisher for 7-106
Final Cut Pro version 5.0.1, requirement for using 

with Pipeline 4-30
Final Cut Pro, importing media with 6-68, 6-70
Final Cut Pro, installing Pipeline plugin for 3-24
Final Cut Pro, Pipeline Plugin for 4-28
firmware update 2-9, 2-12, 5-62
FlipFactory 1-2, 2-9, 2-19, 2-21, 5-57, A-161
FlipFactory / Pipeline workflow, system 

requirements for 4-40
FlipFactory console 5-58
FlipFactory, configuring publisher for 7-100
FlipFactory, requirements for using with 

Pipeline 4-30

FlipFactory, version requirements 4-30
format, selecting 7-93
FPGA chip version 5-52
front panel indicators 2-12, 2-16
front panel indicators for SC 2-9

G

gigabit Ethernet 1-2, 2-11, 2-15, 2-19
gigabit Ethernet port (HD Dual) 2-18
gigabit Ethernet port (Quad) 2-14
GVG 4 EDL 7-89

H

hardware for Quad 2-11, 2-15
hardware for SC 2-9
HD Dual, reset switches 2-12, 2-16
HTTP password rules 5-53
http port 80, must be open 2-20

I

IMX 2-11, 5-58
insert edits, performing 11-153
installing Pipeline software, generally 4-27
Internet Explorer 5-52
Internet Explorer 6 5-48
Internet Explorer, req’d settings for Pipeline 

Administrator 5-48

K

keyboard shortcuts 7-90

L

LAN LED (HD Dual) 2-16
LED SDI, front, on Quad, lights orange 2-12
LED, Ethernet on Quad 2-14, 2-18
LED, Ethernet on SC, lights orange 2-10
LED, Ethernet, on SC, unlit 2-10
LED, front, on Quad, lights yellow 2-12
LED, on HD Dual front panel 2-16
LED, on Quad front panel 2-12
LED, on SC, lights orange 2-9
LED, on SC, lights yellow 2-9
LED, SDI on front, Quad, blinks orange 2-12
LEDs 2-12, 2-16
LEDs, for SC 2-9
license requirements, for MPEG-2 i-i
Link LED (Quad) 2-12
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link-local 2-20, 2-22, 5-52
link-local IP address, default 2-20
Little Endian 6-79, 7-98, 8-129, B-168
log and capture window, using generally 9-139
log and capture, generally 9-137
loopback, disabling 5-54

M

MAC address 2-22
Mac OS X 2-19
Mac OS X, installing Pipeline software on 3-24
Mac OS X, Pipeline Control, supported 4-28
Mac OS X, uninstalling Pipeline software from 3-25
Mac OS X, upgrading Pipeline software on 3-24
media, exporting to Pipeline from Final Cut 

Pro 6-79
metadata, for clip 9-143
Mode LED (HD Dual) 2-16
MPEG-2, license requirements i-i
Multifeed Control C-169
MXF file support 4-29

N

name of Pipeline, editing 5-52
network settings, configuring 2-22
notices

Canadian EMC Notice of Compliance i-iii
FCC emission information i-ii

notices, legal, generally i-i
NTSC 2-11

O

operating temperatures 2-6
overheating warning 2-6
overheating, or Pipeline, avoiding 2-6

P

PAL 2-11
password, none by default, assigning 5-53
Pipeline

adding to LAN 2-20
configuring and connecting 2-22
connecting directly to computer 2-19
dimensions of Quad 2-11, 2-15
dimensions of SC 2-9
LEDs 2-9
name, editing 5-52

network settings 2-22
power requirements 2-6
rebooting 5-55
registering 2-22
soft rebooting 5-55
version 5-52

Pipeline Administrator
About panel 5-50
Configure panel 5-51
Upgrade panel 5-61

Pipeline Administrator, generally 5-47
Pipeline Administrator, launching 5-48
Pipeline applications, features compared 4-28
Pipeline clock, timecode source 7-99
Pipeline Control

creating documents for 7-88
Pipeline Control, feature comparison 4-28
Pipeline EDL 7-89
Pipeline HD Dual

contents of shipping container 2-7
features 1-3
front panel indicators 2-16
locating for operation 2-7
rear panel 2-17

Pipeline Plugin, feature comparison 4-28
Pipeline Plugin, used in Final Cut Pro, Episode, 

Episode Pro Desktop 6-63
Pipeline Plugin, uses QuickTime for crash 

recording 6-68
Pipeline Quad

contents of shipping container 2-7
features 1-2
front panel indicators 2-12
hardware, specifications 2-11, 2-15
locating for operation 2-7
rear panel 2-13

Pipeline SC
contents of shipping container 2-7
features 1-2
front panel indicators 2-9
hardware, specifications 2-9
locating for operation 2-7
rear panel 2-10

Pipeline Settings panel, using to configure 
Pipeline 7-92

Pipeline software, general hardware and OS 
requirements for 4-40

Pipeline software, installing 4-27
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Pipeline software, installing, on Mac OS X 3-24
Pipeline software, uninstalling from Mac OS X 3-25
Pipeline software, upgrading on Mac OS X 3-24
Pipeline, configuring for use in Pipeline 

Control 7-92
PipelineAdministrator 5-59

Quad panel 5-56
ports, that must be open 2-20
Postroll Duration 7-114
power connector (HD Dual) 2-17
power connector (Quad) 2-13
power connector (SC) 2-10
Power LED (SC) 2-9
power requirements for Pipeline 2-6
preroll duration 7-114
Preview Panel, using generally 7-109
preview panel, using in log and capture 9-140, 

10-147
Print Time Tape 11-159
Print To Tape, generally 11-153
ProRes 422 HD, Apple ProRes 422 HD 1-3
publisher, configuring Copy File as 7-108
publisher, configuring Final Cut Pro as 7-106
publisher, configuring for Episode 7-103
publisher, configuring for FlipFactory 7-100
publisher, configuring, generally 7-100
publisher, selecting 7-99
PWR LEDs (HD Dual) 2-16
PWR LEDs, on Quad 2-12

Q

Quad panel, generally 5-56
QuickTime 6-70, 6-72

embedding closed caption 7-118
required format for exporting via Pipeline Plugin 

(Final Cut Pro, Episode, Episode Desktop 6-79
QuickTime (mov) format, required for print to tape 

operations 11-156
QuickTime file support 4-28
QuickTime, format required for crash recording via 

Pipeline Plugin 6-68

R

Radiation Emission Susceptibility Regulatory 
Approved Standards

complied with i-iii
rear panel, HD Dual, ports and connectors 2-17

rear panel, Quad, ports and connectors,back 
plane, Quad, ports and connectors 2-13

rear panel, SC, ports and connectors 2-10
rebooting, Pipeline 5-55
Reference LED (HD Dual) 2-16
Register, using button on About panel 5-50
registering your Pipeline 2-22
registering, URL for 5-50
reset switches, HD Dual 2-12, 2-16
RS-422 2-10–2-11, 2-13, 2-15, 2-17, 2-21, 5-60, 

6-79, 11-154
RS-422 deck control 2-9
RS-422 port (HD Dual) 2-17
RS-422 port (Quad) 2-13
RS-422 port (SC) 2-10
RS422, timecode clock source 7-99
RTSP port 554 must be open 2-20

S

Safari 5-52
Safari, using to download installer 3-24
safety instructions when using Pipeline i-iii
SDI In (HD Dual), indicators for 2-16
SDI In (SC) 2-9
SDI In LED (Quad) 2-12
SDI In port (HD Dual) 2-17
SDI In port (Quad) 2-14
SDI In port (SC) 2-10
SDI LED (SC) 2-9
SDI Out (HD Dual), indicators for 2-16
SDI Out (SC) 2-9
SDI Out LED (Quad) 2-12
SDI Out port (Quad) 2-14
SDI Out port (SC) 2-10
SDI Out, indicators for 2-18
SDI Sync Input (HD Dual) 2-17
SDI time code 7-99
Serial Digital Interface 2-9, 2-11, 2-15
settings, returning to default 5-55
SMPTE-259M 270MBps 2-9
soft rebooting, Pipeline 5-55
Sony Protocol 2-9
Sony protocol 2-10
stack limit two, overheating 2-6
Static IP address 5-52
static IP address 2-20, 2-22, 5-55, A-163
surge protector, recommended 2-6
Sync In (HD Dual) 2-17
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Sync In port (Quad) 2-13
Sync LED (HD Dual) 2-16
Sync LED (Quad) 2-12
Sync Out (HD Dual) 2-17
Sync Out port (Quad) 2-13
sync reference 1-2, 2-12, 2-16
sync reference, using 2-11, 2-15

T

TCP ports that must be open 2-20
Telestream

contacting i-iv
International i-ii
sales and marketing i-i–i-ii
technical support i-i–i-ii
Web site i-i–i-ii

Telestream Intermediary Format 7-116
Telestream, contacting i-ii
temperature, operating requirements for 2-6
test pattern, setting on startup 5-54
TIFO 7-116
TIFO file support 4-28
TIFO, generally 7-116
time code 1-2, 2-15, 6-73
time code, processing 2-9, 2-15
timecode clock source, Auto 7-99
timecode clock source, Channel 1 (Quad) 7-99
timecode clock source, RS422 7-99
timecode clock source, video input 7-99
timecode clock sources, options 7-99
timecode source, computer clock 7-99
timecode source, Pipeline clock 7-99
trademark notice i-i
trigger document, using generally 10-146

U

UDP ports that must be open 2-20
Uncompressed SD 8- and 10-bit 1-3
uninstalling Pipeline software from Mac OS X 3-25
Upgrade panel 5-61
upgrading software on Mac OS X 3-24

V

VANC Closed Caption and Time Code, processing 
with Pipeline 2-15

VBI Closed Caption and Time Code, processing 
with Pipeline 2-9

version 5-52
Vertical Blanking Interval, processing 2-9
Video Input, timecode clock source 7-99
Vista Ultimate, Pipeline Control, supported 4-28
VITC time code 1-2
VTR Controls

in Pipeline Plugin for Final Cut Pro 6-75
VTR RS-422 2-20
VTR, using in print to tape operations 11-154

W

warranty i-iv
Warranty and Disclaimers i-iv
Web browsers

supported 5-48
Web service

using in Record and Automate 10-148
Windows 2-19
workflows for FlipFactory, version 

requirements 4-30
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